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1  Introduzione 

1.1  A proposito di MX Linux
MX Linux è un lavoro cooperativo sviluppato dalla collaborazione tra la antiX community e la vecchia 
comunità MEPIS, utilizzando i migliori strumenti e talenti di ogni distro, comprese le idee e il lavoro 
originariamente creati da Warren Woodford. Si tratta di un sistema operativo di peso medio progettato per 
associare ad un desktop elegante ed efficiente una configurazione semplice, un'alta stabilità e prestazioni 
solide. Rilasciata utilizzando l'ottimo lavoro a monte della comunità open-source Linux, MX 19  è disegnata 
sul core antiX come sistema centrale, con Xfce 4.14 come Desktop Environment e la distribuzione Debian 
stable (Debian 10, “Buster”) come base; l’uso dei nostri   Repos   che fanno il backport da Debian Testing più 
ulteriore software innovativo a sviluppo indipendente la mantengono aggiornata.

Il team di sviluppatori di MX Linux è composto da un gruppo di volontari con diverse provenienze, talenti e 
interessi. Dettagli: Chi siamo.

Un ringraziamento speciale per il continuo forte supporto a questo progetto va ai compilatori di software di 
MX Linux; ai produttori di video Dolphin_Oracle, richb e m_pav; ai nostri volontari, e tutti i nostri traduttori.

1.2  Informazioni su questo manuale

 
Figura 1-1: L'* utilità * dei manuali (xkcd.com) 
Questo Manuale Utente è il prodotto di un grande gruppo di volontari della comunità MX Linux. Come tale, 
esso conterrà inevitabilmente errori ed omissioni, anche se abbiamo lavorato duramente per ridurli al 
minimo. Vi preghiamo di mandarci dei feedback o di segnalarci correzioni e suggerimenti utilizzando uno dei
metodi elencati più sotto. Gli aggiornamenti avverranno secondo necessità. 
Il manuale è stato progettato per accompagnare i nuovi utenti attraverso le fasi dell'ottenimento di una copia 
di MX Linux, l'installazione, la configurazione per far lavorare il proprio hardware, e l'uso quotidiano delle 
varie risorse. Esso mira a fornire un'introduzione generale semplice, e dà volutamente la preferenza agli 
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strumenti grafici quando sono disponibili. Per gli argomenti avanzati, poco frequenti, o per dettagli l'utente 
dovrebbe consultare le risorse o i post sul forum. 
I nuovi utenti potrebbero trovare alcuni dei termini utilizzati in questo manuale come poco familiari o che 
predispongono alla confusione. Abbiamo cercato di limitare l'uso di termini e concetti difficili, ma alcuni 
sono semplicemente inevitabili. Il glossario che si trova alla fine del documento  fornisce definizioni e 
commenti che mirano ad aiutare a superare i passaggi difficili. 
Tutto il contenuto di MX Linux 2019 © è rilasciato sotto GPLv3. Nell’utilizzarlo dovrebbe essere 
riportata la citazione:
Progetto di Documentazione della Comunità di MX Linux. 2019. Manuale degli utenti di MX Linux

Feedback:
• Email: manual AT mxlinux DOT org
• Forum: MX Documentation and Videos

1.3  Requisiti di sistema 
Per installare un sistema MX Linux su un hard disk, normalmente sono necessari i seguenti componenti. 
Minimo 

• Una unità CD/DVD (con il BIOS settato in maniera da poter fare il boot da tale unità), o una live USB
(e BIOS in grado di fare il boot da USB).

• Un processore i686 moderno Intel o AMD.

• 512 MB di memoria RAM.

• 5 GB di spazio libero su disco rigido.

• Per l'installazione su una LiveUSB, almeno 4 GB liberi.

Consigliato 

• Una unità CD/DVD (e BIOS in grado di fare il boot da tale unità), o una live USB (e BIOS in grado 
di fare il boot da USB).

• Un processore i686 moderno Intel o AMD.
• 2 GB di memoria RAM o più.
• Almeno 20 GB di spazio libero sul disco rigido.
• Una scheda video con capacità 3D per supporto desktop 3D.

• Una scheda audio SoundBlaster, AC97 o HDA-compatibile

• Una chiave USB da 8 GB per un uso con persistenza.
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1.4  Supporto 
Che supporto è disponibile per MX Linux? La risposta a questa domanda dipende dal tipo di supporto che si 
intende avere: 

• Problemi di base degli utenti . Una serie di presidi di supporto esiste per MX Linux, dai documenti, 
ai video, al forum e ai motori di ricerca. Vedere la pagina di supporto comunitario per i dettagli. 

• Hardware . L'hardware è supportato nel kernel, il cui sviluppo va avanti di continuo. Va però 
considerato che l'hardware troppo nuovo potrebbe non essere ancora supportato, così come hardware 
molto vecchio, nonostante sia ancora supportato, potrebbe non essere più sufficiente alle esigenze del 
desktop e delle applicazioni. 

• Desktop . Xfce4 è un desktop maturo in fase di continuo sviluppo. La versione fornita con MX Linux
è considerata stabile; importanti aggiornamenti saranno applicati man mano che diventeranno 
disponibili. 

• Applicazioni . Le applicazioni continuano ad essere sviluppate dopo il rilascio di una versione di MX
Linux, il che significa che le versioni fornite potrebbero finire per diventare vecchie col passare del 
tempo. Questo problema viene risolto tramite l'utilizzo di una combinazione di fonti : gli 
aggiornamenti forniti da Debian (compreso il repository Debian Backports), quelli dei singoli 
sviluppatori, compresi gli sviluppatori MX, e il lavoro del Community Packaging Team che accetta il 
più possibile le richieste di aggiornamento degli utenti. 

• Sicurezza . Gli aggiornamenti di sicurezza forniti da Debian copriranno adeguatamente gli utenti di 
MX Linux nel prossimo futuro. 

1.5  Bug, problemi e richieste 
I “bug” sono errori in un programma, che producono risultati non corretti o comportamenti anomali. MX 

Linux definisce "problemi" come bug a monte su cui il Dev Team non può fare nulla. 

Infine per "richieste" si intendono le aggiunte di nuove applicazioni o di nuove funzionalità per le 

applicazioni esistenti, richieste dagli utenti. 

MX Linux affronta queste 3 criticità nel modo seguente: 

• I bug sono gestiti tramite l’antiX e MX Linux   Tracker  . 

• Gli utenti possono fare richieste, o segnalare bug, tramite un post nel forum, sezione Bugs and 

Request Forum, facendo attenzione a fornire informazioni sull'hardware, sul sistema operativo che si 

utilizza, e i dettagli dell'errore 

• Gli sviluppatori, così come i membri della Comunità, risponderanno a tali post con domande, 

suggerimenti, ecc 
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Figura 1-2: La gestione dei bug di MX e antiX 

1.6  Migrazione 
Quando possibile, una modalità di migrazione verso una versione più aggiornata di MX viene fornita con la 

procedura di apt specifica per l'aggiornamento delle distribuzioni (ad esempio, apt-get dist-upgrade ) in 

modo che gli utenti possano evitare la re-installazione. Controlla la pagina del wiki sulla migrazione per la 

procedura corrente (https://mxlinux.org/migration). Va considerato però che quando cambia la base di Debian

allora si ha un’eccezione alla procedura standard per la migrazione. 

Debian Stable è un meravigliosa e solida distribuzione che può essere aggiornata in automatico da versione a 

versione a patto che vengano utilizzati esclusivamente i repository di Debian stable. 

MX utilizza Debian Stable come base, ma utilizza molti programmi utente e librerie più aggiornati grazie ai 

propri repository facendo il backport di programmi più aggiornati da Debian Testing alla Stable. Il che dà una

migliore esperienza utente, ma interferisce con la funzione di “dist-upgrade” di Debian. 

Anche la scelta attuale di utilizzare sysvinit invece di usare pienamente systemd interferisce con questa 

modalità di aggiornamento. 

Quindi è un compromesso: migliore esperienza utente del desktop a scapito di poter aggiornare rapidamente 
una nuova versione di MX (con la possibilità di mantenere la /home se lo si vuole), tuttavia questo problema 
si presenta solo quando avviene l'aggiornamento alla versione successiva della Debian Stable, in genere ogni 
2-3 anni. 
MX-17 e MX-18 usano la stessa base Debian perciò viene offerta una semplice modalità di migrazione.
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1.7  Le Nostre Scelte

1.7.1 Systemd

Dato che l'uso di systemd come gestore di sistemi e servizi è stato oggetto di controversie, vogliamo essere 
chiari sulla sua funzione in MX Linux. Systemd è incluso per impostazione predefinita ma non è abilitato.
Puoi controllare il tuo sistema MX e troverai file che contengono il nome systemd*, tuttavia essi forniscono 
semplicemente una base di aggancio e di compatibilità se si rendesse necessario.
MX Linux usa systemd-shim, che emula le funzioni di systemd necessarie per eseguire gli helper senza 
utilizzare effettivamente il servizio init. Ciò significa che SysVinit rimane il servizio di init predefinito ma 
nel contempo MX Linux può continuare ad usare i pacchetti Debian che hanno dipendenze con systemd 
come ad es. Il Gestore di Stampa CUPS e il Gestore delle Connessioni di Rete. Questo approccio consente 
inoltre all'utente di avere la possibilità di scegliere il proprio init preferito. 
Un metodo base per abilitare systemd in MX Linux è reperibile nel Wiki di MX/antiX, sebbene non venga 
fornito alcun supporto ufficiale per gli utenti che scelgano di eseguire MX Linux usando systemd.

1.7.2 Software non libero

MX Linux è fondamentalmente orientato al normale utente, quindi include una certa quantità di software non
libero per assicurare che il sistema funzioni il più possibile senza doverci mettere mano. L'utente può vederne
la lista se apre il terminale e va a digitare:

vrms

Esempi:
•  Adobe Flash Player (distribuito su autorizzazione).
• Uno strumento appositamente dedicato per l'installazione dei driver grafici Nvidia
• Il driver "wl" (broadcom-sta), e il firmware non libero con componenti proprietarie, vengono forniti 

preinstallati.
Questa è la nostra logica: è molto più facile per un utente esperto rimuovere questi driver se non li desidera 
piuttosto che installarli da parte di un utente normale. Ed inoltre è particolarmente difficile installare un 
driver per una scheda di rete senza disporre dell’accesso ad Internet!

1.8 Note per i traduttori

Qualche indicazione per le persone che traducono il manuale:
• I testi in inglese relativi all'ultima versione sono in questo repo: un repo GitHub. Le traduzioni sono 

memorizzate nella directory "tr"
• E’ possibile lavorare all'interno del sistema GitHub: clonare il repo principale, apportare 

modifiche e poi fare una richiesta di modifica (pull request) perchè vengano accettate al fine di 
fonderle con il sorgente. Per l’uso di GitHub puoi trovare istruzioni in italiano qui.

• In alternativa, è possibile scaricare ciò che interessa, lavorarci localmente per poi notificare che il 
lavoro è completato con un'email a: manual AT mxlinus DOT org o inviando messaggi sul forum.

• In termini di importanza, si raccomanda di iniziare con le Sezioni 1-3 che forniscono le informazioni 
più rilevanti per il nuovo utente. Una volta completate, queste possono essere già distribuite agli 
utenti come traduzione parziale del manuale, anche se le sezioni successive sono ancora in fase di 
elaborazione. Le traduzioni disponibili si possono trovare nel Wiki   di   MX/antiX  .
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2  Installazione 

2.1  Introduzione 
Una unità (USB o DVD) Live di MX Linux avvia il computer senza accedere al disco rigido. Viene copiato 

un file system virtuale nella RAM del computer che funge da base per un sistema operativo temporaneo. 

Quando termina la sessione live, tutto ciò che riguarda il computer e i sistemi operativi presenti sul suo hard 

disk, si presenteranno invariati esattamente nel modo in cui erano prima dell’uso della distro in modalità Live

(vedi anche la sezione 6.6.1). 

Questo fornisce una serie di vantaggi: 

• Consente di eseguire MX Linux sul proprio computer senza doverlo installare. 
• Consente di determinare se MX Linux è compatibile con l'hardware. 
• Ti aiuta ad avere un'idea di come funziona MX Linux e di esplorare alcune delle sue caratteristiche. 
• È possibile decidere se MX Linux è ciò che si vuole senza influenzare in modo permanente il sistema 

attuale. 

L' esecuzione di un'unità Live ha comunque anche alcuni svantaggi, se si utilizza un DVD-Live: 

• Poiché la distro in modalità Live, funziona grazie ad una combinazione di RAM e file temporanei, 
sarà utilizzata più RAM e molte applicazioni verranno eseguite più lentamente. Tale svantaggio 
scompare se la distro viene installata definitivamente sull’hard disk del pc diventando un suo sistema 
operativo definitivo.

• Alcuni hardware e periferiche particolari potrebbero richiedere driver o configurazioni specifiche che 
potrebbero non funzionare se tali driver non sono già presenti dato che non è possibile installarli in 
una sessione Live. L'installazione e la rimozione di software infatti non è possibile perché il DVD è 
un supporto di sola lettura.

2.1.1  PAE o non-PAE? 

MX Linux è disponibile per due architetture: 32 bit e 64 bit entrambe le architetture presentano la modalità 

PAE attivata. PAE è acronimo di Physical Address Extension, un modo per consentire sistemi operativi a 32 

bit l'accesso alla RAM quando questa è maggiore di 4 GB. È possibile utilizzare una versione non PAE su un 

sistema PAE, ma non viceversa. Se la vostra macchina non è in grado di gestire PAE (per esempio perché si 

tratta di hardware vecchio) allora noi raccomandiamo di installare la nostra distribuzione “sorella” antiX 

invece di MX.

Se non siete sicuri che sia necessaria la versione PAE piuttosto che la versione non-PAE, potete eseguire il 

seguente test.

8

https://it.wikipedia.org/wiki/Physical_Address_Extension
https://it.wikipedia.org/wiki/64_bit
https://it.wikipedia.org/wiki/32_bit


• In Linux : aprite un terminale e digitate il seguente comando (installate il pacchetto inxi se il 
comando non dovesse funzionare): inxi -f . Se la voce “CPU Flags” non include PAE nella lista, allora
non sarà possibile installare MX Linux.

• Mac : tutte le versioni Intel OS X supportano PAE.

• Windows ®

• Windows 2000 e precedenti: sicuramente non-PAE
• Windows XP e Vista. Fate clic destro su Risorse del computer → Proprietà, scheda Generale. 

Se, verso il fondo, dice Physical Address Extension (= PAE), allora PAE è la versione corretta 
per l'installazione.

• Windows 7. Aprite la finestra del prompt dei comandi, cliccate sul pulsante Start→ Tutti i 
programmi→ Accessori→ Prompt dei comandi. Apparirà una finestra di terminale. Digitate 
questo codice al cursore nel prompt dei comandi:
wmic os get PAEEnabled

Se PAE è attivata, si otterrà un ritorno del genere: PAEEnabled Questo messaggio può, ma non
per forza, essere seguito dalla parola TRUE.

• Windows 8 e successivi. PAE abilitato di default.

2.1.2  a 32 o a 64 bit? 

Qual è l'architettura della CPU? 

Seguite il metodo appropriato per scoprire se la vostra macchina è a 32 o 64 bit. *

 Linux . Aprite un terminale e digitate il comando lscpu , quindi esaminate le prime righe per 
l'architettura, il numero di core, etc.

 Windows . Consultate questo documento di Microsoft .
 Apple . Consultate questo documento di Apple.

* Se volete conoscere l'architettura del sistema operativo in Linux, provate il comando uname -m

In generale, se si dispone di una CPU a 64 bit e RAM adeguata alla propria macchina e processore, si 

dovrebbe utilizzare la versione a 64 bit. Questo perché la versione a 64 bit è generalmente più veloce, anche 

se poi, in realtà, non si avverte la differenza nell'uso quotidiano. 

A lungo termine, inoltre, un numero crescente di applicazioni, molto probabilmente saranno progettate 

esclusivamente per versioni a 64 bit. 

Si noti che un'applicazione, o un sistema operativo, a 32 bit può essere eseguito su una CPU a 64 bit, ma non 

il contrario. 

Più info: qui
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Quanta memoria (RAM) avete?

 Linux. Aprite un terminale e digitate il comando free -h e guardate il numero nella colonna Total.
 Windows. Aprite la finestra delle proprietà di sistema utilizzando il metodo consigliato per la vostra 

versione di Windows, e cercate la voce "Memoria installata (RAM)."
 Apple. Fate clic sulla voce "Informazioni su questo Mac" nel menu Apple su Mac OS X e cercate le 

informazioni sulla RAM.

Molti utenti di MX Linux a 64 bit confermano che 2GB di RAM sono sufficienti per un uso generale, anche 
se si consigliano almeno 4GB di RAM se si prevede di eseguire processi (ad esempio masterizzazioni) o 
applicazioni (come ad esempio un editor audio o video) che sono ad alto utilizzo di memoria .

2.2  Creazione di un supporto avviabile 

2.2.1  Ottenere l'immagine ISO 

MX Linux è distribuito sottoforma di un unico file ISO, un file di immagine, specifico per le unità di 
memoria di massa, che segue lo standard ISO 9660 come filesystem. 

Nella pagina di download lo trovi solitamente in  due formati.

 La versione originale di una data versione.
 Questa è una versione statica, che una volta rilasciata, rimane inalterata.
 Più distante è la data di rilascio, meno aggiornata è.

 Un aggiornamento mensile di una determinata versione. Questa ISO mensile è stato creata dalla 
versione originale utilizzando MX Snapshot (vedere la sezione 6.6.4).

 Essa include tutti gli aggiornamenti dal rilascio originale, e quindi evita di far scaricare un 
gran numero di file dopo l'installazione.

 Essa inoltre permette agli utenti di utilizzare la distribuzione (su supporto Cd/Dvd o Usb) in 
modalità Live con la versione più recente dei programmi.

 Disponibile solo come download diretto!

    C  rea  re una Usb-L  ive   di MX da W  indows us  ando l’immagine   iso   mensile di MX   

Versione acquistabile.
Sfortunatamente non è  più possibile acquistare un CD o USB ( solo la versione originale ) già masterizzato e
pronto per l'uso, in quanto l'azienda che li forniva è fallita.
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Figura 2-1: Distribuzione dei mirrors di MX Linux (Dic 2018)

Download 
MX Linux può essere scaricato in due modi dalla pagina di download.

 Direttamente. Cliccate sul link alla pagina di Download delle ISO. Selezionare il mirror che 
desiderate utilizzare, quindi cliccate sul link corretto per la propria architettura. Salvate l'ISO sul disco
rigido. Se una sorgente sembra lenta, provatene un’altra. E’ possibile ottenere sia la versione originale
sia l'aggiornamento mensile. 

 Via Torrent . Il sistema di condivisione dei file BitTorrent fornisce un protocollo Internet per il 
trasferimento efficiente di grandi masse di dati. Si delocalizza il trasferimento in modo tale da 
sfruttare i collegamenti di banda migliori e di ridurre al minimo l’uso di quelli lenti. Un ulteriore 
vantaggio di tutti i client BitTorrent è che viene eseguito un controllo degli errori durante il processo 
di download, quindi non c'è bisogno di fare il controllo md5sum alla fine del download. E 'già stato 
fatto!

Il Team Torrent di MX Linux mette in condivisione le ultime ISO MX Linux (solo release originali), presso 
archive.org al massimo entro 24 ore dalla sua uscita ufficiale. I collegamenti ai torrents saranno sulla pagina 
di   Download  .

Andate alla pagina di download   dei torrent   e cliccate sul pulsante del Torrent che desiderate utilizzare in base

alla vostra architettura (a 32 bit o a 64). Il vostro browser dovrebbe riconoscere che si tratta di un torrent, 

quindi aprirà una finestra popup chiedendovi cosa ne volete fare (scaricarlo o aprirlo). Scegliete di scaricare.

Verrà scaricato nella vostra cartella “Scaricati” un file con il nome della Iso e con estensione .torrent 
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Cliccateci sopra, si aprirà il vostro client torrent (Transmission di default) mostrandovi il torrent nella sua 

lista; evidenziatelo e fate clic su Avvia per iniziare il processo di download. 

Quando la ISO avrà completato il suo download, assicuratevi che sia nella stessa cartella del file torrent 

scaricato prima del processo di download dell’ISO . Al termine del download dell’ISO, spostarla da una 

cartella ad un'altra del vostro computer causerà l'interruzione del download da parte degli altri utenti connessi

al vostro computer. Per evitare che questo accada, è consigliabile non cambiare la posizione del file. Sarete 

comunque in grado di aprirlo e di utilizzarlo. I torrent si basano sulla condivisione delle informazioni da 

parte dei singoli utenti, se nessuno condivide, nessuno potrà scaricare.

Figura 2-2: La pagina di Archive.org con i torrent disponibili per MX-19

2.2.2  Controllare l'integrità della ISO scaricata 

Dopo aver scaricato un file immagine ISO, il passo successivo è quello di verificarla. Sono disponibili 
parecchi metodi.

md5sum 
Ciascuna ISO si accompagna con un file md5sum presente anch'esso nell'archivio da cui si fa il download 
dell'ISO. Questo file contiene un numero identificativo dell'ISO e del suo contenuto.
Si dovrà effettuare la verifica dell' md5sum della nostra ISO scaricata, rispetto all md5sum della ISO 
ufficiale. Se la md5sum è identica a quella originale, la copia è autentica ed è stata scaricata senza errori. I 
seguenti passaggi vi permetteranno di verificare l'integrità della ISO scaricata su qualsiasi sistema operativo.

• Windows 
Il modo più semplice con cui gli utenti possono fare questa verifica è attraverso Rufus, uno strumento
per realizzare USB Live; è anche disponibile uno strumento, scaricabile gratuitamente, chiamato 
WinMD5FREE. Scaricate e decomprimete, poi mettete il file exe in una cartella del disco rigido. E’ 
di tipo ‘portable’ ovvero, non richiede installazione.
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• Linux
In MX Linux, accedete alla cartella in cui è stato scaricato il file ISO e il file md5sum. Fate clic sul 
file md5sum e poi “Verificare l'integrità dei dati”. Se i numeri sono identici si potrà leggere un 
messaggio pop-up che dice "nome-file-ISO: OK". 
È inoltre possibile fare click su ISO> Calcola md5sum e quindi confrontarlo con quello della fonte 
ufficiale.
Nel caso in cui questa opzione manchi, si può aprire un terminale nella cartella in cui è stato scaricato
il file ISO (in Thunar: File →Apri il Terminale Qui) e digitare:
md5sum nomefile.iso

Assicurarsi di sostituire "nomefile" con il nome del tuo file (basta inserire le prime paia di lettere poi 
premi il tasto Tab e sarà compilato automaticamente).
Confrontare il numero ottenuto da questo calcolo con il file md5sum scaricato dal sito ufficiale. Se 
sono identici, la copia è identica alla versione ufficiale.

• Mac
Gli utenti Mac potranno aprire una console/terminale nella cartella contenente il file md5sum e quello
della ISO quindi digitare questo comando:
md5 -c nomefile.md5sum

Assicurarsi di sostituire nomefile con il vero nome del file.

sha256sum

MX-19 permette di avvalersi del sistema di sicurezza fornito da sha256 e sha512. Scaricare il file per 
verificare l'integrità dell’ISO. 

• Windows: il modo varia a seconda della versione. Fate una ricerca sul web con questi termini 
"windows <versione> sha256 checksum"

• Linux: seguite le indicazioni date sopra sull’md5sum sostituendo "md5sum" con "sha256sum" 
o"sha512sum".

• Mac: aprite un terminale, portatevi sulla directory dove è presente la ISO e i file sha256 e date questo 
comando:

shasum -a 256 /percorso/del/file

Firma GPG

Dal 16 marzo 2016, i file ISO di MX Linux da scaricare vengono firmati dai loro sviluppatori. Questo 
metodo di protezione consente all'utente di potersi fidare che l'ISO è quello che dice di essere: una ISO 
ufficiale proveniente dallo sviluppatore. Istruzioni dettagliate su come eseguire questo controllo di sicurezza 

si possono trovare nel MX/antiX Technical Wiki.
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2.2.3  Creare l'unità Live

DVD
Masterizzare l’immagine ISO su un DVD è facile, a patto che si seguano alcune linee guida importanti.

 Non masterizzare la ISO su un CD/DVD vergine come se si trattasse di un file di dati! La ISO è 
un’immagine appositamente formattata e avviabile (bootable) di un sistema operativo . È necessario 
quindi scegliere Masterizza immagine disco o masterizzare ISO nel menu del tuo programma di 
masterizzazione CD/DVD. Se invece si masterizza come un file regolare, non sarà possibile ottenere 
una unità Live avviabile.

 Utilizzare un DVD-R o DVD+R di buona qualità, capacità almeno 4,7 GB.

USB
È possibile creare facilmente una pendrive USB avviabile che funziona sulla maggior parte dei sistemi. La 
distro MX Linux, per svolgere questo lavoro, fornisce lo strumento MX Crea Live USB (Live-usb maker) 
(vedi Sezione 3.2).

• Se si desidera fare lo stesso lavoro ma su un sistema Windows, vi suggeriamo di utilizzare il software 
Rufus, che supporta il nostro bootloader; anche le versioni recenti di Unetbootin (successive alla 625)
sembrerebbero supportarlo.

• Se preferite usare Linux, mediante la procedura vista sopra, assicuratevi di aggiornare i vostri repo in 
Synaptic, o con MX Aggiornamenti, così da aggiornare alle versioni più recenti syslinux, e extlinux.

• Se all'avvio del sistema da penna USB, viene visualizzato un messaggio di errore: 

"gfxboot.c32: not a COM32R image" si dovrebbe comunque riuscire a fare il boot della 

penna digitando live al prompt nella riga successiva. Eventualmente, riformattare la pennetta USB e
reinstallare la ISO dovrebbe rimuovere l'errore.

• Se questi strumenti, ad interfaccia grafica, falliscono, è possibile utilizzare il comando "dd", che ora è 
avviabile attraverso un’opzione presente in MX Crea Live-USB (Live-usb maker). 
• ATTENZIONE: fate attenzione a identificare correttamente la vostra chiavetta/dispositivo USB 

di destinazione nella riga del comando dd menzionato sopra, dato che il comando dd 
sovrascriverà completamente ciò che è presente sulla destinazione.

• Per verificare il nome/sigla-identificativa corretta del dispositivo USB, aprite un terminale e 
digitate: 

lsblk
e premete Invio
Viene visualizzato un elenco di tutti i dispositivi collegati al sistema. Si dovrebbe essere in grado 
di identificare il dispositivo USB di destinazione in base alle dimensioni delle unità elencate. 

• Per i dettagli, vedere il Wiki   di   MX/antiX  
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Figure 2-3: tipico output del comando lsblk, che mostra 2 hard disk ciascuno con due partizioni

2.3  Pre-installazione 

2.3.1  Venendo da Windows 

Se valuti di installare Linux MX come sostituto di Microsoft Windows, anzitutto devi salvare e mettere al 
sicuro tutti i file utili (dati e altro) che attualmente utilizzi in Windows. Anche se vuoi solo configurare un pc 
in dual-boot, è consigliato fare il backup dei dati, cosi in caso di eventuali errori o problemi i tuoi dati non 
verranno persi.

Come fare il backup dei file
Individuate tutti i file presenti sul disco, file come documenti di Office, email, foto, immagini, video o 
musica. Eventualmente anche i file *.ini dei programmi “portable” se preferite:

• In genere, la maggior parte di questi (tranne i file *.ini che di solito sono nelle cartelle dei rispettivi 
programmi) si trovano nella cartella Documenti.

• •Alcuni utenti fanno il backup dei loro caratteri (font) personali per il riutilizzo in MX Linux con 
applicazioni (come LibreOffice) che possono elaborare documenti Windows.

• Cercate dal menu di avvio di Windows i vari tipi di file (*.doc, *.xls ecc) per assicurarvi di salvare 
quelli anche in cartelle inusuali (cioè in cartelle diverse da Documenti).

• Una volta individuati tutti questi file, masterizzateli su un CD/DVD, o copiateli su un dispositivo 
esterno come una chiavetta USB o un disco esterno.

A seconda del programma di posta elettronica o di calendario che state usando, i file delle e-mail e del 
calendario potrebbero non essere stati salvati in una posizione evidente o con un nome di file evidente. La 

maggior parte delle applicazioni di posta o di pianificazione (ad esempio Microsoft Outlook ® ) sono in 
grado di esportare questi dati in uno o più formati di file. Consultare la documentazione di aiuto 
dell'applicazione per scoprire come esportare i dati. 

• Dati e-mail: Il formato più sicuro per la posta elettronica è il testo semplice (.txt), dal momento che la 
maggior parte dei programmi di posta elettronica supporta questa funzione. Accertatevi di 
comprimere il file per assicurarsi che i relativi contenuti siano inclusi. Se si utilizza Outlook Express,
la posta viene memorizzata in un archivio .dbx o .mbx, ciascuno dei quali può essere importato in 
Thunderbird (se installato) e quindi riportato sul sistema MX Linux. Utilizzare la funzione di ricerca 
di Windows per individuare gli archivi e copiarli al sicuro su un supporto di backup esterno. La Posta 
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di Outlook dovrebbe essere importata prima in Outlook Express e poi da li esportata in una unità di 
memoria esterna per poter poi essere utilizzata in MX Linux. 

• Dati del calendario: esportare i dati del calendario in formato iCalendar o vCalendar se si desidera 
utilizzarlo in MX Linux. 

• Dati dei contatti: i formati più universali sono CSV (Comma separated values, ovvero valori separati 
da virgola) o vCard. 

Account e password 
Di solito non li trovi memorizzati in file leggibili che possono essere sottoposti a backup, è importante quindi
ricordarsi di prendere nota delle varie informazioni relative agli account usati nel vostro pc windows. Tutti i 
dati di accesso per i siti web o servizi come l'ISP andranno annotati in quanto poi in Linux vanno tutti inseriti
da capo. Gli esempi includono:

• informazioni di accesso ISP: Avrete bisogno di almeno il nome utente e la password per il provider di 
servizi Internet, e il numero di telefono per la connessione se si è in dial-up o ISDN. Altri dettagli 
potrebbero includere un numero di uscita dial-out, tipo di selezione (a impulsi o toni), e il tipo di 
autenticazione (per dial-up); l'indirizzo IP e la subnet mask, server DNS, l'indirizzo IP del gateway, 
server DHCP, VPI/VCI, MTU, il Tipo di Incapsulamento (Encapsulation type), o le impostazioni 
DHCP (per varie forme di banda larga). Se non siete sicuri di ciò che è necessario, consultate il vostro
provider di servizi Internet.

• Wireless networking: Sono necessari la chiave di accesso o la password, e il nome della rete.
• Password siti web: sarà necessario copiare le password a vari forum web, negozi online, o altri siti 

protetti.
• Tutti i dati di accesso alle mailbox: sarà necessario il nome utente e la password e gli indirizzi o URL 

dei server di posta. Potrebbe anche essere necessario il tipo di autenticazione. Queste informazioni le 
recuperate dalla finestra di dialogo Impostazioni account del client di posta elettronica.

• Instant messaging: Il nome utente e la password per il proprio account di IM, la vostra lista di amici, e
le informazioni di connessione del server, se necessario.

• Altro: Se si dispone di una connessione VPN (ad esempio nel vostro ufficio), un server proxy, o altri 
servizi di rete configurati, assicuratevi di trovare e copiare ciò che è necessario per riconfigurare le 
informazioni nel caso sia necessario.

Preferiti del browser 
I preferiti del browser Web (segnalibri) sono spesso trascurati durante un backup, e non sono di solito 
conservati in un luogo ben visibile. La maggior parte dei browser dispone di una funzione per esportare i 
segnalibri in un file, che può essere importato nel browser di vostra scelta in MX Linux. Ecco alcuni metodi 
di esportazione per i browser web più comuni:

• Internet Explorer ® : fate clic su File> importa ed esporta, selezionate esporta preferiti, selezionate la 
cartella preferiti (per esportare tutti i preferiti), selezionate Esporta in un file e date un nome al file.

• Firefox ® 3 e successivi: cliccate su (Libreria→) Segnalibri→ Visualizza tutti i segnalibri ( o 
Organizza Preferiti), evidenziate la cartella o il gruppo di segnalibri per il backup, cliccate su Importa 
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e Salva → Esporta in HTML..., infine date un nome al file dei segnalibri.

Licenze software 
Molti programmi proprietari per Windows vanno installati con una chiave di licenza o con un CD. Anche se 
pensi di lasciare Windows in modo permanente, assicurati di avere una chiave di licenza per tutti i 
programmi che lo richiedono. Se poi si decide di reinstallare Windows (o se la configurazione del dual-boot 
va male), non sarà possibile reinstallare questi programmi senza la propria chiave o licenza.

Nel caso in cui non riusciate a trovare la licenza fornita con il prodotto, potete cercarla nel registro di 
Windows tramite un software apposito, come ProduKey . Se ancora ci sono problemi, cercate nei forum o 
nelle pagine del supporto clienti delle aziende di software per chiedere aiuto.

Esecuzione di programmi di Windows 
I programmi di Windows non sono compatibili con il sistema operativo Linux, e gli utenti MX Linux sono 
incoraggiati a cercare equivalenti nativi (vedere paragrafo 4). Le applicazioni che sono fondamentali per un 
utente possono essere eseguite sotto Wine (vedere paragrafo 6.1), anche se non sempre la compatibilità è 
completa.

2.3.2  Computer Apple Intel 

L’installazione di MX Linux su computer Apple con chip Intel potrebbe essere problematica, anche se la 
situazione cambia a seconda dell'hardware presente. Gli utenti interessati alla questione sono invitati a 
provare a consultare la documentazione presente su Debian e sui forum per gli ultimi sviluppi; Un certo 
numero di utenti Apple lo hanno installato con successo, quindi dovresti avere buona fortuna se fai una 
ricerca o pubblichi le tue domande sul forum MX Linux.
Collegamenti 
Installazione di Debian su Apple Computers: da debian.org

Installazione di Linux su Apple Computers da linuxhub.it

F  orum Debian   italia  

Forum Debianizzati

2.3.3  Domande frequenti relative ai dischi su cui installare (FAQs Hard Drive)

Dove devo installare MX Linux?
Prima di iniziare l'installazione, è necessario decidere dove installare MX Linux. Di solito ci sono queste 
opzioni :

• Tutto il disco rigido con solo MX Linux
• Partizione già esistente sull'hard disk
• Nuova partizione da creare sull'hard disk

le prime due sono disponibili durante l'installazione, la terza invece richiede la creazione di una nuova 
partizione. È possibile farlo anche durante l'installazione di MX Linux, ma si consiglia di farlo prima di 
avviare l'installazione. In Linux, di solito si usa GParted , uno strumento utile, facile e molto potente.
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La modalità tradizionale per un’installazione Linux prevede tre partizioni, una partizione ciascuno per root, 
home e swap, come mostrato nella figura sotto. Dovresti attenerti a questa configurazione, almeno all’inizio, 
se sei nuovo con Linux. Sono comunque possibili anche altre configurazioni, ad esempio alcuni utenti esperti
combinano root e home (e la swap) con un’ulteriore partizione separata, specifica per stoccare i dati 
dell’utente.

Figura 2-4: Gparted mostra tre partizioni (sda1), (sda2) e swap (sda3). 
Si noti che l'unità mostrata qui viene anche utilizzata per i test, così che le partizioni sono più grandi di 
quanto sarebbe normalmente necessario.

Maggiori info: Manuale Gparted

 Crea  r  e   una nuova   parti  zione con   Gparted  

 Parti  ziona un sistema m  ulti-boot  

Come posso modificare le partizioni? 
Uno strumento molto utile per tale azione è Menu Start> Sistema> Disk Manager . Questa utility offre una 
rappresentazione grafica di tutte le partizioni presenti sulla macchina (ad esclusione di swap). Con una 
interfaccia semplice e veloce si può effettuare il montaggio, smontaggio e la modifica di alcune proprietà 
delle partizioni del disco. Le modifiche vengono automaticamente ed immediatamente scritte in /etc/fstab e 
sono quindi conservate per l'avvio successivo del computer.

Disk Manager assegna automaticamente i punti di montaggio in /media, utilizzando /media/nomedisco (ad 
esempio, /media/HomeData) se la partizione ha un nome (label), oppure /media/device (ad esempio, 
/media/cdrom) in caso contrario. Questi punti di montaggio sono creati da Disk Manager quando una 
partizione viene montata, e rimossi immediatamente quando la partizione viene smontata.

AIUTO: Disk Manager
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Quali sono le altre partizioni sul mio pc Windows? 
I più recenti computer domestici con Windows sono venduti con una partizione di diagnostica e una di 
ripristino, in aggiunta a quella che vediamo con il sistema operativo installato. Se quindi GParted ci mostra 
più partizioni, di cui non eravamo a conoscenza, probabilmente si tratta proprio di quelle e conviene lasciarle 
cosi come sono.

Devo creare una home a parte ?
Non è necessario creare una home su una partizione appositamente dedicata, in quanto il programma di 
installazione di MX Linux inserisce la cartella dell'utente /home all'interno della partizione / (root). Ma averla
separata rende gli aggiornamenti più facili e sicuri, e protegge contro i problemi tipici causati dagli utenti, 
tipo riempire il disco con un sacco di immagini, musica o dati video.

Quanto grande dovrebbe essere la partizione / root ?

•  In Linux, la slash: "/" indica la partizione radice (root). La dimensione minima richiesta è un po meno
di 2,5 GB, ma si raccomanda un minimo di 5 GB per consentire tutte le funzioni di base.

• La dimensione minima non consente di installare molti programmi, e può presentare difficoltà nel fare
gli aggiornamenti, nell’eseguire VirtualBox, ecc. La dimensione ottimale per l'uso normale è quindi 
almeno di 10 GB.

• Se avete la vostra Home (/home) all'interno della directory Root (/) e si ha l’abitudine di memorizzare 
molti file di grandi dimensioni, allora si avrà bisogno di una partizione Root ancora più grande.

• I giocatori che giocano videogiochi complessi (ad esempio, Wesnoth) potrebbero notare che c’è 
necessità di una partizione / molto più grande del solito per i dati, immagini, file audio; in alternativa 
vi è la possibilità di utilizzare un disco dati separato.

Ho bisogno di creare un file di swap? 
Il programma di installazione creerà un file di swap in automatico (si veda la Sezione 2.5.1). 
Se usate la funzione di ibernazione (e non solo la sospensione) del sistema, queste sono le raccomandazioni 
per la dimensione dello spazio della swap:

• Per meno di 1 GB di memoria fisica (RAM), la dimensione della swap dovrebbe essere almeno 
uguale alla quantità di RAM di cui dispone il computer e al massimo due volte la quantità di RAM a 
seconda della quantità di spazio sul disco disponibile per il sistema.

• Per tutti gli altri sistemi con una quantità di RAM maggiore, la swap dovrebbe essere almeno uguale 
alla dimensione della RAM.

Gli utenti i cui computer dispongono di una unità SSD al posto di Hard Disk, spesso evitano di configurare 
un file SWAP sull’unità SSD per evitare di rallentare l’unità di memoria.

Cosa significano nomi come "sda"?
Prima di iniziare l'installazione, è fondamentale capire come i sistemi operativi Linux trattino  dischi rigidi e 
le partizioni.
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• Nomi delle unità di memoria. A differenza di Windows, che assegna una lettera di unità per ciascuna
delle vostre partizioni del disco rigido, Linux assegna un nome di dispositivo ad ogni disco rigido o 
altro dispositivo di memorizzazione su un sistema. I nomi dei dispositivi iniziano sempre con sd più 
una singola lettera. Per esempio, la prima unità del sistema sarà sda, la seconda sdb, ecc. Ci sono 
anche modi più avanzati per denominare le unità, il più comune dei quali è l'UUID (Universally 
Unique Identifier), utilizzato per assegnare un nome permanente che non verrà modificato con 
l'aggiunta o la rimozione di altri dispositivi.

• Nomi delle partizioni . All'interno di ogni unità, la partizione viene identificata con un numero 
aggiunto al nome del dispositivo. Così, ad esempio, sda1 sarebbe la prima partizione del primo disco 
rigido, mentre sdb3 sarebbe la terza partizione sul secondo disco.

• Partizioni estese . I primi hard disk di personal computer potevano avere solo quattro partizioni. 
Queste in Linux sono chiamate partizioni primarie e sono numerate da 1 a 4. È possibile aumentare il 
numero trasformando una delle partizioni primarie in una partizione estesa, e dividendo tale 
partizione in partizioni logiche (max 15) che sono numerate da 5 in poi. Linux può essere installato 
sia in una partizione primaria che in una partizione logica.

2.4  Primo avvio 

Login dell’Unità Live (Usb o DVD)

Dovendo fare il Log-in, in un unità Live oppure, sempre in un unità live, operazioni che richiedono i diritti 
di amministratore ad es. per installare nuovi pacchetti, tenete presente queste chiavi di accesso:

• Utente normale
• Nome: demo
• Password: demo

• Amministratore (root)
• Nome: root
• Password: root

2.4.1  Avviare l'unità Live

LiveCD/DVD
Inserire il DVD nel carrello del lettore e riavviare (presumiamo che il pc sia già configurato per il boot da cd-
rom).

LiveUSB
Potrebbe essere necessario qualche passaggio in più per far si che il vostro computer faccia un boot 
utilizzando correttamente la pennetta o altro media USB. Vediamo quali sono i più comuni :

• Per avviare il pc dall'unità USB, potrebbe essere necessario premere, all'accensione del pc, dei tasti 
speciali, con i quali visualizzare un piccolo menù con i dispositivi selezionabili per il boot. Ad 
esempio Esc oppure uno dei tasti funzione (F2, F8, F12) o il tasto Shift (Freccia su Maiusc). Si 
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leggano attentamente le info nella prima schermata che si visualizza durante il riavvio per trovare il 
tasto giusto, oppure leggere la documentazione a corredo del pc.

• In alternativa, potrebbe essere necessario andare nel BIOS per cambiare l'ordine delle periferiche di 
avvio:

• Avviate il computer e premete subito il tasto necessario (ad esempio, F2, F10 o Esc) per 
entrare nel BIOS

• Nel menu che si apre raggiungete la scheda “boot” utilizzando i tasti freccia della tastiera
• Identificate ed evidenziate il dispositivo USB (di solito, HDD USB) quindi, sempre 

utilizzando i tasti freccia, spostatelo in cima alla lista (o inseritelo, se il vostro sistema è 
impostato per questo). Salvate ed uscite

• In caso di dubbi o problemi nel modificare il BIOS, chiedete assistenza nei forum.
• Su computer più vecchi senza il supporto USB nel BIOS, è possibile utilizzare Plop Linux LiveCD 

(sito) che caricherà i driver USB e li mostrerà in un menu. Vedere il sito per i dettagli.
Una volta che il sistema è impostato per riconoscere l'unità USB durante il processo di avvio, basta collegare 
l'unità e riavviare la macchina.

UEFI

    Problemi con il Boot UEFI e alcune impostazioni da controllare!  
Se sul computer è già installato Windows 8 o versioni successive, devono essere fatte altre operazioni per far 
fronte alla presenza di (U)EFI e Secure Boot. 
L’Installer di MX Linux è stato configurato non solo per gestire il boot direttamente dal BIOS, ma anche 
mediante UEFI Boot. 
Unified Extensible Firmware Interface (UEFI) è il successore dei vecchi BIOS.
UEFI utilizza il GUID Partition Table (GPT), mentre BIOS utilizza lo schema di partizionamento Master 
Boot Record (MBR).
I formati GPT e MBR specificano entrambi le informazioni di partizionamento fisico sul disco rigido.

L’indicazione che si dà, valida per la maggior parte degli utenti, è di disattivare il Secure Boot accedendo alle
impostazioni del BIOS o Uefi all'avvio del computer. Una volta disattivato il Secure Boot però, la procedura 
corretta per avviare il computer con UEFI può variare a seconda del produttore.
Può essere sufficiente limitarsi a disattivare il "secure boot" mentre in altri casi si deve poi attivare la 
funzione “legacy support”.
A questo proposito:

Nonostante le specifiche UEFI richiedano che le tabelle delle partizioni MBR siano pienamente supportate, 
alcune implementazioni del firmware UEFI passano immediatamente al boot CSM (basato sul BIOS) a 
seconda del tipo di tabella delle partizioni del disco di avvio, impedendo in modo efficace l'avvio UEFI da 
partizioni del sistema EFI su dischi partizionati in MBR. (Wikipedia, “Unified Extensible Firmware 
Interface”, aggiornata al 14/12/19)  (qui nella versione italiana più sintetica, o qui per un approfondimento 
in italiano dal wiki Arch)

Per la risoluzione di eventuali problemi consultate questa pagina Wiki M  X/antiX   (qui in italiano) o chiedete 
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aiuto nel Forum 

Lo schermo nero
A volte può capitare che all’avvio del sistema operativo venga visualizzato uno schermo nero vuoto che 
mostra solo un cursore lampeggiante in un angolo. E' il risultato di un insuccesso nell’avviare X, il sistema 
grafico a finestre utilizzato da Linux, e normalmente la causa del problema sta nel driver  utilizzato per la 
scheda grafica.
Soluzione : riavviate e selezionate Safe Video or Failsafe nel menu delle opzioni di boot ottenibili digitando 
F6; dettagli su queste opzioni di boot sono nel Wiki. Per una soluzione permanente del problema, vedere 
Sezione 3.3.2.

Il menu di boot non richiama eventuali altri sistemi operativi
Se una volta completata l’installazione, al riavvio successivo nel menu di boot non si presentano le voci per 
l’avvio di eventuali altri sistemi operativi installati nel computer, allora si può ricorrere ad alcuni strumenti 
presenti in MX Tools (MX Strumenti): MX Ripara Boot e MX Opzioni di Boot.
Inoltre, se nel menù non si riesce a richiamare un eventuale sistema Windows presente, talvolta è necessario 
aprire un terminale e digitare:
update-grub

2.4.2  La tipica schermata di apertura (Schermata di Boot)

Figura 2-5: schermata di boot dell'unità Live della ISO x64

22

https://mxlinux.org/wiki/system/boot-parameters


All'avvio (al boot) dell'unità Live, avremo una schermata simile a quella della figura sopra. (La schermata di 

avvio [boot] quando il sistema è installato è molto diversa). Una guida molto dettagliata su questa schermata 

la si può trovare in questo documento.

Voci del menu principale 
Tabella 1: Voci del menu nell'unità Live (Cd/Dvd o Usb-pen)

Voce Commento 

MX-19-(DATA DI 

USCITA) 

Questa voce è impostata come predefinita, ed è il modo standard che la maggior parte 
degli utenti usano per avviare il sistema live. È sufficiente premere Invio per avviare il 
sistema. 

Avvio da disco 
rigido 

Permette all'utente di selezionare e avviare una ISO salvata sull'hard disk.

Test della 
memoria 

Esegue un test per verificare la RAM. Se si passa questo test poi può sussistere un 
problema hardware o comunque ancora un problema con la RAM, ma se fallisce si 
capisce dove è necessario intervenire.

In basso sullo schermo, c’è una riga di voci aggiuntive, sotto la quale appare una fila di opzioni per ogni 
voce; premere F1 per i dettagli su ogni voce.

Opzioni

• F2 Lingua . Imposta la lingua del bootloader e del sistema nella Live di MX. Quando 

successivamente si procederà all'installazione sul disco rigido, la localizzazione scelta verrà trasferita 

automaticamente.

• F3 Fuso orario . Impostare il fuso orario per il sistema. Anche questa impostazione verrà trasferita 

durante l'installazione del sistema.

•  F4 Opzioni . Opzioni aggiuntive per il controllo e l’avvio del sistema Live. La maggior parte di 

queste opzioni sono temporanee e non vengono trasferite sul disco rigido con l'installazione.

• F5 Persist . Opzioni per mantenere le modifiche sull'unità LiveUSB anche dopo che la macchina è 

stata spenta.

• F7 Console . Imposta la risoluzione delle consolle virtuali. Può entrare in conflitto con il Kernel in 

Mode Setting. Può essere utile se si sta avviando l’installazione da riga di comando o se si sta 

cercando di fare il debug del processo di avvio. Questa opzione si trasferirà al momento 

dell'installazione.

Altre chiavi di scelta per la LiveUSB possono essere trovate nel Wiki di M  X/antiX  . 

Le chiavi (cheatcode) per l'avvio di un sistema installato sono differenti, e possono essere trovate nello stesso

documento.

Maggiori info: processo di avvio Linux
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2.4.3  La schermata di apertura UEFI Boot

Figura 2-6: Schermata di boot dell'unità Live x64 quando viene rilevato l'UEFI 

Se l'utente sta utilizzando un computer settato su UEFI-Boot (vedi Wiki di MX/antiX e in italiano Wiki Ita 
MX ), all'inserimento dell'unità Live, invece della schermata di boot vista in precedenza, verrà visualizzata 
quella di UEFI-LIVE-boot con differenti scelte. 

• MX-19x_x64 
• Customize Boot with menus (avvio personalizzato) 

Se si desidera impostare la localizzazione (consigliato per gli utenti di lingua non inglese) o altre opzioni, 
scegliere la seconda opzione: "Customize Boot with menus." Che farà comparire una seconda schermata 
con varie opzioni di menu; basterà selezionare quello che si vuole e seguire le istruzioni. 

2.4.4  Schermata di Login 

Figura 2-7: Schermata di Login, con pulsanti per le opzioni nell’angolo in alto a destra
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Il processo di avvio, su un sistema installato, termina con la schermata di Login (a meno che non abbiate 
optato per l’auto-login); in una sessione Live viene visualizzata solo l'immagine dello sfondo, ma se si 
effettua il logout dal desktop si vedrà la schermata di Login. (Il layout dello schermo varia da versione a 
versione di MX). Su schermi piccoli, l'immagine potrebbe apparire ingrandita; questa è una caratteristica del 
display manager usato da MX Linux.

Si possono vedere quattro piccole icone all'estremità destra della barra superiore. In ordine da destra a 
sinistra: 

• Il pulsante di accensione, in angolo, contiene opzioni per sospendere, riavviare e spegnere.
• Il pulsante di localizzazione permette all'utente di selezionare la tastiera appropriata per la schermata

di login.
• Il pulsante di aiuto visivo che soddisfa le esigenze particolari di alcuni utenti.
• Il pulsante di sessione permette di scegliere quale desktop manager si desideri utilizzare: sessione 

predefinita, sessione Xfce, eventualmente seguito da qualsiasi altro abbiate installato per conto vostro 
(paragrafo 6.3). 

Se desiderate evitare di dover effettuare il login ogni volta che avviate il computer (non raccomandato 
laddove vi fossero problemi di sicurezza), è possibile saltarlo scegliendo “autologin” sulla scheda "Opzioni" 
di MX Manager Utenti. 

2.4.5  Il desktop 

 Xfce 4.12

Il desktop viene creato e gestito da Xfce 4.14 , anche se il suo aspetto e disposizione sono stati pesantemente 
modificati in MX Linux. Nota le due caratteristiche dominanti con cui si presenta il sistema: pannello e 
schermata di benvenuto.

Pannello
Il desktop predefinito di MX Linux ha un unico pannello verticale sul lato sinistro dello schermo. Il pannello 
in modalità orizzontale si può ottenere cliccando su MX Strumenti> MX Rifiniture. 
Elementi del pannello di default procedendo dall'alto verso il basso: 

• Pulsante di accensione, apre una finestra di dialogo per il log-out, il riavvio, arresto, e sospensione.
• Orologio in formato LCD. Cliccando si rende visibile un calendario
• Pulsanti delle finestre: area in cui vengono mostrate le applicazioni aperte
• Browser Firefox 
• File manager (Thunar) 
• Area di notifica 

• Update Manager (aggiornamenti del software)
• Clipboard Manager (gestore degli appunti copia-incolla)
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• Manager Tastiera 
• Network Manager (gestore delle connessioni internet)
• Manager del volume
• Manager dell’Alimentazione (Power Manager)
• USB ejector (smonta periferiche USB)
• Icone di altre applicazioni (ad esempio, Bluetooth). Alcune applicazioni durante l'esecuzione 

possono inserire qui le loro icone.
• Pager: visualizza gli spazi di lavoro o workspace (per impostazione predefinita sono 2, ma cliccando 

col destro se ne può cambiare il numero) 
• Pulsante Start (avvia il "Whisker menu") 

• Altre applicazioni (qui: MX Welcome, appena sotto l'orologio) possono inserire icone nel Pannello, o 
nell'area di notifica, mentre sono in l'esecuzione.

Per cambiare le proprietà del pannello, vedere la sezione 3.8.

Schermata di benvenuto 

Figura 2-8: Schermata di Benvenuto in MX-19 (installato)

Quando un utente procede all'avvio del sistema per la prima volta, una schermata di benvenuto appare al 

centro dello schermo offrendo consigli, suggerimenti e collegamenti a guide e tutorial.

Una volta chiusa, sia che si stia eseguendo il sistema in modalità Live oppure sia installato, può essere 

nuovamente visualizzata attraverso il Whisker menu o dagli MX Tools.

È molto importante per i nuovi utenti prestare attenzione agli argomenti dei vari pulsanti, in quanto farà 

risparmiare molta confusione e fatica nell'uso futuro di MX-Linux. Se il tempo a disposizione è limitato, si 

raccomanda di dare un occhiata almeno al documento delle FAQ, raggiungibile attraverso un icona sul 

Desktop, dove vengono fornite le risposte alle domande più comuni.

Quando si avvia il CD/DVD o la chiavetta USB in modalità Live, le password per l'utente-demo (utente 

provvisorio di default) e per root verranno mostrate nella schermata di benvenuto in basso.
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Consigli e suggerimenti 

Figura 2-9: Il Gestore delle Impostazioni (o Tutte le Impostazioni) è il quadro di base per apportare 
modifiche al sistema (i contenuti in figura potrebbero non corrispondere ). 

Alcune cose utili da sapere all'inizio: 

• Se si hanno problemi con l'audio, connessioni, ecc. vedere Configurazione (sezione 3). 
• Per regolare il volume generale del suono portatevi con il cursore sopra l'icona dell'altoparlante, 

quindi regolate il volume ruotando la rotellina del mouse , oppure cliccando col destro sull'icona 
dell'altoparlante> Open Mixer. 

• Per impostare il sistema ad un particolare layout della tastiera fate clic su Menu-Start> 
Impostazioni> Tastiera , scheda Mappatura, quindi selezionate il modello con il menu a tendina. 
Questo è anche il luogo dove è possibile aggiungere tastiere per altre lingue. 

• Regolate le preferenze per mouse o touchpad facendo clic su Menu-Start > Impostazioni> Mouse e 
Touchpad . 

• Il Cestino può essere facilmente gestito nel File Manager (Thunar), dove potrete vedere la sua icona 
nel pannello di sinistra. Cliccate col destro per svuotarlo. Può anche essere aggiunto al desktop o sul 
pannello del desktop. E 'importante sapere che volendo cancellare dei file se, una volta evidenziati, si 
preme il tasto CANC finiranno nel cestino e saranno recuperabili, se invece si sceglie la voce Elimina 
dal menu contestuale che compare cliccandoci sopra col destro, gli elementi selezionati saranno 
rimossi per sempre e non saranno recuperabili. 

• Potete mantenere il vostro sistema aggiornato controllando l'icona a forma di scatola di MX-
Aggiornamenti, se verde indica che sono disponibili aggiornamenti. Si veda la Sezione 3.2 per i 
dettagli. 
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• Le combinazioni di tasti di scelta rapida (gestite in Gestore delle impostazioni> Tastiera> Scorciatoie 
applicazioni). 

Tabella 2: Tasti di scelta rapida 

Combinazioni Azione 

F4 Fa comparire un terminale nella parte superiore dello schermo

Tasto Windows Si apre il menu Whisker 

Ctrl-Alt-Esc Cambia il cursore in una x per uccidere qualsiasi programma 

Ctrl-Alt-Bksp Chiude la sessione (senza salvare!) e si ritorna alla schermata di login 

Ctrl-Alt-Canc Blocca il desktop evocando xflock4

Ctrl-Alt-F1 
Si esce dalla vostra sessione X (sessione grafica) per trovarsi in una sessione a riga di 
comando; usare Ctrl-Alt-F7 per tornare. 

Alt-F1 Apre questo Manuale Utente di MX Linux

Alt-F2 Apre una finestra di dialogo per eseguire un'applicazione 

Alt-F3 Apre “Trova applicazioni” che permette anche la modifica di alcune voci del menu 

Alt-F4 Chiude l'applicazione presente sulla finestra a fuoco (in evidenza sul desktop) facendo 
apparire un messaggio di uscita.

Stamp (PrtScr) Apre Istantanea (Screenshooter), applicazione per catturare le schermate 

Applicazioni 
Le applicazioni possono essere avviate in vari modi. 

Figura 2-10: Menu Whisker 

• Cliccare sull'icona (con logo MX) del Menu-Start (whisker), sullo schermo in basso a sinistra. 
• Si apre la categoria Preferiti, passando col cursore del mouse sopra le altre categorie sul lato 

destro si potrà vederne il contenuto nel riquadro sinistro. Se volete potete spostare le categorie 
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a sinistra e i contenuti a destra, si può fare cliccando col destro sull'icona del menu-start → 
Proprietà→ scheda Comportamento→ “Posizionare categorie accanto al pulsante del 
pannello”. 

• Nella parte superiore è presente il campo di un potente motore di ricerca incrementale: basta 
digitare poche lettere per trovare qualsiasi applicazione senza bisogno di conoscere la sua 
categoria. 

• Cliccando col destro sul desktop→ Applicazioni. 
• Se conoscete il nome dell'applicazione, potete usare Trova Applicazioni, che potete avviare facilmente

con uno di questi modi.
• Cliccando col destro sul desktop→ Esegui comando ... 
• Alt-F2 
• Alt-F3 porta in primo piano una versione avanzata di Trova Applicazioni che consente di 

accedere alle preferenze di questa funzione.
• Per definire una combinazione di tasti per aprire una applicazione preferita, cliccate su Menu-Start→

Impostazioni , quindi Tastiera, scheda Scorciatoie applicazioni. 

 
Figura 2-11: Ricerca di un’applicazione con Trova Applicazioni

Sistema 
Informazioni di sistema 

•  Cliccate su Start> Veloce Info di Sistema che vi copierà il risultato del comando inxi -Fxrz sugli 
appunti pronto per essere incollato in un post del Forum, in file di testo, ecc.

• Cliccate su Start> Sistema> System Profiler e Benchmark (hardinfo) per una visualizzazione 
grafica delle informazioni del sistema  

Video e audio 

• Per le impostazioni base del monitor, fate clic su Start Menu> Impostazioni> Schermo 
• La regolazione audio avviene attraverso Start Menu> Multimedia> Regolazione del Volume di 

PulseAudio (posizionare il mouse sull'icona del Volume nel pannello e girare la rotellina o cliccare 
col destro) 

NOTA : per la risoluzione dei problemi in determinate aree come il video, suono o internet, consultate la 
Sezione 3: Configurazione. 

Collegamenti

• documentazione Xfce  
• Xfce domande frequenti  
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2.4.6  Uscita 

Quando si apre menù Whisker (o Menu-Start), si vedranno quattro pulsanti di comando presenti di default 
nell'angolo in alto a destra (cambia cosa vuoi che venga mostrato cliccando col destro sull'icona del menu> 
Proprietà, scheda Comandi).

Da sinistra a destra: 

• Tutte le impostazioni 
• Blocca schermo 
• Cambia utente 
• Uscire - Log out

 
 Figura 2-12: Pulsanti di comando

E 'importante uscire da MX Linux correttamente quando avete finito la vostra sessione in modo che il sistema
possa essere spento in modo sicuro. In primo luogo tutti i programmi in esecuzione sono informati che il 
sistema sta per chiudersi, dando loro il tempo per salvare qualsiasi tipo di file in fase di modifica, uscire dalla
posta elettronica, programmi di news, ecc. Se ci si limitasse a chiudere l'alimentazione, si rischierebbe di 
danneggiare il sistema operativo . 
Permanente 
Per uscire correttamente da una sessione, selezionate una delle seguenti opzioni nella finestra di dialogo di 
Log Out: 

• Esci. Scegliendo questo pulsante terminerà tutto quello che state facendo, chiedendovi di salvare i 

file aperti se non li avevate già chiusi prima, e vi riporterà alla schermata di login con il sistema 
ancora in esecuzione.

• Nella parte inferiore della finestra di dialogo di Log Out è selezionata, per impostazione 
predefinita, l'opzione: "Salva la sessione per i prossimi accessi". Il suo compito è quello di 
salvare lo stato del desktop (applicazioni aperte e loro posizione) e ripristinarli durante l'avvio 
successivo. Se avete avuto problemi con la funzione desktop, è possibile deselezionare la 
casellina di questa opzione e poi procedere con un nuovo avvio; se questo non risolve il 
problema, fate clic su Tutte le Impostazioni> Sessione e avvio> scheda Sessione, quindi 
premete il pulsante Elimina le sessioni salvate. 

• Ctrl-Alt-Bksp si tornerà alla schermata di login, ma tutti i programmi e i processi aperti non verranno
salvati. 

• Riavvia o Spegni. Opzioni auto-esplicative. Disponibili anche utilizzando l'icona nell'angolo in alto a
destra della barra superiore nella schermata di login. 

Temporaneo 
È possibile lasciare temporaneamente la sessione in uno dei seguenti modi: 
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• Blocco dello schermo . Questa opzione è facilmente ottenibile grazie ad un'icona (icona blocca 
schermo) posta nell'angolo in alto a destra del menu Start. Protegge il vostro desktop da accessi non 
autorizzati mentre si è lontani, richiedendo la password all'utente per tornare alla sessione. 

• Avviare una sessione parallela come altro utente . Questa opzione è disponibile attraverso l'icona 
“Commutazione utenti” nell'angolo in alto a destra del menu Start. Si clicca su questo pulsante 
quando si vuole lasciare così com'è la sessione corrente e contemporaneamente si vuole avviare una 
sessione per un utente diverso. 

• Sospendere attraverso il pulsante di Log Out. Questa opzione è disponibile nella finestra di dialogo 
che si apre cliccando sul pulsante Log Out, e pone il sistema in uno stato di basso consumo. Le 
informazioni sulla configurazione del sistema, le applicazioni e i file attivi vengono memorizzate 
nella memoria principale (RAM), mentre la maggior parte degli altri componenti del sistema vengono
spenti. E 'molto utile, e generalmente funziona molto bene in MX Linux. Invocato dal pulsante di Log
Out, la sospensione funziona bene per la maggior parte degli utenti, anche se il suo corretto 
funzionamento varia a seconda della complessa interazione tra i componenti di un sistema: kernel, 
display manager, chip video, ecc. In caso di problemi, potete cercare di risolvere intervenendo con le 
seguenti modifiche:

• Cambiare il driver grafico. Ad esempio, da radeon a AMDGPU (per le nuove GPU), o da 
nouveau ai driver proprietari Nvidia.

• Regolare le impostazioni nel menu Start> Impostazioni> Gestore di energia. Per esempio: 
nella scheda Sistema, provate a deselezionare "Blocca lo schermo quando il sistema viene 
addormentato." 

• Fare clic sul menu Start> Impostazioni> Screensaver, e aggiustate i valori in Gestione 
dell'alimentazione del monitor sulla scheda Avanzate. 

• Schede AGP: aggiungere Option "NvAgp" "1" nella sezione Device di xorg.conf 
• Sospendere chiudendo il coperchio-schermo del portatile. Alcune configurazioni hardware 

potrebbero avere problemi nel sospendere in questo modo. Questo è molto meno affidabile rispetto ad
utilizzare il pulsante di Log Out, e non è generalmente raccomandato. L'azione sulla chiusura del 
coperchio può essere regolato nella scheda Generale di Gestore di energia, dove "Blocca lo schermo" 
si è dimostrato affidabile nell'esperienza di molti utenti MX. 

• Ibernazione. L'opzione di ibernazione è stata rimossa, già nelle precedenti versioni di MX, dalla 
finestra di dialogo che si apre cliccando sul pulsante Log Out perché gli utenti hanno riscontrato 
diversi problemi. In MX-19 può essere attivata attraverso MX Rifiniture, scheda Altri. Consulta anche
il Wiki   MX/antiX  

2.5  Il processo di installazione

2.5.1  Fasi dettagliate d'installazione

 Installazione di MX Linux Impostazioni della cartella Home (e Gestione del disco)

Per cominciare, avviare l'unità Live (Cd/Dvd o Usb-pen), ci vorrà qualche minuto perchè si carichi il sistema 
Live, poi quando si presenterà lo schermo di MX, cliccare sull'icona di installazione nell'angolo in alto a 
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sinistra. Se l’icona non dovesse essere presente (ad es. Su una ISO rimasterizzata con MX ISO Snapshot), 
cliccate il tasto F4, si aprirà il terminale, e inserite:

sudo minstall

(utente e password su un’unità Live: demo).

L'installazione inizia con una finestra di benvenuto e condizioni d'uso. Successivamente, saranno mostrate 
una serie finestre con alcune scelte da fare, accompagnate da istruzioni dettagliate.

Figura 2-13: Schermata di benvenuto del programma di installazione. 
Commenti 

• Il lato destro della schermata di installazione presenta le opzioni che l’utente deve scegliere durante il 
processo di installazione; il lato sinistro fornisce chiarimenti sul contenuto del lato destro.

• Imposta Tastiera permette di cambiare il tipo di tastiera per il processo d’installazione.

Figura 2-14: Impostato su “Installaz. personalizzata su partizioni esistenti”
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Commenti 

• Scegli il disco per l’installazione - Usa il disco:

Il disco su cui installare, nella maggioranza dei sistemi con un solo disco fisso, sarà: Sda. 

Se c’è un solo disco fisso nel vostro computer il sistema lo identificherà come Sda, mentre un 

eventuale pennetta-Usb connessa, verrà identificata come sdb. 

Se ci fossero due hard disk, il primo sarà sda, il secondo sdb, ed una eventuale usb-pen, in questo 

caso, sarà sdc. 

Se non siete sicuri di come sia identificato il disco su cui desiderate installare il sistema, utilizzate i 

nomi che vedete in GParted. 

Il disco selezionato sarà esaminato superficialmente per l'affidabilità da SMART . Se vengono rilevati

problemi, si vedrà una schermata di avviso. Dovrete decidere se accettare il rischio e continuare, 

selezionare un altro disco o terminare l'installazione. Per ulteriori informazioni, fate clic Start> 

Sistema> GSmartControl e "Esegui test" (“Perform tests”) sul disco. 

 
Figura 2-15 : SMART avvertimento di rischio fallimento 

• Installazione automatica usando l'intero disco . Selezionate questa opzione se prevedete di 

utilizzare l'intero disco rigido per MX Linux e non siete particolarmente informati su come le 

partizioni siano impostate. Se si seleziona questa scelta, l'installer creerà per voi una partizione di root

e una di swap utilizzando l'intero disco. È possibile specificare una quantità di spazio da lasciare 

inutilizzato, se si prevede di creare più partizioni in seguito. Assicuratevi di aver compreso che la 

selezione di questa opzione eliminerà tutte le partizioni e i dati esistenti. Scegliete questa opzione 

solo se non si ha intenzione di salvare nulla del disco rigido selezionato. 

• Comparirà un messaggio pop-up chiedendo di confermare l'uso dell'intero disco.

Nota. L’installer sceglie di default “Installazione automatica usando l’intero disco” se rileva una 
sola partizione, se invece rileva la presenza di più partizioni, verrà presentata come scelta di default 
“Installazione personalizzata su partizioni esistenti” consentendovi di scegliere un eventuale altra 
partizione su cui si desidera effettuare l'installazione.
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• Riorganizza le partizioni del disco – Avvia partizionatore. Questa opzione avvia Gparted e 

permette di modificare le partizioni esistenti nel disco, tuttavia molti utenti hanno concluso che, se 

servono, è meglio crearle o modificarle prima di iniziare il processo di installazione per evitare 

possibili problemi - per esempio potrebbero non presentarsi, nel menu a discesa dell’installer in 

“Scegli le partizioni” , le partizioni appena create attraverso questa opzione. Quindi conviene crearle 

o a livello di Windows utilizzando applicazioni specifiche per questo compito, oppure attraverso il 

Cd/dvd/Usb-pen in modalità live utilizzando l'applicazione Gparted. Completato il partizionamento 

converrà uscire dal Live per poi ricaricarlo, e a quel punto si procederà con l'installazione. 

Nota. Cliccando sul pulsante “Avvia partizionatore” si avvierà Gparted, come abbiamo detto. 

Potrebbe essere utile aprirlo anche senza voler partizionare, solo per vedere come sono organizzate 

le partizioni del disco, se ci fosse venuto un dubbio in proposito. Chiudendo Gparted si ripresenterà 

questa prima schermata d’installazione che stiamo descrivendo.

• Installazione personalizzata su partizioni esistenti Se si installa MX Linux in dual-boot con un 

altro sistema operativo, o se si desidera che le dimensioni delle partizioni siano definite manualmente,

è necessario selezionare questa opzione. 

Se non avete già preparato in precedenza le partizioni (vedi Sezione 2.3), è possibile cliccare sul 

pulsante “Avvia partizionatore”, verrà avviata l'applicazione GParted e potranno essere create in 

questo momento. Ovviamente vanno considerate le contro-indicazioni dette in precedenza, comunque 

nella maggioranza dei casi non ci sono problemi ed eventualmente si può interrompere l'installazione, 

uscire dal Live e riprovare successivamente con le partizioni modificate. 

Comunque, sia che abbiate creato le partizioni attraverso l’opzione “Avvia partizionatore” sia che 

Gparted (o altri strumenti adatti) lo abbiate avviato prima di far partire l’installer, in ogni caso 

selezionate questa opzione e cliccate sul pulsante “Avanti” solo dopo aver preparato le partizioni che 

vi serviranno nella fase successiva. 

• Crittografia. Con MX-19 è disponibile una nuova funzione: la criptazione dell’intero disco (Figura 

2-16).
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Figura 2-16: Installer impostato su Crittografia

Figura 2-17: l’ installer mostra la scelta delle partizioni
Commenti 
(Se si sceglie Installazione automatica usando l'intero disco visibile nella schermata 1, non comparirà 
questa schermata.) 

• Scegli le partizioni . Specificate le partizioni di root e di swap che volete usare. Se volete impostare 

una partizione separata per la vostra home directory, specificatelo qui, altrimenti lasciate preimpostato

/home partition : root.
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• Si noti che “/home partition : root” significa che la cartella /home dell'utente sarà all'interno 

della partizione / (di root) su cui viene installato MX.

• Molti utenti preferiscono allocare la loro home directory in una partizione diversa da quella 

di / (root), così che se dovesse insorgere un qualsiasi grave problema per il quale sia 

conveniente effettuare una nuova installazione si potranno mantenere tutte le impostazioni 

individuali dell'utente all'interno della partizione ricavata per la /home, rimanendo questa 

intatta, mentre si reinstallerà esclusivamente la partizione root. 

• Si noti che la partizione (sda1) mostrata nella figura soprastante è solo un esempio; la tua 

partizione da selezionare potrebbe essere diversa

• A meno che non stiate usando la crittografia o sappiate cosa state facendo, lasciate boot 

impostato su root.

• Preferenze .
• Si può selezionare “Preserve data in /home” (Preservare dati della /home) se si sta facendo un 

aggiornamento della distribuzione (upgrade) e avevate scelto di creare una partizione separata 

per la /home . Questa opzione non è generalmente raccomandata a causa del rischio che i 

vecchi files di configurazione non corrispondano alla nuova installazione, ma può essere utile 

in situazioni specifiche, ad esempio, per la riparazione del sistema. 

• Selezionare Check for bad blocks (Ricerca bad blocks) se si vuole fare una scansione durante 

la formattazione degli eventuali difetti fisici del disco rigido. Questo è consigliato per gli 

utenti con unità meno recenti. 

• È possibile modificare l'etichetta della partizione in cui si desidera installare (ad esempio, 

"MX-19 Test di installazione") 

• E’ possibile selezionare il tipo di file system che si desidera utilizzare sul disco rigido. Di 

default MX Linux imposta ext 4, ma potete cambiarlo se avete esigenze particolari. 

• Potete mantenere i valori predefiniti di crittografia o, se preferite, potete affinarne le 

impostazioni con il pulsante "Impostazioni avanzate di crittografia".
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Figura 2-18: L’installer richiede la scelta del metodo di boot
Commenti 

• Mentre la parte principale del sistema operativo viene copiata sul disco rigido, vi verranno chieste 
alcune informazioni aggiuntive sulla configurazione. La Figura 2-18 mostra le opzioni di installazione
del bootloader di GRUB. Il disco (sda) mostrato nella figura, da selezionare per il boot, è un esempio; 
il tuo disco da sciegliere potrebbe essere diverso

• La maggior parte degli utenti normali accetteranno le impostazioni predefinite di questa schermata, 
che prevedono l'installazione del bootloader all'inizio del disco. Questa è la posizione consueta e non 
causerà alcun danno. 

• Quando si sceglie Avanti, un messaggio pop-up richiederà conferma ad accettare la posizione del 
bootloader GRUB. L'Installazione di GRUB può richiedere alcuni minuti in alcuni casi. 

Figura 2-19: Impostazione del nome del Computer in rete
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Commenti 
• Molti utenti scelgono un nome preciso per il proprio computer: laptop1, MioComp, StudioDesktop, 

Spippolo, ecc. Si può anche solo lasciare il nome predefinito così com'è. 
• Si può semplicemente cliccare su Avanti se il computer non è inserito in una rete di computer. 

• Puoi disabilitare samba se non hai intenzione di ospitare sul tuo PC cartelle condivise nella rete. 
Questo non influisce sulla capacità del PC di accedere alle condivisioni ospitate altrove sulla rete.

Figura 2-20: Impostazione della localizzazione, del fuso orario e dei servizi.
Commenti 

• Le impostazioni predefinite di solito sono corrette qui, a patto che si sia fatta attenzione a inserire la 
localizzazione italiana (attraverso il tasto F2) alla schermata di avvio (boot) dell'unità-Live. 

• E' importante che la localizzazione sia corretta, le altre impostazioni: orario, fuso orario, tastiera, 
possono essere modificate anche successivamente una volta avviato Xfce, attraverso il gestore delle 
impostazioni. Anche la localizzazione si potrà modificare successivamente, ma averla già definita 
prima di avviare l’installer permetterà di visualizzare le opzioni di scelta e i dialoghi di aiuto in 
italiano con minor rischio di confusione.

Figura 2-21: Abilitazione/disabilitazione dei Servizi 
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Commenti 

• Questa schermata si presenta solo se si era cliccato su "Mostra" a livello della schermata di 
impostazione della localizzazione, del fuso orario e dei servizi

• I servizi sono le applicazioni e le funzioni associate al kernel che forniscono funzionalità per i 
processi di livello superiore.

• Queste applicazioni e funzioni richiedono capacità e memoria, quindi se siete preoccupati delle scarse

prestazioni del vostro computer, si può guardare a questa lista per non avviare gli elementi che si è 

sicuri non essere necessari. Per esempio, un utente che non ha bisogno di Bluetooth (per un mouse o 

per la tastiera, per esempio) possono comodamente deselezionare tale servizio, ma se non si è sicuri di

quel che fa un servizio è meglio lasciarlo così com’è impostato di default.

• Se successivamente si desidera cambiare o regolare i servizi di avvio si hanno due scelte.

• uno strumento da riga di comando chiamato sysv-rc-conf è installato di default e deve essere 
eseguito come root. 

• uno strumento grafico chiamato Boot-Up Manager (BUM) può essere installato dai 
repository. 

 Figura 2-22: Configurazione Utente
Commenti 

• Il livello di sicurezza delle password che si scelgono qui dipenderà molto dall'uso che si fa del 

computer su cui si installa. Un desktop a casa generalmente presenta meno probabilità di essere 

violato rispetto ad un computer portatile o un computer in uno spazio pubblico. 
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• Se si seleziona Autologin, si sarà in grado di bypassare la schermata di login e di accelerare il 

processo di avvio. L'aspetto negativo di questa scelta è che chiunque con un qualche tipo di accesso al

computer potrebbe essere in grado di accedere direttamente al tuo account. Volendo è possibile 

modificare la preferenza per l’autologin anche in seguito, utilizzando MX User Manager (MX 

Manager Utenti) e poi andando sulla scheda "Opzioni" .

• È possibile trasferire tutte le modifiche apportate durante la sessione Live, al Desktop installato 

sull'hard Disk selezionando l'ultima opzione. In ogni caso, una piccola quantità di informazioni 

critiche (ad esempio, il nome della rete wireless) saranno trasferite in automatico. 

Figura 2-23: Installazione Completata

Commenti

• Una volta terminata la copia del sistema e completate le fasi di configurazione, verrà presentata una 

schermata che avvisa che l’installazione è completata e si sarà pronti a partire!

• Se non si desidera riavviare il sistema dopo aver completato l'installazione, deselezionare l'opzione di 

riavvio automatico prima di cliccare su Fine.
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2.6  Risoluzione dei problemi 

2.6.1  Nessun sistema operativo trovato 

Talvolta accade che, al riavvio dopo l'installazione, il computer segnali che non è stato trovato alcun sistema 

operativo o disco di avvio, e che non riesca a mostrare altri sistemi operativi installati come ad es. Windows. 

Di solito, se si verifica questo problema, significa che GRUB non è stato installato correttamente, comunque 

il problema è facile da correggere. 

• Se è possibile avviare almeno una partizione, una volta avviata, aprite un terminale di root ed eseguite

il comando: 

update-grub 

• In caso contrario, procedere con MX Ripara Boot.

• Inserite una unità Live (Cd/Dvd o Usb-pen) sul computer in cui riparare GRUB e avviate la 

Live. 

• Quando si apre la schermata del desktop dell'unità Live andate su Pulsante Start -> MX 

Tools> Ripara Boot . 

• Assicurarsi che sia selezionata l'opzione "Reinstallare GRUB", quindi fate clic su OK. 

• Se nonostante questo, il problema continua a non essere risolto, è possibile che abbiate un 

disco rigido difettoso. Di norma dovreste aver visto una schermata di avviso-SMART 

riportante un problema all'Hard Disk durante le prime fasi dell'installazione. 

2.6.2  Altre partizioni (o unità di memoria dati) non accessibili. 

Le partizioni e le unità diverse da quella indicata per il boot potrebbero non avviarsi dopo l'installazione o 

richiedere l'accesso come utente root. Ci sono un paio di modi per affrontare questo problema. 

• Per le unità interne, utilizzare Start > Impostazioni  > MX Rifiniture, scheda Altro, selezionare: 

"Abilita montaggio di unità interne da parte di utenti non root"

• GUI . Fate clic su Start Menu> Sistema> Disk Manager. Selezionate (vidimate la casella) tutto quello 

che volete sia montato al boot e salvate; al successivo riavvio dovrebbe essere montato e ci si 

dovrebbe poter accedere attraverso Thunar. 

Per dettagli.vedere AIUTO: Disk Manager

• CLI . Aprite Thunar come root (Barra dei Menu> File>Apri root Thunar qui, oppure aprite un 

terminale, loggatevi come root, e digitate thunar) poi individuate il file /etc/fstab; cliccateci sopra per 

aprirlo in un editor di testo. Cercate la riga contenente la partizione o unità a cui si desidera accedere 
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(potrebbe essere necessario digitare blkid in un terminale come root per identificare l'UUID). 

Modificate seguendo questo esempio per una partizione dati.

UUID = 9501.......912 /data ext4 users 0 2

L'inserimento di una voce di questo tipo, farà sì che la partizione venga automaticamente montata al 

boot del sistema, e vi permetterà anche di montarla e smontarla come normale utente. Questa voce 

inoltre farà si che il filesystem venga controllato periodicamente in fase di avvio. Se non si desidera 

che venga montata automaticamente al momento del boot allora modificate il campo delle opzioni da 

"user" a "user, noauto". 

• Se non si desidera che venga controllato regolarmente allora modificate il "2" presente alla 

fine della riga, in "0". Se si dispone di un filesystem ext4 si suggerisce di attivare il controllo 

automatico. 

• Se la voce è montata, ma non viene vista in Thunar, aggiungere "comment=x-gvfs-show"  

nella riga inserita nel file fstab, che costringerà a rendere visibile ciò che è stato montato. 

Nell'esempio precedente, la variazione sarebbe simile a questa:

UUID = 9501.......912 /data ext4 users,comment=x-gvfs-show 0 2 

NOTA: nessuna di queste procedure farà cambiare i permessi Linux, che sono impostati a livello di cartelle e 

di files. Vedere la Sezione 7.3. 

2.6.3  Problemi con i portachiavi (keyring)

Un portachiavi predefinito viene creato automaticamente senza che l'utente debba fare nulla. Se si utilizza 

l'autologin, quando un'applicazione accede al portachiavi, all'utente verrà chiesto di inserire una nuova 

password per creare un nuovo portachiavi predefinito.

Se impostate una password per la prima volta, apparirà la finestra di dialogo di GNOME-Keyring  (di solito 

appare quando si imposta Network Manager), allora si sarà obbligati a reinserirla ogni volta che si riavvia il 

computer. Ci sono due modi per cambiare la situazione: 

• Cliccate su Start Menu > Accessori > Passwords e Chiavi (seahorse). Cliccate col destro su 

Portachiavi Predefinito > Cambia Password. Rimpiazzate la password impostata come “Portachiavi 

Predefinito” con una vuota. Dettagli sull'uso di Seahorse qui, e in italiano qui. 

• Navigate in Thunar in ~/.local/share/keyrings/ e cancellate la password di rete. La volta successiva 

che la finestra di dialogo vi chiederà una nuova password, basterà premere Invio per memorizzare una

password vuota. 
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Si noti che se degli agenti malevoli avessero accesso fisico al vostro computer, utilizzare una password vuota 

gli renderà più facile entrare. Ma risulta comunque abbastanza chiaro che se un agente malevolo ha accesso 

fisico alla vostra macchina siete fregati in ogni caso. 

2.6.4  Blocco dell'installazione

Se MX Linux si blocca durante l'installazione, di solito la causa è un problema con l'hardware difettoso del 

computer, oppure un cattivo DVD. Se si è stabilito che il DVD non è il problema, la causa può essere una 

memoria RAM difettosa, un Hard Disk danneggiato, o qualche altro componente hardware difettoso o 

incompatibile. 

• Aggiungete una delle Boot Options utilizzando F4 al boot o eventualmente consultate il Wiki 

M  X/antiX   . Il problema più comune viene dal driver grafico. 

• L'unità DVD potrebbe avere problemi. Se il sistema lo supporta, create una chiavetta-USB avviabile 

di MX Linux e installate il sistema sul computer dalla chiavetta. 

• Ci potrebbe essere un blocco a causa del surriscaldamento. Aprite il case (il box) del computer e 

verificate che tutte le ventole funzionino quando il computer è acceso. Se il BIOS lo supporta, 

controllate le temperature della CPU e scheda madre (digitate sensors in un terminale di root se 

possibile) e confrontatele con le specifiche di temperatura per il sistema. 

• Spegnete il computer e rimuovete qualsiasi hardware non essenziale, quindi tentate di nuovo 

l'installazione. Gli hardware non essenziali possono includere USB, dispositivi inseriti nella porta 

parallela o seriale; Hard Disk esterni, Schede di espansione ISA (escluse quelle video, se non 

disponete di scheda video integrata), schede AGP, PCI Express, schede PCI rimovibili, schede modem

; dispositivi SCSI (a meno che non si esegua l'installazione da o verso uno di questi); dispositivi IDE 

o SATA (a meno che non si stia installando da o verso uno di questi); joystick, cavi MIDI, cavi audio, 

e tutti gli altri dispositivi multimediali esterni. 
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3  Configurazione

 Cose da fare dopo l'installazione

Questa sezione descrive le istruzioni di configurazione per garantire che il vostro sistema lavori 
correttamente dopo una nuova installazione di MX Linux, e una breve guida per procedere con una propria 
personalizzazione, se lo si desidera. 

3.1  Periferiche 

3.1.1  Smartphone 

 Smartphone e MX-16 (samsung galaxy s5 e iphone 6s)

Android 
Condivisione di file con un dispositivo Android. 

• Molti telefoni che eseguono Android 4.xx includono capacità MTP, ed è possibile utilizzare la 
seguente procedura.

• Collegate il telefono e assicuratevi che l'opzione di archiviazione sia impostata su MTP.
• Aprite Thunar. Quando il riquadro in alto a sinistra (Dispositivi) mostra un icona con il  nome 

del telefono (o: Unità di massa-Storage), cliccate su di essa. Se non viene mostrata spegnete e 
riaccendete il telefono.

• Procedere a cercare la cartella o file che vi interessa. 
• Alcuni file possono essere visualizzati e gestiti con le applicazioni di MX Linux: cliccate sul 

Dispositivo nel riquadro di sinistra, quindi fai doppio clic sul lettore CD, se necessario.

• Musica: usare Clementine
• Immagini: usare Nomacs, che è il visualizzatore predefinito (File> Apri cartella) o installare 

Shotwell
• Con cellulari senza capacità di MTP si può accedere tramite un browser Web con l'installazione di una

app dal Play Store di Google, come ad esempio AirDroid o FTPDroid.

I file musicali possono essere visualizzati e gestiti tramite Clementine . Fate clic su “dispositivi” nella 
colonna a sinistra, quindi nella colonna a fianco comparirà un’icona che rappresenta il vostro telefono. Fate 
doppio clic sull’icona del telefono, se necessario. 
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Figura 3-1: Thunar collegato ad un telefono Android 

iPhone 
E’ stata sviluppata un’applicazione specifica per permettere l’accesso a questi dispositivi attraverso Thunar: 
MX Montaggio iDevice. E’ presente in MX Strumenti, vedi Sezione 3.2

3.1.2  Stampanti 

Figura 3-2: Schermata “Nuova stampante” in Impostazioni di stampa

Connessione Locale 
MX Linux offre due programmi utili per la configurazione e la gestione delle stampanti. 

• Mediante l’applicazione “Impostazioni di stampa”
• Fate clic su Start Menu> Sistema> Impostazioni di stampa 
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• Attendere la schermata “Nuova stampante” mentre l'applicazione esegue la ricerca di 
stampanti connesse via cavo e wireless.

• Verrà indicato il software consigliato per ogni stampante trovata.
• Seguire le istruzioni in linea per concludere l'installazione della stampante.
• GUIDA: manuale di RedHat.

• Mediante un Browser
• Cliccate su Start Menu> Sistema> Stampanti (CUPS) 

• Se la stampante non viene riconosciuta o non funziona correttamente, consultate il MX/antiX Wiki 
per cercare un aiuto. 

Figura 3-3: Schermata di amministrazione di CUPS per la gestione delle stampanti 

Connessione Remota
Su Linux MX, Samba consente la stampa attraverso la rete di stampanti condivise con altri computer 
(Windows, Mac, Linux) e dispositivi NAS (Network Attached Storage) che offrono servizi di Samba 
(paragrafo 3.5). Esistono altre possibilità, vedi manuale Red Hat.
Usare Impostazioni di stampa per impostare una stampante condivisa

• Fate clic su Start Menu> Sistema> Impostazioni di stampa 
• Selezionate Server> Nuova> Stampante 
• Selezionate Stampante di rete> stampante Windows via SAMBA 
• Nella finestra di dialogo inserite    smb://nomeserver/nomestampante 

oppure indirizzo-ip-del-server/nomestampante. Per esempio: BIGSERVER/usbprinter1 o 
192.168.0.100/printer2 

• Se avete difficoltà ad individuare i nomi dei server e delle stampanti, fate clic su Start> Sistema> 
Samba per i dettagli. 
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• Lasciate selezionata l'opzione “indica all'utente se è necessaria l'autenticazione”, quindi fate clic su 
Avanti 

• Lasciate selezionata l'opzione “Seleziona stampante dal database” e quindi fate clic su Avanti 
• Selezionate il driver e poi andate avanti 
• Descrivete la stampante, se necessario, e quindi cliccate su applica 
• Quando la stampante viene visualizzata nella finestra, fate clic su Proprietà> Stampa pagina di prova, 

per assicurarsi che il collegamento e il driver funzionino correttamente. 

Usare l'utility per stampanti (CUPS) 

• Cliccate su Start→ Sistema→ Stampanti (CUPS) - Gestire le stampanti mediante un browser 
• Selezionate “Adding Printers and Classes”> Add Printers
• Nella finestra di dialogo inserite la password utente. 
• In Add Printers> selezionate la scelta appropriata (ad esempio, Windows Printer via SAMBA) > poi 

cliccate Continua
• Nella finestra di connessione, inserite smb://nomeserver/nomestampante utilizzando lo stesso metodo 

visto prima in “Usare Impostazioni di Stampa” per trovare i nomi giusti> Continua 
• Inserite il nome della stampante e la descrizione che desiderate ... Non selezionate “Share This 

Printer” (Condividi la stampante) poi cliccate Continua 
• Selezionate il produttore della stampante> cliccate Continua> Aggiungi stampante> scegliere varie 

opzioni> impostare le opzioni predefinite
• Andate alla manutenzione > Stampa pagina di prova per assicurarsi il corretto funzionamento del 

collegamento e del driver

Risoluzione dei problemi 

• C'è un programma di utilità di risoluzione dei problemi, integrata nell'applicazione “Impostazioni di 
stampa”. Fate clic su Aiuto> Risoluzione dei problemi. 

• Per le stampanti HP, il pacchetto aggiuntivo hplip-gui installerà nell'area di notifica un utile applet 
che fornisce strumenti di risoluzione dei problemi. 

• Se la stampante smette improvvisamente di stampare, controllate che sia ancora attiva facendo clic su 
Start> Sistema> Impostazioni di stampa , quindi fare clic destro sull'icona della stampante per 
riattivarla. 

• Se la tua stampante non è rilevata, o non funziona correttamente, consulta il Wiki di   MX/antiX   per 
una guida dettagliata su come ottenere il driver corretto.

3.1.3  Scanner 

Gli scanner sono supportati in Linux da SANE (Scanner Access Now Easy), che è un'interfaccia di 
programmazione delle applicazioni (API) che fornisce un accesso standardizzato all'hardware di qualsiasi 
scanner (a superficie piana, scanner palmari, video e fotocamere, frame grabber, ecc.).
Operazioni di base 
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È possibile gestire lo scanner in MX Linux con l'applicazione di default gscan2pdf o Simple Scan. Il primo, 
è un buon programma di gestione dello scanner e permette di esportare direttamente in PDF oltre ad altri 
formati. 
Risoluzione dei problemi 

• Assicurarsi che lo scanner sia elencato come supportato da SANE su questa lista . 

• Se hai problemi, consulta il Wiki di   MX/antiX   per trovare soluzioni.

3.1.4  Webcam 

Nella maggior parte dei casi le webcam funzionano in MX Linux. ; puoi testarla lanciando Menu-Start > 
Multimedia > guvcview e usando il quadro delle impostazioni che si apre per adattarla al tuo sistema. Se 
non sembra voler funzionare, vi è una recente dettagliata discussione riguardante driver e configurazione in 
Arch Wiki. L'audio delle webcam è a volte più complicato, vedi Sezione 4.1 su Skype.

3.1.5  Unità di Memoria Dati (Storage)

Unità Disco (come SCSI, SATA e SSD), camere, penne-USB, telefoni, ecc. – Questi sono tutti differenti 
formati di unità di memoria dati (storage).

Montaggio

Di default, le periferiche di stoccaggio dati, che vengono inserite nel sistema, vengono automaticamente 
montate nella directory /media/<nomeutente>/, dopo di chè il file manager aprirà, sempre automaticamente, 
una finestra che ne mostrerà il contenuto (il comportamento può essere modificato in Thunar: Modifica> 
Preferenze). Potete avere una icona posta sul desktop per i dispositivi montati, anche se questa impostazione 
è stata disattivata per impostazione predefinita in MX Linux, cliccando col destro su uno spazio vuoto del 
desktop> Impostazioni della scrivania> scheda Icone, poi, nel campo delle icone predefinite, vidimate: 
dispositivi rimovibili.

Permessi

La facilità di accesso dell'utente alla memoria dati dipende dal tipo di filesystem che esso contiene. La 
maggior parte dei dispositivi di memoria dati esterni, in particolare hard disk, sarà pre-formattato come 
FAT32 o NTFS.

Filesystem dell’unità Permessi

fat32 Nessuno.

ntfs
Di default, i permessi/proprietà sono concessi all'utente che monta il 
dispositivo.

ext2, ext4, e maggior 
parte degli altri  
filesystems Linux 

Di default, il permesso del montaggio delle periferiche interne che 
dispongono di questo filesystem è impostato su Root. Per maggiori 
informazioni sui permessi/proprietà vedi la Sezione 7.3.

È possibile modificare i permessi/proprietà associati a root per accedere ai dispositivi di archiviazione interni 
con i filesystem di Linux utilizzando MX Rifiniture (MX Tweak), scheda Altri (Sezione 3.2).
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SSD

I nuovi computer possono disporre di una scheda interna SSD: un disco allo stato solido che non ha parti in 
movimento. Queste unità tendono ad accumulare blocchi di dati che, anche se cancellati, vengono mantenuti 
in memoria, ciò può rallentare queste unità teoricamente molto veloci. Per evitare che ciò accada, MX Linux 
esegue un'operazione TRIM con frequenza settimanale che può essere visualizzata aprendo il file 
/etc/cron.weekly/fstrim-mx. 

3.1.6 Bluetooth devices

Figura 3-4: finestra Dispositivi di Bluetooth Manager, che mostra i dispositivi rilevati.

Dispositivi bluetooth esterni come tastiere, speaker, mouse, ecc. normalmente funzionano automaticamente. 
Se così non fosse, segui questi passaggi: 

• Vai in Menu-Start> Impostazioni> Gestore Bluetooth (oppure clicca col destro sull'icona Bluetooth 
presente nell'area di notifica)

• Da Gestore Bluetooth vai alla scheda adattatore>Preferenze e poi seleziona “visibile 
temporaneamente” (o scegli la preferenza di visibilità che preferisci) e contemporaneamente 
assicurati che il dispositivo da accoppiare sia settato per essere visibile. Se il dispositivo da 
accoppiare lo permette avvia la ricerca dispositivi bluetooth da quel dispositivo. 

• Sul quadro di controllo del Gestore Bluetooth Se il dispositivo desiderato si trova nella finestra 
Dispositivi, selezionalo e fai clic su Configurazione.

• In caso contrario, clicca sul pulsante Cerca e poi una volta trovato il dispositivo desiderato, seleziona 
la riga dove viene identificato, e clicca il pulsante Associa con il dispositivo per avviare l'associazione
(o pairing).

• Per un telefono, è probabile che tu debba confermare il numero di accoppiamento sia sul dispositivo 
che sul desktop.

• Dopo che si è compiuto il pairing-bluetooth con il dispositivo, cliccare sul pulsante Configurazione, si
presenteranno una serie di finestre per settare le impostazioni volute. Infine verrà chiesto di 
confermare la configurazione da associare al dispositivo. 

• Quando il processo di impostazione è finito, il dispositivo dovrebbe funzionare. 

49

https://it.wikipedia.org/wiki/TRIM
https://it.wikipedia.org/wiki/Unit%C3%A0_a_stato_solido


• Una volta compiuta l’associazione e configurazione, per connettere il dispositivo le volte successive, 
sarà più agevole usare l’icona che compare nell’area di notifica del pannello.

Trasferimento dell'oggetto
Per poter trasferire file (documenti, foto, ecc.) tra un desktop MX Linux e un dispositivo, come un telefono, 
tramite bluetooth, procedere come segue:

• Installate obex-data-server dai repository.
◦ L’installazione del pacchetto porterà con sé come dipendenza libopenobex2.
◦ Attenzione in alcuni casi, rari, il pacchetto obex-data-server potrebbe interferire con il mouse o la 

tastiera se sono collegati tramite bluetooth.
• Date Conferma all’abilitazione bluetooth sia per il telefono che per il desktop e rendeteli visibili agli 

altri dispositivi bluethooth.
• Inviare file

◦ Dal desktop MX Linux: cliccate col destro sull'icona bluetooth nell'area di notifica> Invia file (o 
utilizzate Bluetooth Manager)

◦ Dal telefono: seguite le istruzioni appropriate per il vostro dispositivo.
• Tenete d'occhio il dispositivo ricevente per confermare l'accettazione dell'oggetto da trasferire.
• È anche possibile usare hcitool da riga di comando.

Links

• Blueman Troubleshooting  

• Arch Wiki  

• Debian Wiki on Pairing  

3.1.7 Tavolette Digitali con penna

Le tavole digitali con penna Wacom sono rilevate automaticamente e supportate nativamente in Debian. 
Dettagli nel MX/antiX Wiki.

Links 

• The Linux Wacom Project  
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3.2  MX Strumenti – Livello Base

Figura 3-5: Finestra principale di MX Strumenti (aperta su un sistema installato). 
Su un sistema Live ha alcune opzioni in più

Un certo numero di applicazioni sono state sviluppate appositamente per MX Linux, adattate o trasferite da 
antiX, o adattate da fonti esterne per facilitare l'utente nello svolgere compiti importanti che spesso 
comportano passaggi non intuitivi. (MX Snapshot e altri strumenti avanzati sono trattati nella Sezione 6.6)

3.2.1  MX Aggiornamenti – Mx Updater (sviluppo di MX Apt-notifier)
Questa applet che si mostra come una scatola tratteggiata in bianco, estremamente pratica e versatile, non è 
presente sulla finestra di apertura di MX Strumenti, si trova invece nell'area di notifica dove tiene monitorati 
gli aggiornamenti dei pacchetti avvisandovi quando sono disponibili attraverso la colorazione in verde della 
scatola/icona. 
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E' molto più veloce che passare attraverso Synaptic (paragrafo 5.3). Assicuratevi di controllare le importanti 
opzioni disponibili attraverso il menu contestuale (tasto destro del mouse). 

Figura 3-6: Schermata “Mostra e Aggiorna” di MX Aggiornamenti 

Si noti la possibilità di scegliere tra un aggiornamento base (upgrade) e un aggiornamento completo (dist-
upgrade).

• Aggiornamento completo (dist-upgrade): l'azione predefinita e raccomandata per i nuovi arrivati. 
Aggiornerà tutti i pacchetti con aggiornamenti, anche quelli in cui un aggiornamento comporterà la 
rimozione automatica di altri pacchetti esistenti o farà sì che nuovi pacchetti vengano aggiunti 
all'installazione in modo che tutte le dipendenze siano risolte.

• Aggiornamento base (upgrade): consigliato solo agli utenti più esperti. Aggiornerà solo pacchetti 
aggiornabili che non comportano la rimozione o l'installazione di altri pacchetti. L'utilizzo di questa 
opzione indica che alcuni pacchetti aggiornabili possono rimanere "trattenuti" sul sistema.

• Un'opzione per l'aggiornamento automatico è disponibile in Preferenze. Funziona in background e 
non aggiunge nuovi pacchetti ne rimuove quelli esistenti.

AIUTO: qui. 

3.2.2 Configurazione Bash

Il Bash, (il tipo di linguaggio della shell predefinito in MX Linux) può essere configurato con questa piccola 
applicazione. Permette all'utente di personalizzare i temi e gli alias del terminale attraverso modifiche al file 
bashrc, un file nascosto nella home dell'utente.
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Figura 3-7: scheda per aggiungere o modificare un alias 

Aiuto: qui.

3.2.3 Opzioni di Boot

Figure 3-8: Schermata principale con le varie opzioni da scegliere

Le opzioni di Boot includono parametri del kernel, temi di GRUB, immagini per Splash e altri elementi. 
Questa applicazione rende semplice, veloce e facile agli utenti gestire queste scelte.

AIUTO: qui.
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3.2.4  Ripara Boot (Boot Repair)

Il bootloader è il primo software che si avvia ed è responsabile di avviare il kernel e di trasferirgli il 
controllo. A volte capita che il bootloader (GRUB2) su un'installazione diventi disfunzionale, di solito perché
l'utente ha apportato modifiche di qualche tipo. Questo strumento consente di ripristinare e riparare il 
bootloader, mediante l’uso di un CD/DVD Live (o una Unità-USB Live).

 
Figura 3-9: Schermata principale di Ripara Boot con l’opzione più comunemente selezionata 
AIUTO: qui. 

3.2.5  Cerca chiavi GPG (Fix GPG Keys)

I sistemi di installazione dei pacchetti software prevedono che questi siano autenticati al fine di aumentarne 
la sicurezza. È comunque possibile installare pacchetti non autenticati, ma vi imbatterete in un messaggio di 
errore: “Le seguenti firme non sono state verificate perché la chiave pubblica non è disponibile”. Questa 
utility consente di risparmiarvi i vari passaggi necessari ad ottenere la chiave. 

 
Figura 3-10: Risultati della ricerca delle chiavi pubbliche dei repository con Fix GPG Keys

AIUTO: qui. 
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3.2.6  Installa Codecs (Codec Downloader)

Un codecs è una parte di software che consente la codifica/decodifica di un flusso di dati digitali o di un 

segnale. In MX Linux la maggior parte dei codec vengono installati assieme alle applicazioni multimediali 

presenti, come ad esempio VLC, ma alcuni presentano delle restrizioni legali per cui devono essere installati 

dall'utente. 

Verranno installati Libdvdcss2 (per la lettura di dvd commerciali) e libtxc-dxtn0 (per alcune texture di giochi 

in 3D)

Questo strumento consente una facile installazione di questi codec con restrizioni e contemporaneamente ne 

trasferiscono la responsabilità all'utente. 

 
Figura 3-11: Schermata principale di Installa Codecs 
AIUTO: qui. 

3.2.7  Conky

L’app. chiamata MX Conky in associazione a Conky Manager rende facile personalizzare i dettagli, 

specialmente il colore, di un monitor di sistema del desktop (conky), tra la vasta scelta di conky forniti dalla 

distribuzione .
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Figura 3-12: MX Conky pronto a modificare i dettagli di un conky predefinito 

AIUTO: qui.

3.2.8  Monta iDevice (iDevice Mounter)

Questa applicazione permette di vedere in Thunar i contenuti di un iPhone o iPad, che altrimenti risulta 

spesso difficile.

Figura 3-13: Monta iDevice pronto per il montaggio di un iPhone 6

AIUTO: qui. 
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3.2.9  Crea Live Usb (Live-Usb Maker)

Questo strumento permette di creare rapidamente e facilmente una Usb-Live a partire da un file ISO, un 
Cd/Dvd-Live o una Usb-Live esistente, o persino da un sistema Live in esecuzione.

Figura 3-14: Crea Live Usb (Live USB Maker)

AIUTO: qui. 

3.2.10  Menu Editor

 Menu Editor
Questo semplice editor di menu rende facile modificare, aggiungere o eliminare le voci di menu. Le eventuali
modifiche vengono salvate nella directory dell'utente /.local/shared/applications/, che ha la precedenza sulla
directory /usr/share/applications/ che è la cartella che viene interessata quando il menu Xfce viene 
impostato durante l'avvio. 

Figura 3-15: Menu Editor con la categoria Multimedia espansa 
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Nota: MX Menu Editor è anche accessibile dal menu contestuale a discesa evidenziabile cliccando col tasto 

destro sull'icona del menù whisker (o menu start) nell'angolo in basso a sinistra. 

AIUTO: qui.

3.2.11  Network Assistant

Questa applicazione aiuta a risolvere eventuali problemi di rete rilevando l'hardware, consentendo la gestione

di driver Linux e Windows e fornendo alcuni strumenti di diagnostica di rete. 

Figura 3-16: Network Assistant rilevamento hardware wireless e cablato

AIUTO: qui.

3.2.12  Installa driver Nvidia (Nvidia driver installer)

Questo installer di driver grafici semplifica decisamente un importante procedura: l'installazione di un driver 

grafico proprietario. Il programma per funzionare si appoggia allo script ddm-mx. Cliccando sull'icona 

dell’installer viene portato in primo piano un terminale, e nella maggior parte dei casi tutto quello che l'utente

deve fare è accettare l'impostazione predefinita.
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Figura 3-17: MX Installa driver Nvidia non ritiene necessario continuare

AIUTO: qui  .  

3.2.13  Installa Programmi (Package Installer)

 Installa   Programmi  
Con questa applicazione è possibile installare (o rimuovere), in maniera semplice, alcuni gruppi di pacchetti 
di software comune. Questa capacità è particolarmente utile per programmi la cui installazione non è 
intuitiva o che richiede più pacchetti. E 'anche molto utile per l'installazione dei pacchetti della propria 
lingua, che può essere noioso e lungo selezionare ed installare con altri metodi. Inoltre permette all'utente di 
cercare e installare pacchetti dai repository di Debian Backports e di MX Test senza la necessità di abilitare 
prima questi repository e senza avere a che fare con il complesso sistema di dipendenze dei pacchetti. 

Figura 3-18: Installa Programmi, che mostra i pacchetti popolari della categoria Development (sviluppo)

AIUTO: qui.
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3.2.14  Repo Manager

Sebbene il repository più appropriato per un utente viene selezionato automaticamente durante l'installazione,
vi sono molte ragioni per cui l'utente potrebbe desiderare di cambiare tale scelta successivamente: da un 
server che smette di funzionare ad uno spostamento fisico del computer in una regione diversa. Questo 
strumento fornisce il cambio dei repository con un click del mouse. 
Fornisce anche un pulsante che testerà tutti i repository (MX o Debian) e selezionerà il più veloce.

 
Figura 3-19: Scelta di un repository da usare 
AIUTO: qui.

3.2.15  Schede Audio (Sound Card)

I computer hanno spesso più di una scheda audio a disposizione. Se il sistema non identifica la scheda audio 

corretta, l'utente non sentirà nulla e ne dedurrà che il suono non funziona. Questa piccola intelligente 

applicazione permette all'utente di selezionare quale scheda audio debba essere utilizzata dal sistema. 

 
Figura 3-20: Selezione della scheda audio 

AIUTO: qui.
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3.2.16 Tastiera di Sistema (System Keyboard)

Figura 3-21: Schermata principale di “Tastiera di Sistema”, pronto a selezionare una tastiera differente

Nel caso in cui l'utente avesse trascurato di selezionare la tastiera di sistema nel menu del Login, e non 
l’avesse configurata nemmeno nella sessione Live, oppure semplicemente avesse bisogno di modificarla, 
ecco che questa piccola applicazione fornisce un modo semplice per eseguire quest'operazione. La trovi in 
Tutte le Impostazioni. Per una completa regolazione avete questi strumenti: Tastiera e Tastiera di Sistema. 
Inoltre per le tastiere sullo schermo avete Impostazioni di Onboard.

AIUTO: qui. 

3.2.17 Localizzazione del Sistema

Figura 3-22: Presentazione delle possibilità di localizzazione che possono essere generate.
Nel caso in cui l'utente avesse trascurato di selezionare la localizzazione nel menu del Login, e non l’avesse 

configurata nemmeno nella sessione Live, oppure semplicemente avesse bisogno di modificarla, ecco che 

questa piccola applicazione fornisce un modo semplice per eseguire quest'operazione. La trovi all’interno del 

quadro di MX Strumenti (MX Tools) 

AIUTO: qui. 
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3.2.18 Suoni di Sistema (System Sounds)

Questo piccolo tool raccoglie insieme le scelte attinenti la riproduzione di suoni di sistema come nel caso del 

login/logout, di azioni particolari del sistema, ecc.

Figura 3-23: Impostazione dei suoni di login e logout in Suoni di Sistema

AIUTO: qui  .  

3.2.19 Ora & Data 

MX Ora & Data è un nuovo strumento sviluppato per MX-19. Richiede la password di root e consente, con 
una sola applicazione, di effettuare regolazioni di ogni tipo. 

Figura 3-24: La scheda principale di Ora & Data (in esecuzione come root) 

Aiuto: qui.
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3.2.20  Rifiniture (Tweak)

MX Rifiniture riunisce una serie di personalizzazioni semplici e piccole ma utilizzate spesso come la 

gestione del pannello, la selezione del tema, l’abilitazione e configurazione del compositore, ecc.

Figura 3-25: MX Tweak pronto a spostare il pannello in posizione orizzontale

AIUTO: qui.

3.2.21 Formatta USB

Figura 3-27: Formatta USB pronto a riformattare con fat32

Questo piccolo ma comodo strumento pulisce e riformatta un'unità USB per renderla disponibile a nuovi 
utilizzi.

AIUTO: qui.
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3.2.22  Smonta USB (USB Unmounter)

Strumento che serve a smontare rapidamente periferiche USB e supporti ottici. Lo troverete nell'area di 

notifica se attivato (lo è di default). Un singolo click mostra le unità da smontare, che verranno smontate con 

un doppio clic.

Figura 3-28: USB Unmounter (MX Smonta USB) con un dispositivo evidenziato pronto per lo 
smontaggio.

AIUTO: qui  .  

3.2.23  Manager Utenti (User Manager)

Questa applicazione aiuta ad aggiungere, modificare o rimuovere utenti e gruppi nel tuo sistema. 

 
Figura 3-29: Manager Utenti, scheda Amministrazione

AIUTO: qui.
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3.2.24 Strumenti obsoleti

Alcuni utenti avranno notato che certi strumenti, presenti nelle release precedenti, non esistono più o sono 

stati incorporati in nuovi strumenti.

• Installa driver ATI/AMD: rimosso per mancanza di un driver idoneo da caricare

• Broadcom Manager: riscritto come Network Assistant con caratteristiche più generali.

• Compton Manager: incorporato in MX Rifiniture.

• Installa da Debian Backports: incorporato in Installa Programmi.

• Aspetto di Default: incorporato in MX Rifiniture.

• Trova Risorse Condivise: rimosso a causa di problemi di licenza.

• Flash Manager: rimosso perché Adobe® Flash® Player è ora installato di default su licenza.

• Orientamento Pannello: incorporato in MX Rifiniture.

• Installa dal Repo Test: incorporato in Installa Programmi.

3.3  Video

3.3.1  Risoluzione 

La risoluzione si riferisce al numero fisico di colonne e righe di pixel che creano il display dello schermo (ad 
esempio, 1920x1200). Nella maggior parte dei casi, la risoluzione è impostata correttamente dal kernel 
durante l'installazione o quando viene collegato un nuovo monitor. In caso contrario, si può cambiare nei 
seguenti modi: 

• Fare clic su Menu-Start> Impostazioni> Schermo . Utilizzare i menu a discesa per impostare i 
valori corretti per il monitor che si desidera regolare. Per ulteriori opzioni e un controllo più preciso, 
installare xrandr dai repo.

• Per le schede Nvidia, è possibile installare il pacchetto nvidia-settings che vi darà uno strumento 
grafico che permetterà di modificare le impostazioni come root, con il comando: nvidia-settings 

• In situazioni difficili, è possibile modificare manualmente il file di configurazione /etc/X11/xorg.conf.
Se non fosse già presente sarà necessario crearlo appositamente. Ricordatevi di fare sempre il backup 
del file prima di modificarlo, e controllare il Forum per trovare indicazioni su come intervenire su 
quel file. 

3.3.2  Drivers grafici 

Se non siete soddisfatti delle prestazioni del vostro schermo, potrebbe essere necessario aggiornare/sostituire 
il driver grafico (assicuratevi di fare prima il backup del file /etc/X11/xorg.conf). Ricordatevi che dopo un 
aggiornamento del kernel potrebbe essere necessario ripetere l'operazione di sostituzione del driver, vedere 
Sezione 7.6.3.

Ci sono vari metodi per farlo.
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• Per la maggior parte delle schede Nvidia, il metodo di gran lunga più semplice è quello di utilizzare le
utility di installazione di questi drivers accessibili dal quadro principale di MX Tools (MX Strumenti) 
(vedere Sezione 3.2).

Alcune schede video meno recenti o meno comuni (ad esempio openchrome, Mach64 e fbdev) 
richiedono drivers che sono facilmente installabili con sgfxi (sezione 6.5.3).

Alcune schede Nvidia non sono più supportate in Debian Stable ("Buster"), vedere MX/antiX 
Wiki, sono comunque sostenute dai driver N  ouveau   e Vesa.

• Consultate il Wiki   Debian   sui driver open-source ati, radeon, e amdgpu. Tenete presente che i driver 
open per AMD non sono più disponibili.

• E 'anche possibile, ma più complicato, scaricare il driver direttamente dal produttore. Questo metodo 
richiede di selezionare e scaricare il driver corretto per il vostro sistema; per reperire informazioni sul 
sistema, aprite un terminale e digitate: inxi -Gxx

Qui ci sono i siti web dei driver per i due marchi più popolari (per gli altri marchi fate una ricerca nel web 
con "<nome-marchio> driver Linux "): 

• Nvidia   
• Intel   

I driver Intel devono essere prima compilati, mentre i driver NVIDIA, una volta scaricati, sono installabili in 
maniera molto semplice: 

• Navigate con Thunar fino alla cartella in cui è stato scaricato il driver, cliccate col destro sul file, 
selezionare la scheda Proprietà-> Permessi e controllate che sia eseguibile 

• Premete i tasti CTRL-ALT-F1 per uscire da X (l'ambiente grafico) vi troverete in una schermata con il
prompt del terminale

• Fate il Login come root
• Digitate: service lightdm stop
• Digitate: sh nomefile.run  (assicuratevi di usare il giusto nome del file)
• Date il permesso al driver NVIDIA di spegnere il kernel nouveau
• Quando il processo è finito, digitate: service lightdm start per avviare lightdm e xorg.

• Un'altra importante possibilità è l'uso del driver Mesa, un'implementazione open source delle 
specifiche OpenGL - un sistema per il rendering della grafica 3D. Gli utenti di macchine ad alte 
prestazioni riferiscono che l'ultimo aggiornamento di questo driver porta una stabilizzazione 
significativa al loro sistema. 

• Una versione più recente può essere disponibile nel repository test; utilizzate MX Installa Programmi 
(Sezione 3.2.17) per ottenerlo.
Scegliete la scheda Repo MX Test, deselezionate la casellina in basso con dicitura “Nascondi i 
pacchetti delle librerie e di sviluppo”, cercate "mesa" e spuntate i pacchetti aggiornabili in modo da 
installarli.

• Le schede grafiche ibride combinano due adattatori grafici sulla stessa unità. Un esempio classico è 
NVidia Optimus, che è supportato su Linux da Bumblee
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3.3.2  Font 

Impostazioni base 

1. Cliccate su Start-Menu> Tutte le Impostazioni > Aspetto , scheda Caratteri 
2. Cliccate sul menu a discesa per visualizzare l'elenco dei tipi di carattere e dimensioni
3. Selezionate quello che desiderate, e cliccate OK 

Impostazioni avanzate 

1. Se ne possono trovare alcuni in MX Installa Programmi disponibili con un solo clic. Per maggiori 
possibilità di configurazione, un certo numero di impostazioni sono disponibili eseguendo in un 
terminale con i privilegi di root: dpkg-reconfigure fontconfig-config

2. Firefox: cliccate su Modifica> Preferenze> Contenuti e apportate le modifiche desiderate. 

3. Per ulteriori opzioni, andate a vedere il Wiki   MX/antiX.   

4. Gli schermi ad alta risoluzione hanno esigenze particolari, vedi il Wiki   MX/antiX  .

Aggiunta di font 

1. Fate clic su Start-Menu> Sistema> Gestore pacchetti (Synaptic) . 
2. Utilizzate la funzione di ricerca, cercando font. 
3. Selezionate e scaricare quelli che desiderate. Il pacchetto dei principali font di Microsoft è ttf-

mscorefonts-installer (installato di default) il quale consente una facile installazione dei font “True 
Type” di Microsoft che verranno usati in siti web e applicazioni MS che girano sotto Wine. 

4. Estrarre se necessario, quindi copiare come root (più facile avviando Thunar da un terminale con i 
privilegi di root) la cartella dei font in /usr/share/fonts/ . 

5. I nuovi font dovrebbero essere disponibili nel menu a tendina in Tutte le Impostazioni> Aspetto> 
scheda Caratteri. 

3.3.4  Doppio monitor 

Monitor multipli sono gestiti in MX Linux con Menu-Start> Tutte le Impostazioni> Schermo. 
Si può regolare la risoluzione, scegliere se uno cloni l'altro, quale dei due sarà attivo, ecc. E' spesso 
necessario fare il log out e poi rientrare per vedere attivato lo schermo selezionato. Un controllo più preciso 
di alcune funzioni è eventualmente disponibile con lxrandr (o con xrandr, strumento a riga di comando). 
Xfce 4.14 ha migliorato notevolmente la gestione dei monitor multipli, attraverso: Tutte le Impostazioni> 
Schermo> scheda Avanzate che permettono di impostare in dettaglio ogni monitor, salvare i profili dei 
monitor per utilizzarli automaticamente quando lo stesso hardware verrà nuovamente collegato. Se i 
problemi persistono cercate nel Wiki MX/antiX e per problemi particolari chiedete aiuto nel nel Forum di 
MX/antiX e nel Forum   di   Xfce  .
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Figura 3-30: Selezione dei valori di Display in Tutte le Impostazioni > Schermo

INFO: Documenti Xfce: Display

3.3.5  Gestione alimentazione 

Cliccare nel pannello sull'icona “Gestore di Energia”. Da qui potrai facilmente mettere il visto in “modalità 
presentazione”, o andare in “Impostazioni del gestore dell'energia” per impostare quando un display si dovrà 
spegnere, quando entrerà in sospensione, che azione verrà avviata chiudendo il display/coperchio superiore di
un computer portatile, la luminosità, ecc. Se possiedi un portatile, su questa icona sarà subito visibile lo stato 
della batteria e della luminosità. 
Fate attenzione se pensate di modificare le impostazioni predefinite; sono state ampiamente testate durante lo
sviluppo per trovare la configurazione più stabile.

3.3.6  Regolazione del Monitor 

Sono disponibili diversi strumenti per la regolazione dei valori dello schermo per determinati monitor.
• La luminosità dello schermo può essere impostata da menu-Start> Tutte le Impostazioni> Gestore di 

energia, scheda Schermo.
• Per gli utenti con schede Nvidia, utilizzare con la password di root le impostazioni di nvidia per la 

regolazione fine dello schermo. Dovrete installare dai repository il pacchetto nvidia-settings
• Per cambiare la gamma (contrasto), aprire un terminale e inserite:

xgamma -gamma 1.0

1.0 è il livello normale; cambiatelo in su o in giù per diminuire/aumentare il contrasto.
• Il colore dell'adattamento del display all'ora del giorno può essere controllato con fluxgui o Redshift
• Per una regolazione più avanzata e la creazione di profili, installate DisplayCAL.
• Nuovo in Xfce 4.14 is Start > Impostazioni > Profili Colore. Un profilo colore è un insieme di dati 

che caratterizza un dispositivo di input o output per i colori e la maggior parte di essi deriva dai profili
ICC.
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Figura 3-31: Pronti per aggiungere un profilo colore

AIUTO: qui

3.3.7 Screen tearing - Strappo dello schermo

Lo strappo dello schermo è un artefatto visivo che si genera quando un singolo fotogramma visualizzato sullo

schermo contiene informazioni provenienti da due o più fotogrammi. Esso varia notevolmente a seconda di 

fattori che includono hardware grafico, applicazioni particolari e sensibilità dell'utente.

In MX Linux, sono disponibili diverse soluzioni:

• Cliccare sulla scheda Compositore in MX Rifiniture, e utilizzare il menu a discesa per passare da 

xfwm, impostato di default, a Compton, un compositore indipendente. 

• Utilizzare il menu a discesa per modificare la spaziatura verticale (vblank).

• Quando viene rilevato un driver grafico Intel, una casella di controllo diventa disponibile nella scheda

MX Rifiniture > Config Opzioni che allontana il sistema dal "modesetting" predefinito, una sorta di 

interruttore che abilita l'opzione TearFree del driver Intel. Gli sviluppatori di MX attualmente stanno 

lavorando per includere questa opzione anche su altri driver come radeon.

Link
• MX/antiX Wiki.  
• Arch Wiki: Compton  

3.3.8 Screensaver

Con Xfce 4.14 è disponibile un nuovo salvaschermo con blocco-schermo cliccando su Start Menu →Tutte le 
impostazioni→ Screensaver. Due schede consentono all'utente di accedere a opzioni e preferenze.
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Figura 3-32: Lo screensaver è impostato per funzionare dopo dieci minuti di inattività

AIUTO: qui.

3.4  Network 
Le connessioni internet sono gestite da Network Manager; clicca sulla relativa iconcina-applet presente 
nell'area di notifica del pannello per vedere lo stato, la connessione, le reti disponibili ed esplorare le varie 
opzioni. 
Cliccate col destro sull'applet Network Manager →”Modifica connessioni” e da qui andando su “Modifica” o
“Aggiungi” si aprirà una finestra di impostazioni con diverse tipologie di connessione. 

• Ethernet. Nella maggior parte dei casi questo tipo di connessione non richiede alcun intervento; 
eventualmente per configurazioni speciali, cliccate col destro, andate in Modifica Connessioni, 
evidenziate il nome della connessione Wired e cliccate sul pulsante Modifica. 

• Wi Fi
• Network Manager di solito rileverà automaticamente la scheda di rete del computer ed inoltre 

è in grado di rilevare le reti e i punti di accesso disponibili. 
In alcune situazioni, nel caso di problemi a rilevare la scheda di rete, può essere utile lo 
strumento, da riga di comando, Ceni installabile dai Repository. 

• Per i dettagli, vedere la sezione 3.4.2 di seguito. 
• Banda larga mobile. Questa scheda consente di utilizzare un dispositivo mobile 3G/4G per l'accesso 

al web. Fate clic sul pulsante Aggiungi (+Add, in figura) per impostare. 
• VPN. Fate clic sul pulsante “Aggiungi” per impostare. Se riscontrate problemi durante l'impostazione,

consultate il Wiki   MX/antiX  .  
• DSL. Fate clic sul pulsante Aggiungi per impostare. 
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:  
Figura 3-33: Schermata principale di Network Manager 
Ulteriori info: wiki di Ubuntu: Network Manager

3.4.1  Connessione cablata (wired)

MX Linux in genere rileva le connessioni internet via cavo al boot senza problemi. Se dovesse essere 
necessario un particolare driver Broadcom (evenienza rara), utilizzate MX Network Assistant (Sez. 3.2)
Ethernet e cavo 
MX Linux viene fornito già preconfigurato per uno standard LAN (Local Area Network) che utilizza il 
protocollo DHCP (Dynamic Host Configuration Protocol) per assegnare gli indirizzi IP e DNS (Domain 
Name System) per la risoluzione dei domini. Questo funzionerà nella maggior parte dei casi così com'è. In 
ogni caso potete modificarne la configurazione attraverso Network Manager. 
Quando si avvia MX Linux, agli adattatori di rete viene assegnato un breve nome di interfaccia da udev, il 
gestore del kernel dei dispositivi. Per i normali adattatori cablati questo è di solito eth0 (gli adattatori 
successivi saranno eth1, eth2, eth3, ecc). In MX Linux gli adattatori USB vengono spesso identificati come 
interfaccia eth0, ma il nome dell'interfaccia può anche dipendere dal chipset della scheda. Ad esempio, le 
schede Atheros in genere vengono identificate come ath0, mentre gli adattatori Ralink USB potrebbero venire
identificati come rausb0. Per un elenco dettagliato di tutte le interfacce di rete disponibili, aprite un terminale,
diventate root e digitate: 
ifconfig -a

E' una buona cosa connettersi ad internet attraverso un router, dato che quasi tutti i router cablati dispongono,
se si vuole, di firewall. Inoltre, i router utilizzano NAT (Network Address Translation) per tradurre i grandi 
indirizzi internet in indirizzi IP locali. Questo offre un ulteriore livello di protezione. Collegatevi direttamente
al router, o tramite un hub o uno switch, e il computer  dovrebbe autoconfigurarsi tramite DHCP. 

ADSL o PPPoE 
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Utilizzando ADSL o PPPoE, la connessione a internet è facile con MX Linux. Pulsante destro del mouse 
sull'icona di Network Manager, quindi andate sulla scheda DSL. Fate clic sul pulsante Aggiungi  e inserite le 
informazioni richieste. Se volete potete vidimare la casella “connessione automatica alla rete se disponibile”. 
NOTA: se si verificano problemi quando si utilizza un dispositivo USB per connettersi, collegate l'unità al 
computer, aprite un terminale e digitate: 
dmesg | tail

Posta un messaggio sul forum con l'output del terminale per avere aiuto nel trovare il driver necessario. 

 
Figura 3-34: Configurazione del servizio DSL 
Dial-up 
Nella scheda del dispositivo è necessario impostare le informazioni seriali. Accettare il valore di default 
/dev/modem può funzionare, ma potrebbe essere necessario provare un'altra interfaccia. Questi sono gli 
equivalenti Linux delle porte COM in MS-DOS e MS Windows: 

Tabella 3: Porte equivalenti Linux alle porte COM Windows

Porta Equivalente 

COM 1 /dev/ttyS0 

COM 2 /dev/ttyS1 

COM 3 /dev/ttyS2 

COM 4 /dev/ttyS3 

3.4.2  Connessione wireless 

MX Linux è preconfigurato per rilevare automaticamente una scheda Wi-Fi, e nella maggior parte dei casi la 
scheda verrà trovata e impostata automaticamente. Ci sono due modi standard in cui una scheda wireless può 
essere supportata in MX Linux: 
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• Con un driver nativo che si presenta come parte del kernel di Linux (ad esempio: ipw3945 per Intel). 
• Con un driver di Windows, utilizzando l'applicazione Ndiswrapper (disponibile nei repository), che 

"ingloba" il driver Windows in modo che possa essere utilizzato in un sistema Linux (ad esempio: 
bcmwl5 per alcuni chipset Broadcom). Vedi sotto per info. 

A volte è disponibile sia un driver nativo Linux che un driver per Windows. Si consiglia di confrontarli per 
valutare la velocità e la connettività, e potrebbe essere necessario rimuovere (o mettere in blacklist) quello 
che non si utilizza per evitare un conflitto. Schede wireless possono essere sia interne che esterne. 
I modem USB (dongle wireless) di solito appaiono con l'interfaccia wlan, ma se così non fosse allora 
controlla le altre della lista. 
NOTA : Quale metodo avrà successo varia da utente a utente a causa delle complesse interazioni tra il kernel 
Linux, gli strumenti wireless e il chipset delle scheda wireless e del router che si possiede. 

Passi base per connettersi via wireless

Cliccate su Start-Menu> Impostazioni> Connessioni di rete (o semplicemente cliccate sull'icona Network 
Manager nell'area di notifica), e poi andate a vedere Wi-Fi. Si presenterà una di queste 3 situazioni. 

- La rete wireless viene rilevata .
• Fate clic sul campo con il nome della rete. 
• Fate clic su Modifica nel pulsante di destra, e inserite le informazioni. 
• Al termine, fate clic su OK. 

- La rete trovata non funziona
Se le reti presenti nella zona vengono viste ma non ci si riesce a connettere vuol dire che:

a) la scheda wireless viene gestita correttamente dal modulo contenente il suo driver adatto ma
potreste avere problemi che riguardano la connessione con il modem/router, problemi di 
firewall, problemi con il provider, problemi di DNS, ecc.
b) la scheda wireless viene gestita in maniera anomala, perché il driver non è il più adatto a 
quella scheda o per problemi di conflitto con un altro driver.

In questo caso conviene raccogliere informazioni sulla vostra scheda wireless per capire se i driver 
che la gestiscono possono avere dei problemi e successivamente provare a testare la rete con una serie
di strumenti di diagnostica.

• Trovate le informazioni base aprendo un terminale e inserendo uno alla volta:
inxi -n
lsusb | grep -i net
lspci | grep -i net

Diventate root, sempre nel terminale che avete aperto, e digitate:
iwconfig

L'output dei primi tre comandi vi darà il nome, il modello e la versione (se presente) della 
vostra scheda wireless (esempio qui sotto), così come il driver associato e l'indirizzo MAC 
della scheda wireless; con il quarto comando, otteniamo il nome e il MAC del punto di 
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accesso (AP) al quale ti sei collegato e altre informazioni di connessione. Esempio di output 
del comando inxi -n:
Network 
Card-2: Qualcomm Atheros AR9462 Wireless Network Adapter  
driver: ath9k
IF: wlan0 state: up mac: 00:21:6a:81:8c:5a

A volte è necessario il numero MAC del chipset in aggiunta a quello della vostra scheda 
wireless. Il modo più semplice per farlo è quello di fare clic sul menu Start> Sistema> MX 
Network Assistant, scheda Stato. Esempio:
Qualcomm Atheros AR9462 Wireless Network Adapter [168c:0034] (rev1)

Il primo dei due numeri, tra le parentesi quadre, identifica il produttore, il secondo identifica il 
prodotto. In questo caso 168c (o meglio 0x168c) identifica il produttore Atheros, mentre con: 
0x168c 0x0034 viene identificato con precisione il prodotto, permettendo in alcuni siti 
specifici di risalire all'id. del chipset e quindi del driver adatto.

• Utilizzare le informazioni che avete ottenuto in uno dei seguenti modi:
• Fate una ricerca sul Web utilizzando tali informazioni. 

Ecco alcuni esempi che utilizzano l'output dei comandi visti sopra:
1) linux Qualcomm Atheros AR9462
2) linux 0x168c 0x0034
3) debian stable 0x168c 0x0034

• Consultate i siti Linux Wireless, e Linux Wireless LAN Support linkati sotto, per 
scoprire di quale driver il proprio chipset ha bisogno, che conflitti potrebbero 
presentarsi, e se c'è bisogno di installare separatamente un determinato firmware. 
Pubblicate le informazioni sul Forum e chiedete aiuto.

• Provate a testare il vostro router e la vostra rete. Disattivate il firewall, se presente, finché non 
avviene il riconoscimento tra computer e router. Riavviate il router. Provate a connettervi con 
un router diverso da quello con cui avete difficoltà, ad esempio connettetevi ad uno 
smartphone usando la sua funzione hotspot wifi.
Un modo meno empirico è quello di utilizzare la Sezione Diagnostica di MX Network 
Assistant con il quale si può fare l'operazione di ping verso l'indirizzo ip del vostro router che 
potrete reperire nel suo manuale d'uso. Poi si può fare il ping verso un sito qualsiasi ad 
esempio quello di Google e fare l'operazione di traceroute. Se riuscite a raggiungere con il 
ping un sito usando il suo IP (alcuni li trovate con una ricerca web, ad esempio ip di 
www.google.it è 64.233.167.99), ma non ce la fate con il suo nome di dominio, allora il 
problema potrebbe nascondersi nella configurazione del DNS. Se non sapete come usare la 
scheda di diagnostica di MX Network Assistant leggete il wiki. Se non sapete interpretare i 
risultati di ping e traceroute fate una ricerca in rete o postate i risultati nel forum. Mx Network 
Assistant potrebbe servire anche per sostituire un driver nativo per Linux con il suo omologo 
di Windows grazie a Ndiswrapper, o a mettere in blacklist un driver che interferisce con quello
che gestisce la vostra scheda. Riguardo Ndiswrapper potete vedere maggiori dettagli più sotto.

• A volte utilizzando l'applicazione da terminale Ceni (disponibile nei repository) si possono 
rivelare access point nascosti e altri elementi problematici. 
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NOTA: utilizzando Ceni in MX Linux per configurare l'interfaccia di rete, questo interferirà 
e/o disattiverà la gestione di tale interfaccia da parte di Network Manager come impostazione
predefinita. Ceni salva le sue informazioni di configurazione in /etc/network/interfaces. 
Qualsiasi interfaccia definita e salvata in /etc/network/interfaces sarà ignorata da Network 
Manager, dato che Network Manager presuppone che se esiste un’interfaccia definita e 
salvata in quella posizione, vuol dire che si vuole che sia un'altra applicazione a gestire quel 
dispositivo. Quindi Ceni potrebbe funzionare bene per connettersi ma va detto che si presenta 
con un’interfaccia semi-grafica piuttosto spartana. Se in seguito si volesse utilizzare Network 
Manager, con cui interferisce, potrebbero esserci problemi.

• Pubblicate le vostre informazioni sul Forum per chiedere aiuto

- Nessuna interfaccia wireless viene trovata.
• Aprire un terminale e digitate i 4 comandi visti al punto precedente. Identificate la scheda, il 

chipset e il driver che vi serve facendo una ricerca web e consultando i siti segnalati, secondo 
la procedura descritta al punto precedente.

• Se disponete di un dispositivo WiFi esterno e nessuna informazione su quale scheda di rete 
possieda, scollegate il dispositivo, aspettate qualche secondo e poi ricollegatelo. Aprite un 
terminale e digitate:
dmesg | tail

Esaminate l'output per le informazioni sul dispositivo (come ad esempio l'indirizzo MAC) che 
potranno essere utilizzate per risolvere il problema sul web o sul forum. 

• Probabilmente l'esempio più frequente in cui si presenta questo tipo di situazione è con i 
chipset wireless Broadcom ; vedi Wiki MX/antiX. 

Firmware 
Per alcune schede è necessario installare il relativo firmware (ad esempio, firmware-ti-connectivity per 
Texas Instruments WL1251). MX Linux dispone di un buon numero di firmware, già installati o presenti nei 
repo, ma potrebbe essere necessario rintracciarne qualcuno non presente per una particolare esigenza. In 
questo caso, potete cercarlo sempre grazie al sito LinuxWireless (vedi link sottostante) oppure ricerca o 
richiesta d’aiuto nel forum

Ndiswrapper 
Ndiswrapper è un software open-source che funziona come un involucro (wrapper) di driver permettendo 
l'utilizzo di driver Windows per dispositivi di rete wireless in Linux. Non viene pre-installato in MX Linux, 
ma è presente nei repository. 
NOTA : il driver di Windows che si vuole utilizzare deve avere una corrispondenza con l'architettura del 
sistema operativo (ad esempio per MX Linux edizione a 32 bit servirà un driver Windows a 32 bit). 
Generalmente, si utilizzano i driver di Windows XP. 
Il metodo più semplice di gestire Ndiswrapper è quello di utilizzare MX Network Assistant (sezione 3.2). 
Vedi anche le estese informazioni presenti nel Wiki di MX/antiX.
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Sicurezza 
La sicurezza wireless è gestita da Network Manager. Ecco i passi fondamentali da seguire: 

• Pulsante destro del mouse sull'icona di Network Manager nell'area di notifica-> Modifica connessioni
• Nel campo Wi-Fi evidenziate il nome del punto di accesso a cui ci si vuole connettere (ad esempio, 

"Linksys" o "Starbucks 2345") 
• Cliccate sul pulsante Modifica e quindi andate alla scheda Sicurezza Wi-Fi 
• Utilizzate il menu a tendina per selezionare la protezione desiderata (ad esempio: WPA o WPA2 

Personal) 
• Inserite la password e cliccate su Salva. 

 
Figura 3-35: La scheda Sicurezza Wi-Fi (Wi-Fi Security) in Network Manager 
È possibile usare Ceni per gestire la sicurezza wireless, funzionerà ugualmente bene ma solo fino a quando in
seguito non si decida di utilizzare Network Manager, con cui interferisce. 
Collegamenti 

• Linux Wireless Kernel  
• Linux Wireless LAN Support   
• Linux Wireless  
• Wiki di Debian: Wifi   
• Arch Wiki: Wireless  

3.4.3  Banda larga mobile 

Per l'accesso a Internet wifi tramite un modem 3G/4G, fate riferimento alle pagine 3G del Wiki di Debian, 
linkate sotto, dove si reperiranno informazioni sulla compatibilità. Molti modem 3G/4G saranno riconosciuti 
da MX Network Manager. 
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Risoluzione dei problemi 
In alcuni sistemi, la connessione del modem non riesce a funzionare a causa di un aggiornamento dei 
pacchetti udev e libudev1 . Per risolvere questo problema, aprite Synaptic, selezionate i due pacchetti 
suddetti, e quindi cliccate su Forza versione → pacchetto... Utilizzate il menu a tendina per selezionare una 
versione precedente e poi cliccate sull'icona Applica. 
In alcuni casi, questa soluzione non ha funzionato in modo adeguato, ma alcuni utenti hanno riscontrato che 
la rimozione completa di Network Manager ha risolto il problema. 
Ulteriori info: Wiki Debian: modem 3G

3.4.4 Tethering

Il tethering consiste nell'uso di un telefono cellulare (o di un altro dispositivo mobile con connessione 

internet) per fornire l’accesso alla Rete ad altri dispositivi che ne sono sprovvisti.

Deve essere creato un "hotspot" sul dispositivo con l’accesso alla rete (ad esempio un telefono) in favore del 

dispositivo sfornito di rete che si vuole usare per accedere alla rete (ad esempio un computer). È facile 

configurare un telefono Android come hotspot, anche se le impostazioni variano, in una certa misura, a 

seconda della versione di Android. 

In Android 8: Impostazioni > Connessioni (o Wireless e Reti) > Hotspot e Tethering (o Tethering e Router 

WiFi) > Hotspot. 

Invece, per far si che sia il computer con MX Linux a fare da hotspot per rendere l’accesso alla rete 

disponibile ad altri dispositivi, consultate questo video.

3.4.5  Utility a riga di comando 

Le utility a riga di comando sono utili per reperire informazioni dettagliate, e sono comunemente utilizzate 
nella risoluzione dei problemi. La documentazione dettagliata è disponibile nelle pagine man. Qui sotto sono 
elencate le più comuni. Devono essere eseguite come root . 
Tabella 4: utility wireless 

Comando Commento 

ifconfig Principale utility di configurazione per le interfacce di rete. 

ifup
<interface> 

Apre l'interfaccia specificata. Per esempio: 
ifup eth0 , attiva l'interfaccia Ethernet eth0 

ifdown
<interface> 

L'opposto di ifup, cioè disabilita l'interfaccia specificata.

iwconfig Utility di connessione wireless. Utilizzata da sola, visualizza lo stato wireless. Può essere 
applicata ad una specifica interfaccia, ad esempio per selezionare un particolare punto di 
accesso 

rfkill Disabilita le interfacce di rete wireless (ad esempio, WLAN ) agendo sia a livello software
che hardware. 

depmod -a Sonda tutti i moduli e, se sono cambiati, abilita una nuova configurazione. 
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3.4.5  DNS Statici

A volte è desiderabile modificare la configurazione di Internet dai DNS (Dynamic Name Service) automatici,
previsti di default, ad una configurazione con DNS statici manuali. I motivi per fare questo possono includere
una maggiore stabilità, una migliore velocità, controllo parentale, ecc. Si può fare questa modifica sull'intero 
sistema oppure su singoli dispositivi. In entrambi i casi, prima di iniziare sarà necessario reperire i parametri 
dei DNS statici che si intende utilizzare, ad esempio quelli di OpenDNS, Google Public DNS, ecc,.

Totale o di Sistema 
È possibile effettuare la variazione per chiunque utilizzi il router, usando un browser. Vi servirà:

• URL del router (qui c'è l'elenco se lo avete dimenticato)

• la password, se ne avete impostata una

Sarà necessario trovare, e poi cambiare, il pannello di configurazione del router, seguendo le indicazioni per 
il vostro particolare router (qui c'è un elenco di diverse guide).

Individuale 
Per cambiare le impostazioni solo per un singolo utente, potete usare Network Manager. 
Cliccate col destro sull'icona di connessione nell'Area di Notifica del panello > Modifica connessioni
Evidenziate la vostra connessione e cliccate il pulsante Modifica. 
Sulla scheda IPv4, usate il menu a discesa per cambiare Metodo su “Automatico (DHCP) solo indirizzi” 
Nel campo “DNS Servers” inserite i parametri dei DNS statici che andrete ad usare. 
Cliccate Salva per uscire.

3.5  Gestione dei file 
La gestione dei file in MX Linux si realizza attraverso Thunar, uno strumento veloce e potente. Gran parte 
del suo uso di base è evidente, ma qui ci sono alcune cose utili da sapere: 

• I file nascosti non sono visibili di default, ma possono essere resi visibili tramite il menu degli 
strumenti in alto andando in Visualizzazione (Visualizzazione> Mostra i file nascosti) o premendo 
Ctrl-h 

• Il riquadro laterale di sinistra può essere nascosto, mentre in quello di destra possono essere collocati 
dei collegamenti alle directory (cartelle) facendo clic destro-> Create symlink 

• Nel menu contestuale sono presenti azioni comuni che variano a seconda di ciò che è presente o è a 
fuoco. 

• E' possibile avviare azioni con i privilegi di Root dal menu degli strumenti andando in File →Apri 
root Thunar qui. Sempre dal menù a discesa di File è possibile aprire un terminale, modificare un file 
di testo come root, ecc. Sempre dal menu degli strumenti andando in Modifica -> Imposta Azioni 
Personalizzate si potranno aggiungere altre voci ai menu. 
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• MX Linux fornisce Thunar con molte azioni personalizzate preinstallate, ma ce ne sono altre 
disponibili da copiare, e ognuno può crearsene per esigenze individuali. Vedi Suggerimenti e trucchi, 
più avanti (Sezione 3.5.1); e Wiki   MX/antiX  . 

• Thunar gestisce facilmente anche i trasferimenti FTP, vedi più avanti. 

 
Figura 3-36 Azioni Personalizzate in Thunar 

3.5.1  Trucchi e consigli 

 Abilita le immagini in miniatura in Thunar

• Quando si lavora in una directory che richiede i privilegi di super-utente, è possibile cliccare col 
destro> Apri root Thunar qui (o Menu Strumenti > File > Apri root Thunar qui). 

• È possibile impostare nuove schede dentro il riquadro di Thunar andando nel menu degli strumenti, 
File> Nuova scheda (o Ctrl-T), e quindi spostando elementi da una posizione ad un'altra trascinandoli 
e rilasciandoli da una scheda all'altra. 

• Le azioni elencate nel menu di scelta rapida possono essere modificate/cancellate, e se ne possono 
aggiungerne di nuove cliccando su Modifica> Imposta azioni personalizzate... 

• È possibile assegnare dei tasti di scelta rapida da tastiera per l'azione personalizzata "Apri Terminale 
qui". Per farlo, è necessario prima abilitare gli Acceleratori Modificabili, andando in Start-menu 
→Tutte le Impostazioni →Aspetto →Impostazioni. Poi, in Thunar, passate con il mouse sopra la voce
“Apri il Terminale qui” che verrà in questo modo evidenziata. Questa voce è raggiungibile dal menu 
degli strumenti di Thunar →File → Apri il Terminale qui (tra i vari file ci deve essere almeno una 
cartella perchè compaia questa voce). Una volta raggiunta ed evidenziata, digitate la combinazione di 
tasti che si desidera utilizzare per quest'azione. Comparirà di fianco alla voce la combinazione 
digitata. Poi, durante la navigazione in Thunar, utilizzate la combinazione di tasti per aprire una 
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finestra di terminale nella directory attiva. Ciò vale anche per le altre voci del menu File di Thunar; ad
esempio, si può assegnare Alt-S per creare un link simbolico per un file evidenziato, ecc.

• Varie altre opzioni e comandi nascosti sono disponibili, vedi link sottostante. 
• Sia Java che Python, spesso usati per produrre applicazioni, hanno come estensione finale 

rispettivamente *.jar e *.py. Questi files possono essere aperti con un singolo click, come qualsiasi 
altro file; non è necessario aprirli utilizzando un terminale.

• I file compressi vengono gestiti cliccando col destro sul file. Il programma di archiviazione che lavora
in sottofondo è file-roller (Menu Start> Accessori> Gestore di Archivi). 

• Per la ricerca di file, aprite Thunar e fate clic destro su una qualsiasi cartella-> Trova file qui. Una 
finestra di dialogo si aprirà mostrando diverse opzioni. Il programma in esecuzione in background è 
catfish ( menu Start> Accessori> Catfish ). 

• Per impostare un collegamento (anche detto link simbolico), cliccate col destro su ciò che vi interessa 
linkare (cartella o file al quale si desideri che il collegamento punti) e sul menu pop-up che compare 
andate su “Create symlink”. Comparirà un altro file identico all'originale ma con una freccia: è il file 
di collegamento. Quindi il link simbolico creato può essere spostato (trascinandolo o con taglia e 
incolla) dove volete.

• Azioni personalizzate di Thunar. Questo è un potente strumento per espandere le funzioni del file 
manager. Per vedere quelle che sono predefinite in MX Linux, fai clic su Modifica> Imposta Azioni 
Personalizzate. La finestra di dialogo che appare ti mostrerà quelle predefinite. Per creare una nuova 
azione personalizzata, fai clic sul pulsante "+" sulla destra. Dettagli nel W  iki   di   MX/antiX.  

• Le cartelle possono essere visualizzate attraverso un’immagine posizionando un'immagine che 
termina in *.jpg o *.png nella cartella e rinominandola “folder”.

Figura 3-37: usare un’immagine per rappresentare una determinata cartella
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3.5.2 FTP 

 
Figura 3-38: Usare Thunar per accedere ad un sito FTP

Il File Sharing Protocol (FTP) è utilizzato per trasferire file da un host ad un altro, tramite una rete. 

• Aprite Thunar e cliccate sull'icona Esplora la rete nel riquadro a sinistra
• Nel campo dell'indirizzo, digitare il nome del server con  ftp://  come prefisso. Ad esempio, per 

raggiungere la documentazione MX (se ne avete i permessi) è necessario immettere questo indirizzo: 
ftp://  mxlinux.org  .

• Sulla finestra pop-up di dialogo inserite nome-utente e password, e lasciate che ricordi la password 
per le volte successive se vi è pratico così. 

• Questo è tutto. Spostandovi fino alla cartella che siete soliti usare, è possibile cliccare col destro sulla 
cartella> Invia a> Pannello laterale (crea scorciatoia). Questo è un modo molto semplice per 
connettersi. 

• Applicazioni specifiche per FTP possono essere installate con MX Installa Programmi.

Per una discussione su come funziona FTP, vedere questa pagina . 

3.5.3  La condivisione di file: risorse condivise in rete

Ci sono varie possibilità di condividere file tra computer, o tra un computer e un dispositivo

• Samba. SAMBA è la soluzione più completa per condividere i file con macchine Windows sulla 
vostra rete senza apportare modifiche alle macchine Windows. SAMBA può essere utilizzato anche 
da molti lettori multimediali di rete e dispositivi Network-Attached Storage (NAS)]. SAMBA offre 
alcuni altri servizi per l'interfacciamento con le reti Windows, ad esempio l'autenticazione ad un 
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dominio, servizi di messaggistica, e la risoluzione dei nomi NetBIOS. Per info dettagliate, vedere di 
seguito. 

• NFS. Questo è il protocollo standard Unix per la condivisione di file. Molti ritengono che sia meglio 
di Samba per la condivisione di file, e può essere utilizzato con macchine Windows (2000 e XP) se 
sulle suddette macchine si installa "Services for Unix" o client NFS. Per info dettagliate vedere: 
MX/antiX Wiki.

• Bluetooth: Per lo scambio di file, installate blueman dai repo, riavviate, accoppiatevi con il 
dispositivo, quindi cliccate col destro sull'icona Bluetooth nell'area di notifica> Invia file al 
dispositivo. 

3.5.4  Risorse condivise (Samba)

Figura 3-39: Utilizzo di Thunar per esplorare le risorse condivise in rete 

Thunar è in grado di connettersi alle cartelle condivise (anche dette condivisioni Samba) su computer 
Windows, Mac, Linux e dispositivi NAS (Network Attached Storage). Per stampare servendosi di Samba, 
vedere la sezione 3.1.2. 

• Selezionate Esplora rete nel riquadro a sinistra di Thunar per vedere le reti presenti, tra cui Rete 
Windows (Windows Network) 

• Cliccate sulla rete su cui volete visualizzare i gruppi di lavoro a disposizione (spesso chiamati,  per 
impostazione predefinita, Workgroups o Gruppi di lavoro). Ora potete trovare quello che state 
cercando. 

• Selezionate un Workgroup o Gruppo di lavoro su un server Samba disponibile
• Selezionate un server per le condivisioni di Samba disponibili
• Selezionate una condivisione (o risorsa condivisa) Samba per vedere le cartelle disponibili
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• Un collegamento alla risorsa condivisa selezionata verrà creato nella sezione RETE del pannello 
laterale sinistro di Thunar

3.5.5  Creazione di condivisioni 

Su MX Linux, Samba può essere anche utilizzato per creare risorse condivise il cui accesso si rende 
disponibile ad altri computer (Windows, Mac, Linux). La creazione di condivisioni pubbliche è abbastanza 
semplice, ma va tenuto presente che la creazione di condivisioni Samba è un campo complesso dal punto di 
vista della configurazione. Ad esempio, l'azione di creare risorse condivise specifiche per singoli utenti, 
correttamente autenticati, è oltre la portata di questa guida. Guide più complete sono disponibili direttamente 
dal programma Samba, e in Samba.org. 
Metodo base 

 Creare una condivisione con lo strumento di configurazione di Samba
Cliccate su Menu-Start> Sistema> Samba per far apparire lo strumento configurazione del server Samba. 
Fate clic sull'icona a forma di segno più per aggiungere una condivisione; i dettagli sono disponibili 
cliccando sull'icona Aiuto. NOTA: gli utenti riferiscono che lo strumento di configurazione spesso non è 
efficace/sufficiente ma deve essere sostituito dal metodo manuale, descritto di seguito.

Metodo manuale 

 Creare una condivisione manualmente
Se avete bisogno, o desiderate, creare azioni manualmente, attenersi alla seguente procedura. 

• Utilizzare una /home/nomecartella esistente o creare una cartella e renderla disponibile in lettura e 
scrittura per: il Proprietario, il Gruppo, e Altri. In altre parole, renderla aperta al mondo. Iniziando con
una semplice Condivisione Pubblica è un buon modo per imparare. NOTA: Se siete preoccupati per 
la sicurezza della rete non utilizzate questo metodo. Piuttosto, studiate i riferimenti di cui sopra per 
imparare a creare azioni sicure. 

• Per stabilire una condivisione Samba, è necessario modificare il file di configurazione in qualità di 
root. Lo si può trovare in: /etc/samba/smb.conf 
Modificate la linea: workgroup = xxxxx associandogli qualsiasi nome di Workgroup di Windows si 
voglia usare (di default è Workgroup) 

• Alla fine del file aggiungete le seguenti righe per stabilire la tua Condivisione
[SHARENAME]
path = /home/nomeutente/nomecartella
guest ok = yes
read only = no
browseable = yes
force create mode = 777
force directory mode = 777

• Salvate il file. Quando aggiungete una nuova condivisione, il demone Samba dovrebbe accorgersene e
attuare immediatamente le modifiche. Se si apportano modifiche a una condivisione esistente, è 
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necessario riavviare Samba per assicurarsi che le modifiche abbiano effetto, andando al terminale, 
diventando root, e immettendo: service samba restart

• Si può anche verificare la presenza di errori in smb.conf eseguendo testparm dal terminale
• Vai ad un altro computer per testare la vostra capacità di vedere la condivisione Samba nella 

navigazione in rete e testare, nella condivisione, la capacità di lettura e scrittura.

Ulteriori info: Documenti Xfce: Thunar 

3.6  Audio
L'audio in MX Linux è gestito a livello di kernel da Advanced Linux Sound Architecture (ALSA), e a livello 
utente da PulseAudio. Nella maggior parte dei casi l'audio funzionerà in automatico senza problemi, anche se
potrebbe essere necessario qualche piccolo aggiustamento. Cliccate sull'icona dell'altoparlante per disattivare 
completamente l'audio, dopo di che ripristinatelo (Sempre che in Preferenze il canale regolabile attraverso 
l’icona sia quello dei diffusori audio, di solito “master”). Posizionare il cursore sull'icona dell'altoparlante 
nell'area di notifica e utilizzare la rotellina per regolare il volume. Vedere anche il paragrafo 3.8.9. 

3.6.1  Impostazioni della scheda audio

Se si dispone di più di una scheda audio, assicurarsi di selezionare quella che si desidera regolare utilizzando 
la funzione MX Schede Audio. La scheda audio viene configurata, e il volume dei brani in ascolto viene 
regolato facendo clic destro sull'icona dell'altoparlante nell'area di notifica> Apri mixer. Se i problemi 
persistono dopo aver fatto il logout ed essere rientrati, leggete il paragrafo Risoluzione dei problemi, qui 
sotto. Per informazioni dettagliate su PulseAudio, vedere più avanti. 

3.6.2  Uso simultaneo delle schede audio

Ci possono essere momenti in cui si desidera utilizzare più di una scheda contemporaneamente; per esempio, 
si può decidere di ascoltare musica sia attraverso le cuffie che attraverso degli altoparlanti posti in un luogo 
diverso. Questo non è facile da fare in Linux, ma troverete indicazioni utili guardando le FAQ di PulseAudio.
Inoltre, dovrebbero funzionare le soluzioni descritte in questa pagina del Wik  i di Mx/antiX  , stando attenti a 
regolare correttamente i riferimenti della vostra scheda alla vostra situazione. 

A volte è necessario fare lo scambio di scheda audio, ad esempio quando una è HDMI e l'altra analogica. 
Questo può essere fatto in PulseAudio, scheda Configurazione; assicurati di selezionare l'opzione Profilo che 
funziona per il tuo sistema. Per rendere automatico questo passaggio, vedi lo script su questo sito di GitHub

3.6.3  Risoluzione dei problemi 

• L’audio non funziona  
• Nessun suono, anche se l'icona dell'altoparlante è nell'area di notifica. 

• Provate ad aumentare tutti i controlli ad un livello superiore. Per un suono di sistema come ad 
es. quello di Login, utilizzate la scheda Riproduzione (Playback) in Pulseaudio.
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• Modificare il file di configurazione direttamente: si veda la Sezione 7.4. 
• Nessun suono, ed inoltre nessuna icona dell'altoparlante è presente nell'area di notifica. 

Potrebbe essere che la scheda audio è mancante o non riconosciuta, ma il problema più comune è 
quella di più schede audio multiple, che affrontiamo ora.

• Soluzione 1: fare clic su Menu> Impostazioni> MX Schede Audio Avviare, e seguire la 
schermata per selezionare e testare la scheda che si desidera utilizzare. 

• Soluzione 2: utilizzare il controllo del volume di PulseAudio (pavucontrol) per selezionare la 
scheda audio corretta 

• Soluzione 3: entrare nel BIOS e spegnere HDMI 
• Controllare la matrice ALSA della scheda audio attraverso i link elencati più sotto. 

3.6.4  Server Audio 

Considerando che la scheda audio è un componente hardware accessibile all'utente, il Sound Server è un 
software che funziona in gran parte in background. Permette la gestione generale di schede audio, e la 
possibilità di effettuare operazioni avanzate sul suono. Il più comunemente usato per un utente individuale è 
PulseAudio.
PulseAudio è un server audio avanzato ed open-source che può lavorare con diversi sistemi operativi, ed è 
installato di default in MX Linux. Ha un proprio mixer che permette all'utente di controllare il volume e la 
destinazione del segnale sonoro. Per un uso professionale, Jack audio è forse il più conosciuto.

Figura 3-40: Utilizzo del Mixer di PulseAudio

3.6.5  Link 

• L'audio non funziona  
• ALSA: Matrix SoundCard   
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• ArchLinux Wiki: Informazioni   su   PulseAudio   
• PulseAudio Documentazione:   Free desktop  

3.7  Localizzazione 
MX Linux è gestito da un team internazionale di sviluppatori che lavorano costantemente per migliorare ed 

ampliare le opzioni di localizzazione. Ci sono molte lingue in cui i nostri documenti non sono stati ancora 

tradotti, e se potete fare uno sforzo per aiutarci in questo, proponetevi al Forum di traduzione.

3.7.1  Installazione 

L'atto primario della localizzazione si effettua già durante l'uso dell'unità-Live. 

• Alla prima schermata del bootloader, assicuratevi di utilizzare i tasti funzione per impostare le 

preferenze. 

• F2. Selezionare la lingua 

• F3. Selezionare il fuso orario che si desidera utilizzare. 

• Se si dispone di una configurazione complessa o alternativa, è possibile utilizzare i parametri 

del boot. Ecco un esempio per impostare una tastiera tartara per la lingua russa: lang=ru 

kbvar=tt Un elenco completo dei parametri di avvio (cheat codes) possono essere trovati nel 

Wiki   di   MX/antiX  . 

• Se impostate i valori di localizzazione nella schermata di boot, allora quando arriverete alla 

Schermata 7 dell'installazione dovrebbero essere mostrati questi valori . In caso contrario, o se si 

desidera cambiarli, selezionate la lingua e il fuso orario che desiderate.

Altri due metodi sono disponibili dopo la schermata di Boot. 

• La prima schermata del programma di installazione di MX Linux consente all'utente di scegliere il 

tipo di tastiera che intende utilizzare. 

• La schermata di Login ha dei menu a discesa, nell'angolo in alto a destra, dove è possibile selezionare

sia la tastiera che la localizzazione.

3.7.2  Post-installazione 

A partire da MX-18, MX Tools include due strumenti per cambiare il tipo di tastiera e la localizzazione. 

Vedere le sezioni 3.2.15 e 3.2.16 più sotto.
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Figura 3-41: Aggiunta di un altro layout di tastiera in Tutte le impostazioni 

Anche Xfce4 ha il suo proprio sistema per fare la stessa cosa:
Ecco i passaggi di configurazione che si possono fare per localizzare il vostro MX Linux dopo l'installazione.

• Per cambiare la tastiera: 
• Cliccare su Start-Menu> Impostazioni> Tutte le Impostazioni> Tastiera, scheda 

Mappatura. 
• Deselezionare “Usa predefiniti di sistema”, quindi cliccate sul pulsante in basso “+ Aggiungi” 

e selezionate la tastiera/e che desiderate sia disponibile. 
• Cliccate su Chiudi, quindi nell'area di notifica del pannello cliccate su Keyboard Switcher 

(l'icona a forma di bandiera) per selezionare la tastiera che volete sia attiva.
• Per ottenere i pacchetti di lingua per le principali applicazioni: cliccate Menu-Start> Sistema> MX 

Installa Programmi, fornite la password di root, quindi cliccate su Language per trovare e installare i
pacchetti della lingua per le applicazioni in uso. 

• Impostare il Cinese Semplificato Pinyin è un po' più complicato, vedi qui.
• Per modificare le impostazioni dell'ora: cliccare su Start Menu> Tutte le Impostazioni > 

Impostazioni Ora e selezionate le preferenze. Se state utilizzando l'orologio digitale DateTime, tasto 
destro del mouse> Proprietà per scegliere 12h/24h e altre impostazioni locali. 

• Per ottenere il correttore ortografico per la vostra lingua: installare il pacchetto aspell o myspell per la
vostra lingua (ad esempio, myspell-it). 

• Per ottenere informazioni meteo locali: Cliccate col destro sul Panello> Pannello> Aggiungi nuovi 
elementi> Aggiornamento Meteo. Poi pulsante destro del mouse> Proprietà e impostare la 
posizione internazionale che si desidera visualizzare (l'applicazione cercherà di indovinarla tramite il 
tuo indirizzo ip). 

• Per la localizzazione di Firefox, installare l'appropriato pacchetto firefox-l10n-  per la lingua di 
interesse; ad esempio, per l'italiano (Italia), installare firefox-l10n-it. 
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• Per Thunderbird, prima di tutto scaricare il pacchetto thunderbird-l10n-xpi-it poi cliccare sul pulsante 
a destra Thunderbird menu > Preferences, andare alla scheda Advanced, premere il pulsante Config 
Editor: mettete nel campo di ricerca general.useragent.locale, poi cliccate due volte sul valore en-US e
impostate la preferenza al nome della localizzazione che volete usare (es., it_IT), quindi tornate al 
pulsante Thunderbird menu > add-ons > Languages e abilitate l'italiano. Riavviate

• Potrebbe essere necessario, oppure si potrebbe desiderare, modificare le informazioni di 
localizzazione (lingua di default, etc.) disponibili per il sistema. Per fare ciò, aprite un terminale, 
diventate root e digitate:
dpkg-reconfigure locales

• Comparirà un elenco con tantissime sigle relative alle impostazioni internazionali, queste si 
potranno scorrere utilizzando i tasti freccia. 

• Attivate e disattivate ciò che volete (o non volete), utilizzando la barra spaziatrice per far 
apparire (o scomparire) l'asterisco davanti alla sigla locale. 

• Al termine, fate clic su OK per passare alla schermata successiva. 
• Usate le frecce per selezionare la lingua predefinita che si desidera utilizzare. Per gli utenti 

dell'Italia, per esempio, tipicamente sarà it_IT.UTF-8. 
• Fate clic su OK per salvare e uscire. 

Ulteriori info: documentazione di Ubuntu 

 
Figura 3-42: Re-impostare la lingua di default per il sistema installato 

3.7.3  Ulteriori note 

• È possibile modificare temporaneamente la lingua per una particolare applicazione inserendo questo 
codice in un terminale (in questo esempio, per passare allo spagnolo):
LC_ALL=es_ES.UTF8 <comando da avviare>
Ciò funzionerà per la maggior parte delle app. già localizzate.

• Se è stata selezionata la lingua sbagliata durante l'installazione, è possibile cambiarla anche 
successivamente, direttamente dal sistema installato, usando MX Localizzazione per correggerla. 
Oppure potete aprire un terminale e inserire questo comando (per disporre dell’italiano):
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sudo update-locale LANG=it_IT.utf8
• Può accadere che una particolare applicazione non abbia una traduzione nella vostra lingua; a meno 

che non si tratti di un'applicazione di MX, noi non possiamo fare nulla per risolvere questo problema, 
piuttosto potreste inviare un messaggio allo sviluppatore. 

• In alcuni file desktop che vengono utilizzati per creare il Menu-Start potrebbe mancare il commento 
nella tua lingua, anche se l'applicazione stessa ha una traduzione nella tua lingua; metteteci al corrente
di ciò con un post nel Forum di traduzione. 

3.8  Personalizzazione
Xfce4 rende molto facile cambiare le funzione di base e l'aspetto della configurazione di un utente, inoltre 
l'integrazione di Xfce 4.14 ha ora fornito funzionalità aggiuntive. 

• Ricordate soprattutto: il tasto destro del mouse è tuo amico! 
• Un grande controllo si riesce ad ottenere tramite Tutte le impostazioni 
• Le modifiche apportate dall'utente sono memorizzate nei file di configurazione di Xfce4 nella 

directory: /home/nomeutente/.config/ (più semplicemente descritta come ~/.config/).
• La maggior parte dei file di configurazione di Xfce4 a livello di sistema sono in /etc/skel/ o in 

/etc/xdg/ 
Ulteriori info: Consigli   su   Xfce e trucchi   (PDF in Inglese)

Wiki di MX/antiX: Comandi di Xfce a riga di comando e altre cose utili (in Inglese)

Alcuni consigli su Xfce (in Italiano)

3.8.1  I temi di default

L'aspetto dei temi di default sono controllati da una serie di elementi personalizzati. 

• Schermata di login (modificabile da Tutte le Impostazioni> lightdm GTK + Greeter Setting)
• Tema: Ark-Dark (MX-18)
• Sfondo: in /usr/share/backgrounds/MXLinux/lightdm/
• Login box: modificabile in default theme nel file /usr/sbin/lightdm-gtk-greeter

• Desktop:
• Wallpaper: Tutte le impostazioni> Desktop

Le immagini predefinite sono presenti in usr/share/backgrounds. Quando si seleziona da 
un'altra posizione, tenere presente che dopo aver utilizzato la voce "Altro" è necessario 
navigare fino alla cartella desiderata, quindi cliccare su "Apri"; solo allora sarà possibile 
selezionare un particolare file in quella posizione.

• Tutte le impostazioni> Aspetto. Si possono trovare varie impostazioni riunite insieme in MX 
Rifiniture

• Impostazioni del Menu-Whisker (anche chiamato impropriamente Start-Menu)
- Personali in: ~/.config/xfce4/xfconf/xfce-perchannel-xml/xfce4-panel.xml; 
impostazioni personali dello stile in: ~/.config/gtk-3.0/gtk.css

89

https://wiki.xfce.org/it/tips
https://mxlinux.org/wiki/xfce/xfce-commands-and-other-useful-stuff#List%20configuration%20settings
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf
http://pclosmag.com/download.php?f=XfceTipsTricksSE.pdf


- Di Sistema: nelle cartelle gtk-3.0 presenti in ciascuna delle cartelle dei temi 
predefiniti (/usr/share/themes/) 

3.8.2  Sguardo generale 

L'aspetto complessivo può essere personalizzato in Menu-Start> Impostazioni> Gestore delle 
impostazioni . 

• Cliccate su Aspetto per modificare Stile, Icone, Font e altre impostazioni. 
• Cliccate su Gestore delle Finestre per selezionare l'aspetto delle finestre. Per modifiche più dettagliate

(es. in che punto del desktop si aprirà la finestra, su quale desktop apparirà la finestra, la dimensione 
che deve avere, ecc.), installate dai repo gdevilspie . 

• Cliccate su Scrivania (oppure si può anche cliccare col destro sul Desktop) per cambiare lo sfondo, il 
menu e alcune impostazioni delle icone. 

• Per gestire le icone presenti sul desktop, ad esempio per avere il cestino o le icone-collegamenti ai 
dispositivi rimovibili, cliccate col destro sul desktop> Impostazioni della scrivania > Icone. 

• Impostazioni dettagliate dello stile sono gestite in ~/.config/gtk-3.0/gtk.css; il codice necessario per 
apportare modifiche è più complesso in Xfce 4.14 rispetto al precedente Xfce 4.12. Un aiuto per 
questi aspetti particolari può essere cercato sul forum di Xfce.

Ulteriori info: Xfce4 docs: Aspetto. 

3.8.3  Pannello 

Figura 3-43: Schermata Preferenze per la personalizzazione dei pannelli 
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• Per spostare il pannello, bisogna prima sbloccarlo cliccandoci sopra col destro, andare su Pannello> 

Preferenze del pannello> scheda Visualizzazione

• Usate MX-Rifiniture per cambiare la posizione del pannello: verticale (destra o sinistra), oppure  

orizzontale (in alto o in basso).

• Per cambiare la modalità di visualizzazione all'interno del pannello, selezionare dal menu a tendina, 

nel campo Disposizione: Orizzontale, Verticale, o Deskbar. 

• Per nascondere automaticamente il pannello, scegliete dal menù a tendina: Mai, Sempre, o in modo 

intelligente (nasconde il pannello quando una finestra si sovrappone ad esso). 

• Installare i nuovi elementi del pannello cliccando col destro su uno spazio vuoto, quindi dal menu che

si presenta scegliere Pannello> Aggiungi nuovi elementi. Poi avete 3 scelte: 

• Selezionare una delle voci dalla lista principale che vi viene presentata 

• Se ciò che si vuole non è lì, selezionate Avviatore. Cliccate sul pulsante in basso “Aggiungi”. 

Quando viene inserita l'icona dell'avviatore nel pannello, cliccateci sopra col destro, poi 

scegliete Proprietà, si apre una finestra pop-up, cliccate sul segno più e selezionate un 

elemento dalla nuova lista che si presenta.

• Se si desidera aggiungere un elemento non presente in una delle liste, selezionate l'icona 

“Aggiunge un nuovo elemento vuoto” sotto il segno più, e riempite i campi di dialogo nella 

finestra che si apre. 

• Le nuove icone appaiono in fondo al pannello; per spostarle cliccate col destro su Sposta

• Per cambiare look, orientamento, ecc. cliccate col destro sul Pannello, poi nel menu che si apre andate

su Pannello > Preferenze del pannello

• L'orologio Orage (di default), così come il plugin "Clock" di Xfce, usa il codice strftime. Per 

cambiarli, consultate questa pagina o aprire un terminale e digitate man strftime .

• Per creare una doppia fila di icone nell'area di notifica, da tasto destro del mouse> Proprietà, e 

diminuite “Dimensione massima delle icone” finché non si trasforma. 

• Per vedere sul pannello tutte le applicazioni aperte, andate in MX Rifiniture > scheda Altro, e attivate 

"Mostra le finestre di tutti gli spazi di lavoro nel pannello” 

• Per aggiungere o eliminare un pannello cliccate col destro sul pannello andate in pannello > 

Preferenze del pannello e cliccate sul pulsante “+”o sul pulsante “x” in alto a destra.

• Il posizionamento del pannello in orizzontale si può ottenere con un solo clic attraverso MX Rifiniture

(Sezione 3.2)

Ulteriori info: Xfce4 docs: Panel. 
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Figura 3-44: Pannello predefinito messo in orizzontale grazie a MX Rifiniture. 

3.8.4  Desktop 

 Personalizzazione desktop
Il desktop di default (o meglio il suo wallpaper o sfondo) può essere modificato in vari modi. 

• Tasto destro del mouse su qualsiasi immagine> Imposta come sfondo 
• Se si desidera che gli sfondi siano disponibili per tutti gli utenti, diventate root e metteteli nella 

cartella /usr/share/xfce4/backdrops; questa cartella comunque dovrete crearla, o utilizzando Thunar 
come root o in un terminale root usando il comando mkdir . 

• Se si desidera ripristinare lo sfondo predefinito, lo trovate in /usr/share/backgrounds/

Molte altre personalizzazioni sono disponibili da Tutte le impostazioni. 

• Cambiare il tema di default in Aspetto . Il tema di default è una versione ritoccata da MX di greybird 
con bordi più larghi che personalizza l'aspetto del Menu-Whiskers.

• Per cambiare i bordi così da renderli meno sottili e più facili da afferrare, consultate il Wiki di 
MX/antiX.

• Aggiungere icone standard come Cestino o Home per il desktop in Scrivania , scheda Icone. 
• La visualizzazione delle finestre, l'ancoraggio ai bordi dello schermo e lo zoom delle finestre possono 

essere personalizzati attraverso Regolazioni del Gestore delle Finestre.
• Se avete più finestre aperte è possibile passare da una all'altra, vedendone il contenuto, 

digitando Alt+Tab. La visione del contenuto delle finestre si può personalizzare scegliendo di 
visualizzare una lista compatta al posto delle icone tradizionali.

• La visione del contenuto delle finestre attraverso Alt+Tab può essere impostata per 
visualizzare miniature (thumbnails) invece di icone, ma richiede di attivare il compositing che 
alcuni computer meno recenti potrebbero avere difficoltà nel supportare. Per attivarlo, prima si
deve andare alla scheda “Scorrimento” e deselezionare “Scorri le finestre in un elenco", quindi
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sulla scheda "Compositore" abilitate la visualizzazione composita e vidimate “Mostra le 
anteprime delle finestre al posto delle icone quando si scorre”.

• Le finestre, se trascinate verso un angolo del desktop e poi rilasciate, si adattano ai bordi dello 
schermo. Aprendo più finestre (fino a 4) e trascinandole verso i bordi dello schermo si 
adatteranno tra loro, senza sovrapporsi.

• Se il compositing è attivato, potete gestire lo zoom delle finestre anche utilizzando la 
combinazione Alt+rotellina del mouse. 

• Per selezionare uno sfondo diverso per ogni area di lavoro (workspace), andate in Scrivania, scheda 
Sfondo e de-selezionate l'opzione “Applica a tutte le aree di lavoro”. Quindi selezionate un wallpaper 
e ripetete il processo per ogni area di lavoro, trascinando la finestra di dialogo nella successiva area di
lavoro selezionando poi un altro wallpaper. 

Figura 3-45: La casella a destra, de-selezionata, consente sfondi diversi per ciascuna area di lavoro

Conky 
E' possibile visualizzare diverse informazioni sul desktop utilizzando Conky, fate cosi:

• Sia Conky Manager sia MX Conky sono installati di default.

• Quando si clicca su MX Conky, verrà mostrata una finestra di dialogo per avvisare se sono disponibili

aggiornamenti.

• Cliccate su menu-Start> Accessori per trovare Conky Manager. MX Conky è contenuto in MX 

Strumenti (MX Tools).

• Un set di conky che funzioneranno senza aggiustamenti è incluso di default. Puoi importarne altri 

usando l'icona “Import Theme Pack” presente nella barra dei menu di Conky Manager
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• Evidenzia ogni conky e premi Anteprima per vedere come appare. Chiudere ogni anteprima prima di 

passare ad un altro. 

• Selezionare la casella del tipo di Conky che vi interessa. Sarà automaticamente installato. 

• I file di configurazione sono memorizzati nella cartella ~/.conky/ in singoli file all’interno di cartelle 

col nome del tema; possono essere modificati evidenziandoli e poi cliccando sull'icona edit (matita) di

Conky Manager.

AIUTO: Wiki di MX/antiX

Ulteriori Info: home page Conky 

 
Figura 3-46: Schermata principale di Conky Manager che mostra una delle molte configurazioni di 
Conky disponibili

HotCorner 
L'apertura dei programmi o attivazione di determinate azioni/effetti può essere facilitata con l'installazione di 
HotCorner. Il plugin del pannello di Xfce non viene più mantenuto, ma nel Wiki di MX/antiX se ne può 
trovare un modo per l'installazione e l'uso.
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Figura 3-47: Finestra di dialogo delle impostazioni di HotCorner 

Terminale a Comparsa

 Personalizzazione del terminale   a     comparsa  

MX Linux fornisce un terminale a discesa molto utile, richiamato da F4 (si può cambiare, se si desidera, con 
Menu Start> Tutte le impostazioni> Tastiera: scheda Scorciatoie applicazioni). La configurazione di 
default è molto funzionale, ma molte opzioni riguardanti l'aspetto e le funzioni sono disponibili cliccando col 
destro su uno spazio vuoto della schermata principale, andando poi nel menù che compare, in Preferenze.

3.8.5  Touchpad

Le opzioni generali per il touchpad di un computer portatile si trovano cliccando su Impostazioni > Mouse e 
Touchpad. Un'applicazione molto utile per disabilitare il touchpad mentre si digita, o per attivarlo e 
disattivarlo a piacere, è touchpad-indicator, che si trova nei repository. Cliccando col destro sull’icona 
nell’Area di Notifica si possono impostare importanti opzioni come ad es. l’autostart.

3.8.6  Menu ("Whisker") 

 Personalizzazion  e del Menu Whisker  

 Diverti  rsi   con il   M  enu   Whisker  
MX Linux viene fornito di default con il menu Whisker, ma può essere facilmente installato un menu 
classico facendo clic destro sul pannello: Pannello> Aggiungi nuovi elementi> Menu delle Applicazioni. Il 
Menu Whisker è altamente configurabile. 
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• Per impostare le vostre preferenze: cliccate col destro sull'icona del menu> Proprietà. Ad es:
• Andate nella scheda Comportamento e selezionate “Posizionare categorie accanto al 

pulsante del Pannello.” 
• selezionate “ Posizionare il campo Cerca accanto al pulsante del pannello”. 
• Nella scheda Comandi potete decidere quali tra i pulsanti di attività, presenti in alto a destra,

quando si apre il menu, volete che siano presenti. 
• E' facile aggiungere programmi a Preferiti: destro del mouse su qualsiasi voce di menu> Aggiungi ai 

Preferiti. 
• Per organizzare i Preferiti secondo i propri gusti è sufficiente trascinarli e rilasciarli. Cliccate su una 

voce per spostarla o cancellarla.
Ulteriori Info:  F  unzioni del menu   Whisker   

MODIFICHE
Le voci del menu possono essere modificate attraverso queste due applicazioni (ma le voci del menu sono 
file.desktop che si trovano in /usr/share/applications/ e volendo potreste anche modificarle direttamente 
come root). 

• MX Menu Editor (Sezione 3.2). 
• Una applicazione nativa di Xfce 

• Fate clic su Menu-Start> Accessori> Trova Applicazioni (o Alt-F3 ), e cliccate col destro su 
una voce.

• Il menu contestuale che si presenta contiene Modifica e Nascondi (quest'ultimo può essere 
molto utile).

• Selezionando il pulsante Modifica si apre una schermata in cui è possibile modificare il nome, 
il comando, l'icona e inserire un commento. 

 

Figura 3-48: Schermata di modifica delle voci del Menu

3.8.7  Schermata di Login (Greeter)

L'utente ha una serie di strumenti per personalizzare la schermata di apertura del login. 
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• Fate clic su Start> Impostazioni> Gestore impostazioni> LightDM GTK + Greeter si apriranno le

impostazioni per regolare la posizione, lo sfondo, il font, ecc 

• L'auto-login può essere attivato da MX Manager Utenti> scheda Opzioni. 

• Alla schermata di Login si può visualizzare un'immagine, come icona personale dell’utente, così:

• Menu Start> Impostazioni> Informazioni personali (Mugshot)

• Compila solo i dettagli che desideri aggiungere.

• Cliccate sull'icona, e raggiungete l'immagine che desiderate utilizzare, infine chiudete

• Manuale

• Creare o selezionare un'immagine e utilizzare gthumb o un altro editor di foto per 

ridimensionarlo a circa 96x96 pixel

• Salvate l'immagine nella vostra cartella home come .face (assicuratevi di includere il punto e 

non aggiungere alcuna estensione come jpg o png).

• Fare clic su Tutte le impostazioni> LightDM GTK + Greeter Settings, scheda Aspetto: attiva 

l'opzione Immagine utente. 

• Qualunque modo si sia scelto effettuate il Log-out, e vedrete l'immagine accanto alla casella di 

accesso; verrà visualizzato anche nel menu di Whisker dopo aver effettuato il login.

3.8.8  Bootloader 

Il menu del bootloader (GRUB) di MX Linux già installato, può essere modificato facendo clic su Menu 

Start> MX Tools > MX Opzioni di Boot (vedi Sezione 3.2.2). Per altre funzioni, installate Grub 

Customizer. . Si dovrebbe usare questo strumento con cautela, tuttavia consente agli utenti di configurare 

alcune impostazioni di Grub importanti, come l'impostazione dell'elenco delle voci della schermata del boot, 

i nomi delle partizioni, lo sfondo, il colore delle voci di menu, ecc. Uno sguardo sulle sue funzioni è visibile 

qui (in inglese) o qui: http://www.html.it/articoli/grub-customizer-guida-alluso/ 

3.8.9  Suoni degli eventi e di sistema 

I bip del computer sono messi a tacere per impostazione predefinita nelle righe di “blacklist” (lista nera) nel 

file /etc/modprobe.d/pc-speaker.conf. Commentate (cioè inserite un # all'inizio della riga) quelle righe come 

root, se desiderate ripristinarle. 

I suoni degli eventi possono essere attivati in tutto il sistema cliccando su Start Menu > Tutte le 

Impostazioni> Aspetto, scheda Impostazioni: selezionate Abilita i suoni per gli eventi e, se lo desiderate, 

Abilita i suoni di feedback per l’input. 

Possono essere gestiti con MX Suoni di Sistema (Sezione 3.2)
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Se poi non iniziate a sentire avvisi sonori quando ad esempio si chiude una finestra o si fa il logout, effettuate

le seguenti operazioni: 

• Fate il Log Out e poi rientrate. 
• Cliccate su-Start Menu> Multimedia> Regolazione del volume PulseAudio, scheda Riproduzione, e 

regolate il livello in base alle esigenze (iniziate con il 100%). 
• Cliccate su Start Menu e, in alto sul campo vuoto di Ricerca, digitate "!alsamixer" (non dimenticare il 

punto esclamativo). Apparirà una finestra di terminale con un singolo controllo audio (Pulseaudio 
Master).

• Utilizzare F6 per selezionare la scheda audio, e quindi regolate i canali che appaiono a un 
volume maggiore. 

• Cercate canali come "Surround", "PCM", "Speakers", "Master_Surround", "Master_Mono" o 
"Master". I canali disponibili dipendono dal particolare hardware. 

Tre file audio sono forniti di default: Borealis, Freedesktop e Fresh e Clean. Tutti si trovano in 
/usr/share/sounds. Se ne trovano altri nei repository o con una ricerca web 

3.8.10  Applicazioni predefinite 

GENERALI
Le applicazioni predefinite da utilizzare per operazioni generali si possono impostare cliccando su Start 
Menu > Tutte le impostazioni > Applicazioni preferite , dove è possibile impostare quattro preferenze. 

• programma di navigazione web (il browser)
• Lettore di posta 
• File manager 
• Emulatore di terminale 

PARTICOLARI
Molti valori di default per tipi specifici di file vengono impostati durante l'installazione di un'applicazione. 

Per esempio, i file *.docx e *.xlsx vengono associati a LibreOffice quando questo viene installato. Ma spesso

esistono più opzioni per un determinato tipo di file, e un utente vorrebbe determinare quale applicazione 

venga attivata con quel file. Un esempio comune è quando un utente vuole aprire un file .mp3 * con un 

lettore musicale diverso da quello di Clementine (default). Esiste un metodo semplice per fare questo 

cambiamento. 

• Cliccate col destro su uno qualsiasi tra i file appartenenti alla tipologia che vi interessa

• Sceglietete una delle seguenti possibilità:

• Apri con <applicazione elencata> . Questo aprirà il file con l'applicazione selezionata per 

questo caso particolare, ma non avrà effetti sull'applicazione predefinita. 
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• Apri con altra applicazione . Scorrete l'elenco per evidenziare quella che desiderate (tra cui 

"Usa un comando personalizzato"), quindi selezionate Apri. La casella in basso "Usa come 

predefinita per questo tipo di file" dovrebbe essere selezionata per impostazione predefinita, 

quindi controllate se desiderate che l'applicazione selezionata diventi la nuova applicazione 

predefinita da avviare quando si fa clic su un file di quel tipo particolare. Tienila deselezionata 

se vuoi usare l'applicazione per una volta. 

Figura 3-49: Modifica applicazione predefinita 

3.8.11  Limitare gli Account 

In alcuni casi, potrebbe essere opportuno bloccare un'applicazione o un sistema per proteggerlo dagli utenti. 

Gli esempi includono i computer di una scuola o presenti in un luogo pubblico destinati ad un uso generale, 

in cui è necessario chiudere il file system, il desktop e l'accesso a Internet. 

Ci sono un certo numero di opzioni disponibili.

• Alcuni componenti di Xfce che supportano la modalità kiosk. Dettagli in: Wiki di   Xfce  

• Controlla se il browser che usi contiene una modalità kiosk

• La distro specializzata per questo compito: Porteus   Kiosk  

Più Info: la guida di Alan D. Moore.
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4  Utilizzo base 

4.1  Internet 

4.1.1  Browser Web 

 MX Linux viene fornito di serie con il popolare browser Firefox già installato. Firefox ha un gran 
numero di add-on e plugin per aumentare l'esperienza dell'utente.
Qui la home page di Firefox e qui i Firefox add-ons

 Gli aggiornamenti di Firefox sono disponibili attraverso i repository di MX Linux, e di solito sono a 
disposizione degli utenti entro 24 ore dal rilascio. Per un download diretto, andare alla Sezione 5.5.5.

 I file di localizzazione di Firefox possono essere installati facilmente con MX Installa Programmi.
 Firefox ha un servizio di sincronizzazione che facilita il trasferimento di segnalibri, cookie, ecc. da 

un'altra installazione di Firefox esistente.
 Altri browser sono comunque sono disponibili, facili da scaricare e installare grazie a MX Installa 

Programmi. Controllare il Wiki di MX/antiX per suggerimenti e consigli di configurazione.

4.1.2  E-mail 

 Thunderbird   è installato di default in MX Linux . Questo popolare client di posta elettronica si 
integra bene con Google Calendar e Google Contacts. Le versioni più recenti disponibili si possono 
ottenere da MX Installa Programmi > MX Repo Test.

 File di localizzazione per Thunderbird possono essere installati facilmente con MX Installa 
Programmi.

 Per info su come intervenire con i link che non riescono più ad aprirsi in un browser, consultare il 
Wiki di MX/antiX.

 Altri client di posta elettronica leggeri sono disponibili sempre attraverso MX Installa Programmi. 

4.1.3  Chat 

 HexChat. Questo programma di chat IRC è installato di default in MX Linux. Rende all'utente lo 
scambio di messaggi di testo molto facile.
home page   di   HexChat   

 Pidgin. Questo comodissimo client ad interfaccia grafica di messaggistica istantanea è in grado di 
utilizzare più reti in una sola volta, cioè, è in grado di collegarsi a più chat di più gestori (Yahoo 
messenger, Microsoft, Facebook etc) .
home page   di   Pidgin  

VIDEO CHAT 

 Skype. Un programma proprietario tra i più popolari per la messaggistica istantanea e chat vocale e 
video. E 'cross-platform e quindi può essere installato su MX Linux senza problemi utilizzando MX 
Installa Programmi > Messaging . Si integra automaticamente con PulseAudio, che viene installato 
per impostazione predefinita. 
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home page di Skype

Segnalazione di problema : di tanto in tanto Skype si rifiuta di riconoscere una particolare webcam. 
Per ovviare, provare questa procedura: aprite una finestra di terminale, diventate root, quindi dare il 
comando per disattivare il driver (scaricarlo dal kernel) e poi il comando per reinstallarlo. (Si può 
anche creare uno script per eseguire automaticamente i comandi.) Vediamo i comandi :
modprobe -r uvcvideo
modprobe uvcvideo

Se non si ottengono risultati, anche dopo aver usato gli strumenti delle impostazioni propri di Skype, 
provate in questo modo :

 Accedi a Skype e poi, dal menu in alto, andate in Skype →Opzioni e andate alla scheda 
Dispositivi Audio. 

 Fate clic sul pulsante per avviare una chiamata di prova. Mentre la chiamata è in corso, dal 
menù principale di Skype andate in Opzioni-> Dispositivi Audio poi cliccate sul pulsante “apri
il gestore dei volumi di PulseAudio”, si aprirà il mixer di Pulseaudio, quindi nel mixer andate 
alla scheda “registrazione” qui potrebbe comparire il pulsante “audio interno stereo 
analogico”, fate delle prove di settaggio su questa scheda. 

 Ancora, mentre la chiamata di prova è in corso – andate alla scheda “ingressi” e settate 
l'ingresso del microfono di Skype sul microfono della webcam. 

 Wire è un software client di messaggistica istantanea cifrato e multipiattaforma. Oltre che su LinuX è
disponibile su iOS, Android, Windows, macOS e su browser web. Usa Internet per fare chiamate 
audio e video, inviare messaggi SMS, file, immagini, video e disegni dell'utente a seconda del 
software usato. Può essere utilizzato su qualsiasi client disponibile e richiede un numero di telefono o 
un indirizzo di posta elettronica per registrarsi. Licenza: GNU-GPL v3

Sito web: https://wire.com/en/

 Gmail ha una funzione integrata di video-chat, vedere la Sezione 4.10.6 

4.2  Multimedia 
Qui elencate vi sono alcune delle numerose applicazioni multimediali disponibili in MX Linux. Esistono 
anche applicazioni professionali avanzate che possono essere trovate attraverso ricerche mirate in Synaptic. 
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4.2.1  Musica 

 
Figura 4-1: Ascoltare una traccia di un CD, con Clementine

 Applicazioni
 Clementine. Un moderno programma per ascoltare musica e per organizzare un archivio in 

grado di riprodurre ogni fonte, da un CD ad un servizio cloud. Installato di default.
home page   di   Clementine   

 Audacious. Un lettore musicale completo e manager di file audio. Installabile tramite  MX 
installa Meta-pacchetti.
home page Audacious 

 Deadbeef. Un piccolo programma, facile da usare e leggero in memoria, ma con robusto set di
caratteristiche di base. Installabile tramite MX installa Meta-pacchetti.
home page   di   deadbeef   

 Ripper ed editor audio
 Asunder. Un CD ripper ed encoder audio con buona interfaccia grafica, che può essere 

utilizzato per salvare su hard disk le tracce dei tuoi CD audio. Installato di default.
home pag  e di Asunder   

 EasyTAG. Una semplice applicazione per la visualizzazione e la modifica dei tag nei file 
audio.
home page   di   EasyTAG  

4.2.2  Video 

 AGGIORNAMENTO: Netflix su Linux a 32 bit

• Applicazioni Video
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• VLC. Celebre player e molto altro che riproduce una vasta gamma di formati video e audio, 
DVD, VCD, podcast, e multimedialità correnti provenienti da varie fonti di rete. Installato di 
default.
Home page di VLC

• SMPlayer. Un mediaplayer che può leggere praticamente tutti i formati video e audio. Se 
installato con MX Installa Programmi allora il browser per YouTube di SMPlayer viene 
installato di default.
home page SMplaye  r  

• Netflix. E’ una funzionalità per lo streaming di film Netflix a livello desktop. E’ disponibile 
per Firefox e Google Chrome. 
home page Netflix

Figura 4-2: Esecuzione del desktop di Netflix in Google Chrome

• Ripper ed editor video
• Handbrake. Un video ripper facile da usare, semplice e veloce. In MX Installa Program.

home page   di   HandBrake   
• DeVeDe. Questa utility converte automaticamente vario materiale audio-video in formati 

compatibili con CD audio e gli standard DVD Video.
home page   di   DeVeDe   

• DVDStyler. Un altro buon programma di authoring. In MX Installa Programmii.
DVDStyler   di   home page   
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• OpenShot. Un editor video semplice da usare e ricco di funzionalità. In MX Installa 
Priogrammi.
home page   di   OpenShot   

4.2.3  Foto 

Figura 4-3: Utilizzare lo strumento di ritaglio in Nomacs 

• Nomacs. Un visualizzatore di immagini veloce e potente installato di default.
h  ome page   di   Nomacs  

• Mirage. Installato di default in MX Linux, questa veloce applicazione è facile da usare e consente di 
visualizzare e modificare le foto digitali. In MX Installa Programmi
home pa  g  e   del progetto Mirage   

• Fotoxx. Questa veloce applicazione permette un facile editing di foto e la gestione degli 
album/raccolte soddisfando le esigenze anche dei fotografi seri.
home page Fotoxx 

• GIMP. Il principale pacchetto di manipolazione delle immagini per Linux. La Guida ( gimp-help ) 
deve essere installata separatamente, ed è disponibile in molte lingue. Il pacchetto base è installato di 
default, mentre se lo si vuole completo è disponibile presso MX Installa Program.
home page   di   GIMP   
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4.2.4  Registrazione dello schermo 

 
Figura 4-4: Schermata principale di SimpleScreenRecorder 

• SimpleScreenRecorder. Un programma semplice ma potente per registrare programmi e giochi. In 
MX Installa Programmii.
home page di S  impleScreenRecorder  

• RecordMyDesktop. Acquisisce i dati audio-video di una sessione di desktop Linux. In MX Installa 
Programmi.
ho  me page   di   recordMyDesktop   . 

4.2.5  Immagini 

• mtPaint. Un'applicazione di facile apprendimento per creare pixel art e manipolazione di foto digitali.
mtPaint home page

• Pinta. Questo programma di disegno/editing, facile da usare, fornisce un metodo semplificato per 
creare e manipolare le immagini.
ho  me page   di   Pinta   

• LibreOffice Draw. Diagrammi, disegni e immagini possono essere creati e modificati con questa 
applicazione.
home page di L  O Draw  

• Inkscape. Questo editor per illustrazioni ha tutto il necessario per creare computer art di qualità 
professionale. In MX Installa Programmi.
home page di Inkscape
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4.3  Ufficio 

4.3.1  Suite Office 

4.3.1.1 Sul desktop

LibreOffice

MX Linux viene fornito con una grande suite per ufficio gratuita chiamata LibreOffice, LibreOffice, un 

ottimo sostituto di  Microsoft Office ® per utenti Linux. La suite è disponibile in Start Menu> Ufficio> 
LibreOffice . LibreOffice supporta i file in formato .docx, .xlsx e .pptx di Microsoft Office 2007 e simili. 

Figura 4-5: La presentazione di apertura in LibreOffice 6

• L'ultima versione disponibile nei repo è installata di default.
• Word Processor: LibreOffice Writer. Un word processor avanzato compatibile con i file in 

formato .doc e .docx. 
• Foglio di calcolo: LibreOffice Calc. Un foglio di calcolo avanzato compatibile con i file in 

formato .xls e .xlsx.
• Presentazione: LibreOffice Impress. Utilizzato per le presentazioni, ecc, compatibile con i file 

in formato .ppt e .pptx. 
• Draw: LibreOffice Draw. Utilizzato per creare grafica e diagrammi. 
• Math: LibreOffice Math. Usato per per le equazioni matematiche. 
• Base: LibreOffice Base. Utilizzato per creare e manipolare database. Se si utilizza questa 

applicazione per creare o utilizzare i database nel formato nativo di LibreOffice, è necessario 
installare anche libreoffice-base-driver e libreoffice-sdbc-hsqldb ovviamente abbinati alla 
stessa versione installata di LibreOffice. 

• Gli utenti possono ottenere le versioni più recenti in diversi modi:
• scaricandole direttamente dal sito di LibreOffice. Vedere il Wiki di MX/antiX per i dettagli
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• Scaricandole da MX Installa Programmi, scheda Debian Backports.
• Scaricando il pacchetto flatpak (con MX Installa Programmi) o il pacchetto appimage.

LINK
• Home page di LibreOffice
• Wiki di MX/antiX

Sono disponibili anche altre suite desktop

• Softmaker   Free   Office   in MX Installa Programmi →Applicazioni popolari
• Calligra Suite (fa parte del progetto KDE) in MX Installa Programmi →Repo Test

4.3.1.2 Nel cloud

Google
• Documenti G  oogle   e la Suite   Office   (quest'ultima richiede un abbonamento) offrono eccellenti

applicazioni online che includono tre componenti standard per l'ufficio: Documenti, fogli di 
calcolo e diapositive. È facile condividere i file, e le opzioni di esportazione sono molto utili.

Microsoft
• I prodotti Microsoft non sono FOSS, ma molti utenti ne hanno bisogno, o vogliono poterci 

accedere, soprattutto nell’ambito delle imprese, in contesti istituzionali ecc. Anche se le 
applicazioni della suite Microsoft Office non possono essere installate nativamente sotto 
Linux, Microsoft Office365 (servizio a pagamento) o On-line Office (gratuito) sono semplici 
normali pagine web che funzionano bene su MX Linux all'interno di qualsiasi browser 
moderno. Dettagli nel Wiki di MX/antiX.

Altre opzioni
• OnlyOffice   (servizio a pagamento per le imprese)

4.3.2  Finanze per ufficio

• GnuCash. Software finanziario per uso ufficio. E' facile da imparare, e consente di monitorare i conti 
bancari, le operazione eseguite, il reddito e le spese. Può importare dati in QIF, QFX e altri formati, e 
supporta contabilità a partita doppia. Presente in MX Installa Programmi. Il pacchetto della Guida 
(gnucash-docs) deve essere installato separatamente.
home page   di   GnuCash   
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Figura 4-6: Nuovo conto in GnuCash 

4.3.3  PDF 

• QPDFview. Un visualizzatore veloce e leggero, che comprende una serie di strumenti di base. 
Installato di default.
home page QpdfView 

• Adobe Reader per Linux offre ulteriori funzionalità (come ad esempio i commenti e la  compilazione
di form). In MX Installa Pacchetti (sotto la scheda Ufficio).

• home page di Adobe Reader   
• PDFShuffler permette riordino, cancellazione e aggiunta di pagine PDF. Installato di default.

• home page   di   PDFShuffler   
• gscan2pdf è un metodo pratico di scansione di documenti in PDF, oltre a servire esigenze di 

scansione generali. Installato di default. (vedi Wiki di MX/antix)
• home page   di   gscan2pdf     
• Wiki di M  X/antiX: gscan2pdf   

• SimpleScan è un software di scansione semplice che funziona molto bene per le attività quotidiane. 
Installato di default in MX Linux

• home page   di SimpleScan  
• Per altre funzioni (ad esempio, la creazione di un documento PDF usando LibreOffice), vedere Wiki 

di M  X/antiX: PDF  

4.3.4  Impaginazione e desktop publishing

• Scribus. L'impaginazione professionale che produce output pronti per la stampa. Disponibile con MX
Installa Programmi.
home page   di   Scribus   
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4.3.5  Project time traker (Registra tempi di progetto)

• Kapow. App semplice ma ricca di funzionalità per registrare i tempi di sviluppo di un progetto.
home page   di Kapow  

Figura 4-7: Kapow impostato per monitorare il lavoro di un progetto

• Altre Opzioni  

4.3.6  Videoconference e desktop remoto

• AnyDesk. Permette un facile accesso remoto. Disponibile in MX Installa Programmi, insieme ad altre
opzioni. Home page di AnyDesk

• TeamViewer. Applicazione multipiattaforma per il supporto remoto e videoconferenze online. 
Gratuito per uso privato. Disponibile in MX Installa Programmi
home page   di   TeamViewer  

4.4  Casa

4.4.1  Finanze 

• HomeBank. Facile gestione della vostra contabilità personale, delle vostre finanze e budget.
home page di HomeBank

• Grisbi è molto utile per la finanza domestica. E' possibile importare i file QIF/QFX, e ha 
un'interfaccia intuitiva.
home page   di   Grisbi   

4.4.2  Media Center 

• Plex Mediaserver. Consente di accedere a tutti i file multimediali presentandoli raggruppati insieme 
per un più facile accesso e visione. In MX Installa Programmi. 
home page   di Plex  
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• Kodi Entertainment Center (ex XBMC) permette agli utenti di riprodurre e visualizzare la maggior 
parte dei video, musica, podcast e tutti i file multimediali digitali comuni da supporti di 
memorizzazione locali e di rete. In MX Installa Programmi
home page   di   Kodi   
Wiki   di   Kodi  

4.4.3  Agenda - Organizer 

• Note. Questo utile plugin di Xfce (xfce4-notes-plugin) consente di creare e organizzare i foglietti 
appiccicosi di note (post-it) per il vostro desktop .
home pag  e di Note   

• Osmo. Gradevole applicazione compatta che include calendario, attività, contatti e note, Calendario 
velocissimo. Integrato con Thunderbird. 
home page   di   Osmo   

Figura 4-8: La gestione delle informazioni personali di Osmo 

4.5  Sicurezza 

4.5.1  Firewall 

• Gufw. Un programma, di facile utilizzo, per la configurazione di un firewall personale. Installato di 
default.
home page   di   Gufw  
Wikipedia: Personal firewall
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4.5.2  Antivirus 

• ClamAV. Utile per impedire agli utenti di Linux di passare inconsapevolmente email e altri 
documenti infettati da virus agli utenti vulnerabili di Windows.
home page di ClamAV 

4.5.3  AntiRootkit 

• Chkrootkit. Questa applicazione esegue la scansione del sistema alla ricerca di rootkit noti e 
sconosciuti, backdoor, sniffer ed exploit.
home page   di C  hkrootkit   
Wikipedia: Rootkit

4.5.4  Protezione delle password 

• Passwords and Keys. Un gestore di password e chiavi di criptazione installato di default. Consigli e 
dettagli d'uso si possono trovare nel Wiki MX/antiX.

• KeePassX. Un gestore di password e di misure di sicurezza che vi aiuta a gestire le password in modo
sicuro. In MX Installa Programmi
home page   di   KeePassX   

4.5.5  Accesso al Web 

• La maggior parte dei browser moderni hanno componenti aggiuntivi che permettono un facile 
filtraggio del web. 

• FoxFilter è un classico esempio che si installa su Firefox, Chrome e Opera.

Figura 4-9: La scheda Preferenze in FoxFilter
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4.6  Accessibilità 
Esistono varie utility open-source per gli utenti Linux MX con disabilità. 

• Tastiere sullo schermo. Lo strumento Onboard è installato di default, e Florence si trova nei repo.
• Xfce. Fare clic su Menu Start> Impostazioni> Accessibilità e selezionare Abilita tecnologie assistive. 

Modificate le opzioni disponibili per soddisfare i vostri gusti. 
Documentazione Xfce4:   A  ccessibilità  

• Debian. Molti altri strumenti sono disponibili all'interno di Debian stesso.
Wiki di Debian

4.7  sistema 

4.7.1  Richiedere i privilegi di root

Per apportare modifiche al sistema (ad esempio per l'installazione di software) è indispensabile ottenere i 
privilegi di root (o amministratore, superuser). Ci sono due classici comandi per diventare root usando un 
terminale.

• su: richiede la password di root e garantisce i privilegi per tutta la sessione di terminale 
• sudo: richiede la password utente e concede privilegi per un breve periodo di tempo 

In altre parole, “su” consente di uscire dalla modalità utente in modo da essere, di fatto, loggati come root, 
mentre sudo consente di eseguire comandi nel tuo account utente con privilegi di root. Inoltre, su utilizza 
l'ambiente (la configurazione specifica di un utente) dell'amministratore (root), mentre sudo permette 
modifiche a livello di amministratore, ma mantiene l'ambiente dell'utente nell'eseguire il comando. In 
generale, MX Linux usa il "vero root", il che significa che questo manuale e il Forum in genere istruiscono 
sull'uso di su. 
Ulteriori info: fate clic sul menu Start> digitate "#su" o "#sudo" (senza le virgolette) nello spazio di ricerca in
alto, e andate a vedervi le pagine dettagliate di man (il manuale nel terminale). 

Avviare un'applicazione root 

Alcune applicazioni, presenti nel menu Start, richiedono che l'utente abbia i privilegi di root: GParted, Grub 
Customizer, lightdm gtk+ greeter, ecc. A seconda di cosa è stato previsto nel programma, la finestra di 
dialogo che compare può mostrare che l'accesso come root venga memorizzato (come impostazione di 
default) per tutto il tempo di durata della sessione (cioè, fino al log-out del computer). Questo è il caso di 
gksu, ma non di altri come pkexec.
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Figura 4-10: Finestra di dialogo che si presenta quando viene utilizzato il comando pkexec, che non 
prevede di mantenere in memoria la password di root

Persistenza dei privilegi di root
Se nelle applicazioni presenti nel menu-start viene usato il comando gksu, allora la volta successiva in una 
stessa sessione, in cui si avvia un'applicazione che necessita dei privilegi di root, comparirà una finestra di 
dialogo indicante che i privilegi sono stati concessi senza la necessità di fornire nuovamente la password 
(volendo potete selezionare l’opzione di non mostrare più il messaggio). Se preferite che la password venga 
fornita ogni volta, potete modificare questa azione predefinita de-selezionando "Ricorda password" 
(Remember password) quando vi apparirà questa finestra di dialogo. 

Figura 4-11: Finestra di dialogo che mostra la casella per ricordare la password di root

4.7.2  Ottenere le specifiche del tuo hardware

• Fare clic su Start> Sistema> System Profiler e Benchmark per un bel display grafico che include i 
risultati di vari test. 

• Cliccate su Start > MX Tools > Veloce Info di Sistema. E’ la stessa cosa di aprire un terminale e 

digitare il comando: inxi -Fxrz

L'output viene automaticamente copiato negli appunti e può facilmente essere incollato in un post del 
forum.
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4.7.3  Creare collegamenti simbolici 

Un link simbolico (anche soft link o symlink) è un tipo speciale di file che punta a un altro file o a una 
cartella, molto simile a un collegamento in Windows o un alias in Macintosh. Un collegamento simbolico 
non contiene dati reali (come fa invece un hard link), semplicemente punta a un altro luogo da qualche parte 
nel sistema. 
Ci sono due modi per creare un collegamento simbolico: con Thunar o usando la riga di comando. 

• Thunar 
• Individuate il file o la cartella (destinazione del collegamento) a cui si desidera puntare da un 

altra posizione nel filesystem o utilizzando un altro nome 
• Fate clic destro su ciò che si desidera collegare> Create Symlink, e viene creato un link 

simbolico nella posizione in cui ci si trova 
• Cliccate con il tasto destro del mouse sul nuovo collegamento simbolico> Taglia 

Passate nel punto del filesystem in cui si desidera che sia piazzato il collegamento, cliccate col
destro su un'area vuota> Incolla. 

• Modificate se necessario il nome del collegamento. 
• Riga di comando: Aprite un terminale e digitate: 
ln -s Nome/del_file_o_cartella/a_cui/si_punta Nomecollegamento

• Nell'inserire i nomi dei file/cartelle assicuratevi di includere il percorso completo. 
• Ad esempio per un link simbolico, che si vuole sia presente nella cartella Documenti, ad un 

file chiamato "foto.jpg" presente nella cartella Download, scrivete nel terminale:
ln -s ~/Download/foto.jpg ~/Documenti/foto 

• L'opzione -s indica che si sta creando un link simbolico e non un hard link.
Un hard link (o collegamento fisico), a differenza del link simbolico, si collega direttamente ai
dati, praticamente ottengo una copia del file originario che si aggiorna nei contenuti se 
l'originale viene modificato, ma se viene modificato il duplicato sarà l'originale ad aggiornarsi.
Inoltre con un link simbolico cancellando il file d'origine, il file di collegamento non sarà in 
grado di aprire più nulla, mentre con un hard link se cancello l'originale il file collegato 
continua a sussistere con tutto il suo contenuto.

4.7.4 Trovare file e cartelle

GUI (Interfaccia Grafica)
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Figura 4-12: Schermata di ricerca di Catfish 
Catfish è installato di default in MX Linux, e può essere lanciato dal Menu Start> Accessori . E' inoltre 
integrato in Thunar in modo che l'utente lo possa attivare cliccando col destro su una cartella> Trova file qui.
home page   di   Catfish   

Altri programmi di ricerca più avanzati sono disponibili nei repository come recoll.

CLI (Riga di comando)
Ci sono alcuni comandi molto utili da usare in un terminale. 

• Locate. Per ogni modello fornito, locate effettua una ricerca su uno o più database di nomi di file e 
visualizza quelli che contengono il modello. Ad esempio, digitando:
locate firefox

restituirà una lunghissima lista di ogni singolo file che contiene la parola "firefox" nel suo nome o nel 
suo percorso. Questo comando è simile a find e funziona meglio quando si conosce con precisione il 
nome esatto del file. 
esempi di locate 

• Whereis. Un altro strumento a riga di comando, installato di default. Per ogni dato modello, whereis 
cerca uno o più database di nomi di file e visualizza i nomi dei file che contengono il modello, ma 
ignora i percorsi così che la lista di nomi riportata è molto più breve. Ad esempio, digitando:
whereis firefox

restituirà un elenco molto più breve, rispetto a quello di locate. Qualcosa come questo: 
firefox: /usr/bin/firefox /etc/firefox /usr/lib/firefox /usr/bin/X11/firefox /usr/share/firefox 
/usr/share/man/man1/firefox.1.gz 
esempi   di   whereis  

• Which: Probabilmente il più utile, tra questo tipo di comandi. Quando viene fornito un comando a 
which, questi tenterà di rintracciare l'eseguibile. Ad esempio, digitando:
which firefox
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restituisce un singolo elemento: 
/usr/bin/firefox
esemp  i di which  

4.7.5  Uscita e chiusura forzata dei programmi 

• Desktop
1. Premete Ctrl-Alt-Esc per cambiare il cursore in una "x". Cliccando poi sulla finestra di un 

qualsiasi programma aperto, questo verrà chiuso. Tasto destro del mouse per annullare. Fate 
attenzione a non cliccare direttamente sul desktop o la sessione terminerà bruscamente. 

2. Gestore dei processi: avviate da menu Start> Preferiti> Gestore dei Processi o cliccate su 
menu Start> Sistema> Gestore dei Processi , selezionate il processo da fermare e fate clic 
destro per arrestare, interrompere o chiudere forzatamente. 

3. E' disponibile anche uno strumento più tradizionale: fate clic su Start> Sistema> Htop , che 
vi aprirà un terminale dove si vedranno tutti i processi in esecuzione. Individuate il 
programma che desiderate interrompere, evidenziatelo, premete F9, quindi premete il tasto 
invio. 

• Terminale: premete Ctrl-C , che di solito ferma un comando/programma che è stato avviato 
attraverso una sessione del terminale. 

• Se le soluzioni precedenti non funzionano, provate questi metodi più estremi (elencati per gravità 
crescente). 

Riavviare il server X. Premete Ctrl-Alt-Bksp per uccidere tutti i processi della sessione, 
ritornando alla schermata di login. Qualsiasi lavoro non salvato andrà perso. 
Utilizzare il tasto magico R Sist (REISUB). Tenete premuto il tasto Alt e contemporaneamente
con l'altra mano il tasto R Sist (oppure Stamp), e poi lentamente senza smettere di premere 
Alt+RSist, premete i tasti R-E-I-S-U-B, uno dopo l'altro. Tenete premuto ciascun tasto della 
sequenza REISUB per circa 1 o 2 secondi prima di passare al tasto successivo; il sistema 
dovrebbe arrestarsi correttamente e riavviarsi. Lo scopo di questa sequenza magica è quello di 
far passare il sistema attraverso diverse fasi che lo conducono in sicurezza fuori da un guasto 
di qualche tipo.
Questo e' ciò che succede passando queste lettere al sistema:

➢ R - cambia la modalità della tastiera. Per far "passare la tastiera dalla modalità raw, la modalità
usata da programmi come X11 e svgalib, alla modalità XLATE" (da Wikipedia), ma non è 
detto che abbia un effetto significativo. 

➢ E - termina in maniera pulita tutti i programmi in esecuzione. Questo tasto invia il segnale 
SIGTERM a tutti i processi eccetto init e chiede loro di terminare con calma, dando loro la 
possibilità di riordinare e liberare le loro risorse, salvare i dati, ecc.....

➢ I - uccide con forza tutti i programmi in esecuzione. E’ simile alla E, ma invia il segnale 
SIGKILL a tutti i processi eccetto l'init, che li uccide immediatamente e con forza. 

➢ S - sincronizza tutti i dischi e pulisce le loro cache. Tutti i vostri dischi hanno normalmente 
una cache di scrittura, un settore di RAM dove il sistema mette in cache i dati che vuole 
salvare sul dispositivo, per velocizzare l'accesso. Syncing dice al sistema di pulire 
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immediatamente queste cache ed eseguire tutte le scritture rimanenti. In questo modo non si 
perdono i dati che sono già stati messi in cache ma non ancora scritti e si protegge dal lasciare 
il filesystem in uno stato incoerente. 

➢ U - smonta tutti i dischi e li rimonta in sola lettura. Anche questo tasto non ha effetti 
partricolarmente evidenti, semplicemente fa sì che tutti i dischi montati siano in sola lettura 
per evitare ulteriori scritture (che potrebbero risultare parziali). 

➢ B - riavvia il sistema. Riavvia il sistema. Tuttavia, non esegue uno spegnimento pulito, ma un 
hard reset.

Andando a premere il tasto E, dovreste vedere il display grafico scomparire, ma se non 
succede nulla perchè questa combinazione di tasti non funziona, Potete provare così:
Nel vostro computer il tasto Alt sulla sinistra potrebbe non funzionare, in questo caso prova ad
usare il tasto a destra Alt Gr. Spesso l'intera sequenza Alt-RSist + REISU, lavora correttamente
ma se il tasto B non avvia il reboot, allora provate a premere il taso B insieme a Alt Gr invece 
di Alt, cioè premete Alt Gr-RSist + B. Se ancora non va provate a sostituire O invece di B, il 
computer si dovrebbe spegnere invece di fare il reboot. 
Nei portatili che usano il tasto Fn per differenziare RSist da Stamp, potrebbe non essere 
necessario usare il tasto Fn (cioè Alt-Stamp+lettera dovrebbe funzionare).
In alcuni computer potrebbe essere necessario premere Ctrl insieme con Alt. Quindi ad 
esempio si dovrebbe premere insieme Ctrl-Alt-SysRq+R.
Wikipedia: REISUB

• Se non funziona nient'altro, tenete premuto il pulsante di accensione del computer per 10 secondi o 
giù di lì fino a quando non si spegne. 

 
Figura 4-13: Schermata principale di Gestore dei processi, pronto a chiudere un processo.
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4.7.6  Controllo delle Prestazioni

Generale 

• GUI
• Fate clic su Start> Sistema> System Profiler e Benchmark, dove è possibile non solo vedere 

un gran numero di caratteristiche, ma eseguire anche test di performance. 
• Molti conky (monitor di sistema sul desktop) mostrano le prestazioni del sistema; potete 

utilizzare Conky Manager per visualizzare in anteprima le tue preferenze ed esigenze. Vedere 
la sezione 3.8.3.

• Plugins Xfce. Xfce 4.12 dispone di una serie di plugin per il monitoraggio del sistema che 
possono essere inseriti nel pannello, tra cui Battery Monitor, CPU Frequency Monitor, CPU 
Graph, Disk Performance Monitor, Free Space Checker, Network Monitor, Sensor plugin, 
System Load Monitor, and Wavelan . Essi possono essere installati attraverso il metapacchetto 
xfce4-goodies.
home page   di   Xfce4 G  oodies   

• CLI
• lm-sensors. Questo pacchetto di monitoraggio della salute dell'hardware è installato di default 

in Linux MX. Aprite un terminale, diventate root e digitate:
sensors-detect 
Premete il tasto Invio e rispondete sì a tutte le domande. Al termine, si sarà in grado di 
ottenere informazioni dettagliate sui valori di lettura dei vari sensori, disponibili sul vostro 
sistema, aprendo un terminale e digitando: sensors . 
lm-sensors

Batteria 
Il livello della batteria è monitorato dal plugin “Power Manager” presente sul pannello. Volendo è disponibile
anche un altro plugin per il pannello, specifico per la carica della batteria, si ottiene cliccando col destro sul 
Pannello> Pannello> Aggiungi nuovi elementi ...

4.7.7  Pianificare le attività 

• GUI
• Compiti pianificati (gnome-schedule). Un modo molto utile per pianificare operazioni di 

sistema senza dover modificare direttamente i file di sistema. Installato di default.
home page   di g  nom  e schedule  

• CLI
• È possibile modificare manualmente crontab, un semplice file di testo che contiene un elenco 

di comandi che devono essere eseguiti in determinati orari.
panoramica   di   crontab   
easy crontab generator 
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4.7.8 Orario Corretto 

La corretta impostazione dell'ora viene normalmente effettuata durante l'installazione. Se l'orologio mostra 
sempre l'ora sbagliata, ci sono 4 possibili cause: 

• fuso orario sbagliato 
• scelta sbagliata di UTC in funzione del tempo locale 
• orologio del BIOS impostato in maniera sbagliata 
• time drift (tempo di deriva) 

Questi problemi di solito si superano utilizzando “MX Ora e Data” ( menu Start> Impostazioni> MX Ora 
e Data); per le modalità a riga di comando, vedere il Wiki di MX/antiX. 

4.7.9  Visualizza Key Lock (Blocco Tasti Maiusc)

Su molti computer portatili non vi è alcuna spia per l'attivazione dei tasti CAPSLOCK o NumLock, il che 
può essere molto fastidioso. Si può risolvere questo problema con una notifica che compare sullo schermo, 
installate indicator-keylock dai repository. 

4.8  Backup 

4.8.1  Backup

Eseguire il backup dei dati e dei file di configurazione regolarmente è una pratica molto importante. 
Un'attività che si può svolgere facilmente in MX Linux. Si consiglia vivamente di eseguire il backup su 
un'unità diversa rispetto a quella nella quale hai i tuoi dati da copiare! L'utente medio potrà disporre 
convenientemente di uno dei seguenti strumenti grafici, anche se i metodi CLI saranno ugualmente funzionali
ed efficaci. 

 
Figura 4-14: Schermata principale di Lucky Backup 
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• LuckyBackup. Un programma facile per eseguire il backup e la sincronizzazione dei file. Installato 
di default.
manuale   di   LuckyBackup   

• Déjà Dup. Uno strumento per il backup semplice ma molto efficace.
home page di Deja Dup

• BackInTime. Una valida applicazione ben conosciuta. In MX Installa Pacchetti > MX Test Repo.
• Servizi Cloud. Ci sono molti servizi cloud che possono essere utilizzati per il backup o la 

sincronizzazione dei dati. Dropbox e Google Drive sono probabilmente i più conosciuti, ma ne 
esistono molti altri. 

• Clonazione. Creare un'immagine completa del disco rigido.
• Clonezilla. Scaricate Clonezilla direttamente dalla home page di Clonezilla, 

copiate/masterizzate l'ISO di clonezilla su una unità (CD/Dvd, Usb), spegnete il computer e 
avviate usando l'unità con clonezilla. Documentatevi prima di ripristinare una partizione con 
clonezilla, è un software da gestire con attenzione.

• Timeshift. Fa il ripristino/backup dell’intero sistema; installabile dai repo. La home-page di 
Timeshift include una dettagliata panoramica e istruzioni d'uso.

• Strumenti CLI. Vedere la discussione in Arch Wiki: Clonazione
• comandi CLI per fare il backup (rsync, rdiff, cp, dd, tar, ecc.)

Arch Wiki: Backup

Vedere anche la sezione 6.6.3 Salva tuo Sistema su ISO (MX Snapshot) 

Dati 

Assicurarsi di eseguire il backup dei dati, inclusi i documenti, grafica, musica e mail. Per impostazione 
predefinita, la maggior parte di questi vengono memorizzati nella directory /home; noi però raccomandiamo 
che se possibile si utilizzi una partizione dati separata o, ancora meglio, uno stoccaggio dati esterno (es. 
Cloud o su Server). 

File di configurazione 

Ecco un elenco di elementi da considerare per il backup. 

• /home. Contiene la maggior parte dei file di configurazione personali. 
• /root. Contiene le modifiche apportate come amministratore-root. 
• /etc/X11/xorg.conf. file di configurazione del Server X, se ce n'è uno. 
• I file di GRUB2  /etc/grub.d/ e /etc/default/grub . 

Elenco dei pacchetti dei programmi installati:

Non è una cattiva idea salvare nella directory /home, o nel cloud (Dropbox, Google Drive, ecc.) un file che 
contiene l'elenco dei programmi che sono stati installati con Synaptic, apt-get o Gdebi. Se in futuro fosse 
necessario reinstallare, è possibile recuperare i nomi dei file per una facile reinstallazione. 
GUI 
Uno strumento utile per avere una lista dei pacchetti installati successivamente all'installazione del sistema 
può essere trovata facendo clic destro sull'icona di MX Aggiornamenti  nell'area di notifica> Cronologia. 
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Apparirà un elenco dei pacchetti che sono stati installati tramite il sistema apt. Sarà possibile copiare e 
incollare questo elenco in un documento per l'archiviazione e la consultazione. 
CLI 
È possibile creare un inventario di tutti i pacchetti sul sistema installato dopo l'installazione copiando questo 
comando per poi eseguirlo in un terminale. Questo creerà un file di testo nella vostra directory home 
chiamata "apps_installed.txt" contenente tutti i nomi dei pacchetti. 
Per reinstallare tutti i pacchetti in una sola volta: fate in modo che tutti i repository necessari siano abilitati, 
quindi date questi comandi uno alla volta: 
su
dpkg set-selections < apps_installed.txt 
apt-get update 
apt-get dselect-upgrade 

NOTA: Si deve evitare di utilizzare un file apps-installed.txt appartenente ad una release di MX basata su una
versione di Debian diversa rispetto a quella su cui si va a dare il comando (ad esempio, comando dato su 
MX-17 utilizzando un file ricavato da MX-16)
C'è uno strumento di nome aptik nei repository che può aiutare se usato con attenzione. È stato sviluppato 
per Ubuntu ma risparmierà un bel po' di lavoro ugualmente bene anche in MX Linux, specialmente riguardo 
certi file di impostazioni che si ha la tendenza a tralasciare nelle operazioni di backup e ripristino.

4.8.2 Manutenzione del disco

Quando un sistema invecchia, spesso accumula dati che non vengono più utilizzati e riempiono gradualmente
il disco. Tali problemi possono essere ridotti dall'utilizzo periodico di MX Pulizie.
Vediamo un esempio. Poichè la sua macchina stava rallentando, un utente controllò lo spazio libero sul disco 
usando inxi -D e fu sorpreso di vedere che il disco era pieno al 96%. 

Cliccando sul pulsante Avvia Disk Usage Analyzer che si trova in MX Pulizie, gli venne fornita una analisi 
grafica del disco e cliccando sui grandi segmenti rossi venne messo in evidenza che in particolare era la 
cache ad essersi gonfiata molto.

Figura 4-15. Disk Usage Analyzer che mostra una directory root quasi piena
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Dopo la pulizia con MX Pulizie, la percentuale è scesa a circa il 63% e la lentezza era sparita.

Figura 4-16. Risultati della pulizia della cache nella rappresentazione fornita da DiskUsageAnalyzer

4.8.  Verifica degli errori

Molti messaggi di errore vengono scritti in file specifici che registrano eventuali problemi in applicazioni, 

eventi, servizi e sistema. Sono detti file log e sono contenuti nella directory /var/log/. 

Tra questi, i più importanti sono:

• /var/log/boot

• /var/log/dmesg 

• /var/log/kern.log 

• /var/log/messages 

• /var/log/Xorg.0.log

Non sono sempre facili da leggere, ma spesso vale la pena guardarli se si sospetta un problema. Puoi 

guardarli in un terminale usando il comando cat seguito dalla posizione del log che vuoi vedere. Di solito per 

la maggior parte degli utenti è molto più semplice esaminarli installando dai repository gnome-system-log.

4.9  Giochi 
Navigando lunga la lista di giochi disponibili tramite Synaptic (cliccate su Sezioni> Giochi e divertimento 
nella parte inferiore del pannello di sinistra) o seguendo i link qui sotto, si presenteranno molti titoli per il 
vostro divertimento. 
Di seguito sono elencati alcuni esempi per stuzzicare l'appetito. 
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4.9.1  Giochi di avventura e sparatutto

• Chromium BSU: uno sparatutto veloce, top-scrolling, in stile arcade, che utilizza una navicella 
spaziale. Installato di default.
Chromium BSU home page: 

• Beneath A Steel Sky: Un thriller di fantascienza ambientato nel futuro in una dimensione tetra post-
apocalittica. 
home page   di Beneath a   Steel Sky   

• Kq: Una console in stile gioco di ruolo, simile a Final Fantasy. 
home page   di   kq   

• Mars. "Uno sparatutto da ridere/demenziale". Proteggi il tuo pianeta dalla brutta fine che vi vogliono 
riservare i vostri vicini invidiosi!
home page Mars 

 
Figura 4-17: Attacco di navi da guerra nemiche su Chromium BSU 

4.9.2  Giochi Arcade 

• Defendguin: Un clone di Defender, in cui la tua missione è quella di difendere piccoli pinguini. 
home page Defendguin 

• Frozen Bubble: bolle colorate vegono congelate nella parte superiore dello schermo. Via via che il 
ghiaccio scende, si devono eliminare gruppi di bolle congelate prima che queste raggiungano il 
cannoncino del giocatore.
home page   di   Frozen Bubble   

• Planet Penguin Racer: un divertente gioco di auto da corsa con il vostro pinguino preferito.
home page di T  uxracer home page   

• Ri-li: Un simpatico gioco che utilizza un trenino. 
home page Ri-li 

• SuperTux: Un classico gioco “corri e salta” in 2D ad avanzamento laterale in uno stile simile ai 
giochi originali di SuperMario.
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home page   di   SuperTux   
• SuperTuxKart: una versione molto migliorata di tuxkart. 

home page   di   Supertuxkart   

 
Figura 4-18:  Il treno Ri-li ha bisogno che decidiate velocemente il da farsi. 

4.9.3  Giochi di società 

• Giochi del team Gott Code: Peg-E (un gioco solitario a pedine) installato di default.
home page   di   Gottcode   

• Mines (gnomines): un gioco con un campo minato per 1 giocatore. 
home page   di Mines  

• Do'SSi Zo'la: L'obiettivo di questo gioco che si svolge su un isola è quello di bloccare l'avversario 
distruggendo le caselle che lo circondano. 
home page   di   Do'SSi Zo'la   

• Gnuchess: un gioco di scacchi. 
home page   di   Gnuchess  

 
Figura 4-19: Momento di alta tensione in Mines.
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4.9.4  Giochi di carte 

Ecco alcuni giochi divertenti di carte disponibili dai repository. 

• Hearts ( gnome-Hearts ): Il classico gioco di cuori.
Hearts 

• Pysolfc: Oltre 1.000 solitari con una singola applicazione. 
home page   di   Pysolfc   

4.9.5  Desktop simpatico 

• XPenguins. Pinguini camminano attorno al vostro schermo. Può essere personalizzato con altri 
animali come Lemmings e orsi (bisogna eseguire il programma da una finestra di root).
home page   di   XPenguins   

• Oneko. Un gatto (neko) segue il cursore (il mouse) intorno allo schermo. Può essere personalizzato 
con un cane o altro animale.
Wikipedia: Neko

• Algodoo. Questo gioco libero presenta una pattaforma di fisica 2D dove si può giocare con la fisica 
come mai prima. La sinergia divertente tra scienza e arte è nuova, e rende il gioco educativo è 
divertente.
Home page di Algodoo

• Xteddy. Mette un simpatico orsacchiotto sul desktop. In alternativa è possibile aggiungere la propria 
immagine.
Home page   di   Xteddy   

• Tuxpaint. Un programma di disegno per i bambini di tutte le età.
home page   di   tuxpaint   

 
Figura 4-20: genio in erba al lavoro in Tuxpaint 

125

http://www.tuxpaint.org/
http://www.tuxpaint.org/
http://www.tuxpaint.org/
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://staffwww.itn.liu.se/~stegu/xteddy/index.html
http://www.algodoo.com/
https://en.wikipedia.org/wiki/Neko_(software)
http://xpenguins.seul.org/
http://xpenguins.seul.org/
http://xpenguins.seul.org/
http://pysolfc.sourceforge.net/
http://pysolfc.sourceforge.net/
http://pysolfc.sourceforge.net/
https://libregamewiki.org/Gnome_Hearts


4.9.6  Bambini 

• Tre meta-pacchetti di giochi e applicazioni didattiche distinti per tipologia di età sono disponibili in 
MX Installa Programmi, sezione education

• In aggiunta, Scratch è un linguaggio di programmazione libero con una comunità online in cui è 
possibile creare le proprie storie interattive, giochi e animazioni. In MX Installa Meta-pacchetti
h  ome page   di   Scratch  

 
Figura 4-21: Schermata di codifica per il Dance Party con Scratch 

4.9.7  Tattiche & Giochi di strategia 

• Freeciv: Un clone di Civilization © di Sid Meyer (versione 1), un gioco di strategia a più giocatori a 
turni, in cui ogni giocatore diventa il leader di una civiltà, partendo dall'età della pietra, cercando di 
arrivare all'età moderna. Lo scopo di questo gioco è quello di creare la civiltà più fiorente del mondo.
home page di Freeciv
Come giocare

• LBreakout2: LBreakout2 è un gioco arcade in stile breakout in cui si utilizza una specie di paletta per
lanciare una palla contro un muro di mattoni fino a quando tutti i mattoni vengono distrutti. Molti i 
livelli e le sorprese. Installato di default.
home page   di   Lgames   
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• LinCity: Un clone dell'originale SimCity. È necessario costruire e mantenere una città e mantenere la 
sua gente soddisfatta in modo che la popolazione cresca.
home page   di   LinCity   

• Battle for Wesnoth: un gioco di strategia a turni, di ottimo livello, con un tema di fantasia. Dovrete 
costruire il vostro esercito e lottare per riconquistare il trono.
home page di B  attle for Wesnoth  

 
Figura 4-22: prima pallina nella speranza di sfondare il muro con LBreakout 

4.9.8  Giochi di Windows 

Un certo numero di giochi di Windows possono essere giocati in MX Linux utilizzando un emulatore di 
Windows, come Cedega o DOSBox, oppure alcuni possono funzionare sotto Wine: si veda la Sezione 6.1. 

4.9.9 Servizi per giocare

Figura 4-23: Sins of a Solar Empire: Ribellione in esecuzione su Steam con Proton
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Esistono varie collezioni e servizi per l'utente che desidera giocare su MX Linux. Due dei più noti sono 
facilmente installabili con MX Installa Programmi. 

• PlayOnLinux. Un frontend grafico per Wine (Sezione 6.1) che permette agli utenti Linux di 
installare e utilizzare facilmente numerosi giochi e applicazioni progettati per funzionare con 
Microsoft® Windows®. 

homepage di PlayOnLinux.

• Steam. Una piattaforma di distribuzione digitale proprietaria per l'acquisto e la riproduzione di 
videogiochi. Permette l'installazione e l'aggiornamento automatico dei giochi. Include Proton, una 
versione modificata di Wine.

Homepage di Steam

4.10  Strumenti di Google 

4.10.1  Gmail 

Gli account di Gmail possono essere facilmente integrati in Thunderbird seguendo i suggerimenti automatici.

4.10.2  Contatti di Google

I contatti di Google possono essere collegati a Thunderbird utilizzando l'add-on gContactSync. 

Ulteriori info: home page   di   gContactSync   

4.10.3  Gcal 

Gcal può essere impostato su una scheda in Thunderbird con le add-ons Lightning e Google Calendar Tab .

Ulteriori info: home page di Lightnight 

4.10.4  Gtasks 

GTasks possono essere incluse in Thunderbird selezionando la voce Attività del calendario. 

4.10.5  Google Earth 

Il metodo più semplice per installare Google Earth è quello di utilizzare MX Installa Meta-pacchetti, dove 

GE è nella sezione "Varie". 
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Vi è anche un metodo manuale che può essere utile in alcuni casi. 

• Installate googleearth.package dai repository o direttamente dal repo di Google. 

• Aprire un terminale e digitare:

make-googleearth-package 

• Una volta completato il lavoro, diventate root e digitare:

dpkg -i *.deb googleearth 

• Verrà visualizzato un messaggio di errore sullo schermo per problemi di dipendenze. Per Correggerle 

date quest'ultimo comando (sempre come root):

apt-get -f install 

Ora finalmente Google Earth apparirà nel menu Start> Internet . 

4.10.6  Google Talk 

C'è un plugin per il browser chiamato google-talkplugin disponibile presso i repository di Google che 

permette di effettuare una chiamata vocale o una video-chiamata usando il vostro account Gmail per 

chiamare un altro utente Gmail.

4.10.7  Google Drive 

Servizio di cloud storage che permette di caricare file online per condividerli con altre persone

Esistono comodi strumenti che forniscono l'accesso locale al tuo account Gdrive:

• Un'applicazione gratuita e semplice chiamata Odrive si installa senza problemi e funziona bene.

• L'applicazione proprietaria multipiattaforma Insync permette di sincronizzare i tuoi file presenti nel 

cloud con il tuo desktop Linux desktop, in maniera semplice. Permette anche la sincronizzazione 

selettiva e l'installazione su più computer. 
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5  Gestione del Software

5.1  Introduzione 

5.1.1  Metodi 

MX Linux offre due metodi complementari di gestione del software:
• MX Installa Programmi (MX Package Installer) permette l'installazione/rimozione con un solo clic di 

app selezionate dai repository standard della distribuzione in quanto utili e famose, ma permette 
anche di accedere ad app che non sono disponibili in questi repository in quanto si tratta di software 
presente nei repo di MX Test, Debian Backports e Flatpaks. Vedere la Sezione 3.2.11.

• Synaptic Package Manager, uno strumento grafico completo che permette un'intera gamma di 
operazioni di gestione dei pacchetti Debian.

MX Installa Programmi ha una serie di vantaggi rispetto a Synaptic:
• È molto più veloce!
• La scheda Applicazioni popolari è limitata ai pacchetti più utilizzati, quindi sono più facili da trovare.
• Installa alcuni pacchetti che altrimenti sarebbero complicati da installare correttamente (ad esempio, 

Wine).
Comprende nella stessa applicazione anche altre fonti oltre a Debian Stable e al Repo MX stable:

• Il nostro MX Test Repo con pacchetti più recenti di quelli che Synaptic ha di default.
• Debian Backport.
• Include anche i flatpaks, non disponibili in Synaptic.

Synaptic, dal lato suo, ha questi punti di forza rispetto a MX Installa Programmi:
• Permette di impostare un gran numero di filtri avanzati, come sezioni (categorie), stato, ecc.
• Offre informazioni dettagliate sui specifici pacchetti.
• Rende molto facile aggiungere nuovi repository.

Questa sezione 5 si concentra Synaptic, che è il metodo che si consiglia ai principianti per gestire i pacchetti 
software quando hanno bisogno di andare oltre le funzioni di MX Installa Programmi. Analizzerà anche altri 
metodi disponibili che potrebbero essere indicati in determinate situazioni.

5.1.2  Pacchetti 

La gestione del software in MX avviene attraverso il sistema: A  vanced Package Tool (APT)   che opera dietro 
le quinte. Il software viene fornito sotto forma di  pacchetto: un discreto insieme di dati non eseguibili dove 
si trovano le istruzioni per l'installazione che il gestore di pacchetti dovrà seguire. I pacchetti sono 
memorizzati su server chiamati repository (repo), e possono essere visionati, scaricati e installati tramite uno
speciale software client chiamato gestore di pacchetti. Il gestore di pacchetti raccomandato per MX è 
Synaptic, ma è possibile usare apt da riga di comando per chi preferisce usare il terminale. Per i file *.deb che
avremo ottenuto in maniera diversa rispetto a scaricarli dai repository attraverso Apt-Synaptic (magari 
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scaricati da qualche sito web o copiati dai Cd di qualche rivista) si potrà utilizzare l'utility grafica Gdebi che 
viene avviata con un semplice clic sul file del pacchetto.
La maggior parte dei pacchetti hanno una o più dipendenze, il che significa che per funzionare hanno 
bisogno di uno o più pacchetti di supporto. Il sistema APT è progettato per gestire automaticamente le 
dipendenze per voi; In altre parole, quando si tenta di installare un pacchetto le cui dipendenze non sono già 
installate, il gestore di pacchetti APT contrassegna automaticamente anche le dipendenze per l'installazione. 
Può comunque capitare (raramente) che queste dipendenze non possano essere soddisfatte, impedendo quindi
l'installazione di un pacchetto. 

5.2  Repository (Repo)
I repository APT (repo) sono molto più che semplici siti web con software scaricabile. I pacchetti su questi 

siti-archivi, sono appositamente organizzati e indicizzati per essere accessibili tramite un gestore di pacchetti,

piuttosto che navigarci direttamente. 

ATTENZIONE: non aggiungere altri repository a caso su MX Linux! Ciò è particolarmente vero 

per Debian Sid, che è molto probabile che interrompa l'installazione dei pacchetti senza possibilità di 

riparazione.

5.2.1  Repos standard 

MX Linux viene fornito con una serie di repository abilitati che garantiscono sicurezza e un'ampia scelta di 

software. Se siete novizi di MX Linux (e soprattutto se lo siete di Linux), si raccomanda, in generale, in un 

primo momento di utilizzare i repository di default. 

Per motivi di sicurezza, questi archivi sono firmati digitalmente, il che significa che i pacchetti sono 

autenticati con una chiave di crittografia per assicurarsi che siano autentici. Se si installano pacchetti da 

repository non-Debian senza chiave, si otterrà un messaggio di avviso che non possono essere autenticati. Per

sbarazzarsi di questo avviso e assicurarsi che le installazioni siano sicure, è necessario installare le chiavi 

mancanti utilizzando MX Fix GPG keys (MX Cerca Chiavi GPG) presente nei MX Tools. 

I repository sono facilmente aggiunti, abilitati/disabilitati, rimossi o modificati tramite Synaptic, ma possono 

anche essere modificati manualmente modificando i file in /etc/apt/ in un terminale root. In Synaptic, 

selezionare Impostazioni> Repository, quindi fare clic sul pulsante Nuovo e aggiungere le informazioni. Le 

informazioni del repository vengono espresse in una singola linea, in questo modo: 

deb http://mxrepo.com/mx/testrepo/ stretch test 

Fate attenzione a inserire correttamente gli spazi che separano in quattro parti le informazioni in questa riga. 

Queste 4 parti che vanno a costituire la riga informativa del repository vengono definite nei 4 campi presenti 

nella parte inferiore della finestra che si apre selezionando in Synaptic Impostazioni> Repository

131



Figura 5-1: Repository con il repo test di MX evidenziato 
Alcuni repository portano etichette speciali in funzione al tipo di pacchetti che contengono: 

• contrib, dipendono o sono pacchetti-accessorio dei pacchetti non-free. 
• non-free, non soddisfano le Debian Free Software Guidelines (DFSG). 
• security, contengono solo pacchetti di aggiornamenti relativi alla sicurezza. 
• backport, contengono pacchetti provenienti dai repository delle versioni più aggiornate di Debian che

sono stati ricompilati per essere compatibili con Debian Stable (la versione di Debian su cui è 
costruita MX Linux) per mantenere il vostro sistema operativo aggiornato. 

• MX, contengono i pacchetti speciali e specifici della distribuzione che portano MX a essere quella 
che è. 

L'attuale elenco standard dei repository MX, è conservato nel Wiki M  X/antiX   . 

5.2.2  Community Repos

MX Linux ha i propri Repository realizzati con i pacchetti che i nostri compilatori costruiscono e 
mantengono. Questi pacchetti sono distinti dai pacchetti ufficiali di MX provenienti da Debian Stable, essi 
sono basati su pacchetti provenienti da fonti diverse:

• Debian backports, versioni di Debian in fase di sviluppo (test o addirittura sperimentale) a cui è stato 
fatto il backport alla versione stable

• antiX
• Progetti Indipendenti
• GitHub

I Repos comunitari sono fondamentali per MX Linux, in quanto consentono ad un sistema operativo basato 
su Debian Stable di rimanere al passo degli importanti sviluppi del software. 

132

http://www.mepiscommunity.org/wiki/system/repos-mx-15
http://www.mepiscommunity.org/wiki/system/repos-mx-15


Il repo MX Test, se usato in aggiunta al repo MX Main, conta di ottenere un feedback dagli utenti prima che i
nuovi pacchetti vengano spostati su Main. Il modo più semplice per installare pacchetti presenti nel repo MX 
Test è con MX Installa Pacchetti (Sezione 3.2), poiché gestisce molti passaggi automaticamente.

Per saperne di più su ciò che è disponibile, chi sono i compilatori, e come partecipare, vedi Progetto 
Packaging M  X Com  m  unit  y  .   

5.2.3  Repository dedicati 

In aggiunta ai repository generali quali: quelli di Debian, quelli specifici di MX e quelli comunitari, esistono 
anche un certo numero di repository associati ad una singola applicazione. Aggiungendone uno, direttamente 
o tramite Synaptic, si potranno poi ricevere gli aggiornamenti futuri per quel determinato software. Alcuni 
sono già precaricati, ma non abilitati, altri li potrete aggiungere voi. 
Ecco un classico esempio (VirtualBox): 
deb http://download.virtualbox.org/virtualbox/debian/stable contrib
I nuovi utenti provenienti da Ubuntu o da una derivata spesso chiedono informazioni sui repository PPA; 
Ubuntu è piuttosto lontana da Debian standard, quindi tali repository devono essere trattati con cautela. 
Consulta il Wiki di MX/antiX.

5.2.4  Repository di sviluppo 

Esiste una categoria di repository che consente di acquisire il più recente (e quindi meno stabile) sviluppo di 
un'applicazione. Ciò si può ottenere attraverso il portale Git che può essere consultato dall'utente finale per 
rimanere aggiornato sullo sviluppo mediante il controllo della versione. L'utente può scaricare e controllare 
su un computer locale una copia del codice sorgente dell'applicazione che gli interessa. Il portale GitHub è un
metodo conveniente per la gestione dei progetti che utilizzano Git e MX Linux mantiene la maggior parte del
suo codice nel proprio archivio GitHub.
Maggiori info: Wikipedia: repository software 

5.2.5  Mirrors 

I repository di MX Linux sia per i pacchetti software che per le ISO sono archiviati in siti ospitati su server 
diversi in tutto il mondo, lo stesso vale per i repository Debian. Questi siti (detti mirrors, cioè specchi perché 
riproducono esattamente gli stessi contenuti di un sito originale) permettono di fornire fonti multiple delle 
stesse informazioni, e hanno la funzione di ridurre il tempo di download, migliorare l'affidabilità, e di fornire 
una certa resilienza in caso di guasto del server. Durante l'installazione, il server-mirror da cui scaricherete il 
software molto probabilmente verrà selezionato automaticamente in base alla vostra posizione geografica e 
alla lingua. Ma l'utente può avere motivo per preferirne uno diverso: 

• In alcuni casi l'assegnazione automatica in fase di installazione può essere sbagliata.
• L'utente può cambiare la residenza.
• Potrebbe rendersi disponibile un nuovo mirror che potrebbe essere più vicino, più veloce o più 

affidabile.
• Un mirror esistente potrebbe cambiare il suo URL.
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• Potrebbe non essere più on-line.

MX Repo Manager (Sezione 3.2) rende facile cambiare i mirrors che usate per scaricare il software, 

permettendovi di scegliere quello che funziona meglio per voi. 

Il modo più semplice per trovarlo è di usare il pulsante che seleziona il mirror più veloce per la vostra 

posizione.

5.3  Synaptic 
La seguente sezione cerca di fornire una panoramica aggiornata sull'uso di Synaptic.
Si tratta di uno strumento grafico che consente di installare, rimuovere, aggiornare o ottenere informazioni su
tutti i pacchetti software archiviati nei repository. Si fa presente che verrà richiesta la password di root e, 
ovviamente, è necessario essere connessi ad Internet. 

5.3.1  Installazione e rimozione di pacchetti 

Installazione 
Ecco i passaggi fondamentali per l'installazione del software in Synaptic: 

• Fare clic su Start> Sistema> Gestore pacchetti Synaptic , fornendo la password di root, se viene 
richiesta. 

• Premete il pulsante Aggiorna. Questo pulsante fa sì che Synaptic contatti i server dei repository online
e scarichi un nuovo file-indice con informazioni riguardanti i pacchetti che sono disponibili, in che 
versioni, e quali altri pacchetti (pacchetti di dipendenze) sono necessari perché possano essere 
installati. Se si riceve un messaggio che non è stato possibile contattare qualcuno dei repository, 
attendere un minuto e poi riprovare. 

• Se si conosce già il nome del pacchetto che si sta cercando, basta cliccare sul riquadro a destra e 
iniziare a digitare; Synaptic farà una ricerca incrementale mentre si digita. 

• Se non si conosce il nome del pacchetto, utilizzare il pulsante “cerca” in alto a destra per individuare 
il software in base al nome o parole chiave. Questo è uno dei più grandi vantaggi di Synaptic rispetto 
ad altri metodi. 

• In alternativa, usate uno dei pulsanti filtro nell'angolo in basso a sinistra: 
• Sezioni fornisce sottozone, come editor, giochi e divertimenti, utilità, ecc. Si vedrà una 

descrizione di ciascun pacchetto nel riquadro inferiore, ed è possibile utilizzare le diverse 
schede per reperire ulteriori informazioni. 

• Stato gruppi di pacchetti suddivisi in base al fatto che siano installati o meno, da aggiornare, 
ecc. 

• Origine mostrerà i pacchetti di ciascun specifico repository. 
• Filtri personalizzati viene data la possibilità di utilizzare filtri di ricerca con varie opzioni. 
• Cerca tra i risultati mostrerà un elenco delle ricerche precedenti della sessione in cui 

Synaptic si trova. 
• Cliccare sul quadratino-casella vuota posta alla sinistra del pacchetto che si desidera installare, quindi 

selezionare “Installa” dal menù che compare, la casellina verrà marcata mostrando al suo interno un 
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visto. Se il pacchetto ha delle dipendenze, verrà mostrata una notifica e verranno automaticamente 
contrassegnati per l'installazione anche questi ulteriori pacchetti. 

• Alcuni pacchetti sono accompagnati da pacchetti "Suggeriti"e "Raccomandati" che possono essere 
visualizzati tramite pulsante destro del mouse sul nome del pacchetto . Si tratta di pacchetti aggiuntivi
che aggiungono funzionalità al pacchetto selezionato, ed è una buona idea prenderli in considerazione
verificandone caratteristiche e funzionalità per decidere se, e cosa eventualmente installare.

• Cliccare su Applica per avviare l'installazione. Se dovesse presentarsi un messaggio di questo tipo: 
“Si stanno per installare pacchetti di software che non possono essere autenticati!” non 
preoccupatevi, può tranquillamente essere ignorato.

• Ci possono essere ulteriori passaggi da eseguire: basta prestare attenzione ai messaggi e seguire le 
istruzioni che li accompagnano fino a quando l'installazione viene completata. 

Figura 5-2: Controllo dei pacchetti raccomandati con l'installazione di un pacchetto. 

Rimozione 
La rimozione, con Synaptic, del software dal vostro sistema, si presenta altrettanto semplice quanto 
l'installazione, ma c'è di più di quel che appare: 

• Per rimuovere un pacchetto, è sufficiente fare clic sulla stessa casellina usata per l’installazione e 
selezionare Rimuovi o Rimuovi completamente. 

• La rimozione disinstalla il software, ma lascia i file di configurazione di sistema nel caso in 
cui si desideri mantenere le impostazioni. 
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• La rimozione completa rimuove sia il software sia i file di configurazione di quel software, 
tuttavia i file di configurazione strettamente personali relativi al pacchetto non verranno 
rimossi. E' possibile in Synaptic verificare la presenza di file di configurazione residua 
controllando categoria “Non installato (configurazione residua)” che troviamo in “Stato” nel 
pannello laterale destro. 

• Quando sono presenti altri programmi che dipendono dal pacchetto che deve essere rimosso,  
dovranno essere rimossi anche i pacchetti di questi altri programmi. Questi programmi infatti non 
funzionerebbero una volta eliminato il pacchetto che fungeva da dipendenza. Questo di solito accade 
quando si rimuovono le librerie di un software, o applicazioni a riga di comando che servono come 
back-end (come motore sottostante un applicazione grafica) ad altre applicazioni. In questi casi 
meglio non rimuovere quel pacchetto, che fungeva da dipendenza di più programmi, assicuratevi 
quindi di leggere con attenzione il riepilogo che Synaptic fornisce, con l'elenco dei pacchetti che 
verranno installati e di quelli che verranno eliminati, prima di fare clic su OK. 

• La rimozione di applicazioni di grandi dimensioni che sono costituite da molti pacchetti può portare a 
complicazioni. Molte volte questi pacchetti sono installati utilizzando un meta-pacchetto, che è un 
pacchetto vuoto che contiene un elenco di pacchetti e serve semplicemente ad installare tutto l'insieme
di pacchetti necessari per quell'applicazione. Il modo migliore per rimuovere un pacchetto complicato
come questo è di ispezionare la lista delle dipendenze del meta-pacchetto, e rimuovere i pacchetti 
elencati. Fate attenzione, però,  a non disinstallare un pacchetto che è una dipendenza anche di un'altra
applicazione che invece si desidera conservare! Nel riepilogo dei pacchetti da eliminare si potrà 
vedere facilmente se oltre al pacchetto del programma che volete disinstallare e ai relativi pacchetti di
supporto verranno elencati anche pacchetti di altre applicazioni che volete mantenere. Non date l'OK 
e ripetete la procedura, un pacchetto per volta, eliminando solo quelli che non danno problemi.

• Potreste scoprire che nella categoria di stato “Auto removibile” s'accumulano nel tempo diversi 
pacchetti. Questi sono stati installati da altri pacchetti di programmi che poi sono stati eliminati, e non
sono più necessari. E' quindi possibile, e consigliabile, cliccare su questa categoria di stato, 
evidenziare tutti i pacchetti nel riquadro di destra, e poi cliccarci sopra per rimuoverli. Assicurati 
comunque di esaminare attentamente l'elenco e controlla nuovamente anche quando si presenta la 
finestra di riepilogo, prima di dare la conferma perché a volte potresti scoprire che le dipendenze 
elencate per la rimozione includono qualche pacchetto che in realtà desideri conservare. Usa:
apt -s autoremove

per eseguire una simulazione (ottenuta con l'opzione -s) se non sei sicuro.
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Figura 5-3: Tutto pronto per cancellare i pacchetti auto rimuovibili. 

5.3.2  Aggiornamento e downgrade 

Synaptic vi permette di tenere rapidamente e comodamente il vostro sistema aggiornato. 
Aggiornamento - Upgrade
La disponibilità di aggiornamenti viene segnalata da un cambiamento dell’icona di MX Aggiornamenti  
presente nell'area di notifica del pannello, infatti l’icona a forma di scatola diventerà verde

Ci sono due metodi alternativi di procedere quando appare questa freccia. 

• Cliccare sul pulsante sinistro del mouse sull'icona di MX Aggiornamenti. Questo è il metodo più 
veloce perché non è necessario attendere che il software si avvii, carichi la lista pacchetti, ecc. Viene 
visualizzata una finestra di terminale con i pacchetti da aggiornare; esaminateli attentamente, quindi 
fare clic su OK per completare il processo. 

• Cliccare col destro sull'icona di MX Aggiornamenti se preferite aprire Synaptic.
• Fate clic sul pulsante “Seleziona aggiornamenti” sotto la barra dei menu per selezionare tutti i 

pacchetti disponibili per l'aggiornamento, oppure selezionate la sezione “Stato” nel pannello di
sinistra in basso, e poi cliccate sul campo “installato (aggiornabile)” in alto, per rivedere i 
pacchetti o per selezionare gli aggiornamenti individualmente. 

• Fate clic su Applica per avviare l'aggiornamento, ignorando l'eventuale messaggio di fare 
attenzione (warning). All'inizio del processo di installazione, si ha la possibilità di guardare i 
dettagli del processo in un terminale all'interno di Synaptic. 

• Con l'aggiornamento di certi pacchetti, è possibile che compaia una finestra di dialogo dove viene 
chiesto una conferma a procedere in un determinato modo, o di inserire informazioni di 
configurazione, oppure decidere se sovrascrivere o meno un file di configurazione che viene fornito 
con differenze rispetto alla configurazione presente. Prestate attenzione qui, e seguite le istruzioni fino
al termine dell'aggiornamento. 

Downgrade (Retrocessione) 
A volte si può decidere di ripristinare la versione precedente di un'applicazione, ad esempio a causa di 
problemi sorti con la nuova versione aggiornata. Questo è facile da fare in Synaptic: 
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1. Aprite Synaptic, fornite la password di root, e fate clic sul pulsante “Aggiorna”. 
2. Cliccate su Installato, nel pannello a sinistra, poi nel pannello di destra, trovate ed evidenziate il 

pacchetto su cui desiderate effettuare un downgrade 
3. Sulla barra dei menu in alto , fate clic su Pacchetto> Forza Versione... 
4. Nel menu a tendina che compare, scegliete tra le versioni disponibili, se ce ne sono. 
5. Fate clic su Forza versione, quindi installate nel modo consueto. 

6. Per evitare che la versione più indietro venga immediatamente aggiornata, è necessario bloccarla 
andando sulla barra dei menu in alto e poi Pacchetto> Blocca versione come vedremo 
dettagliatamente nel prossimo punto.

 
Figura 5-4: Usando Forza Versione per declassare un pacchetto 

Bloccaggio 
A volte può essere utile bloccare un'applicazione a una versione specifica per evitare che venga aggiornata al 
fine di evitare problemi con quelle più recenti. Questo è facile da fare: 

1. Aprite Synaptic, fornite la password di root, e fate clic su Aggiorna. 
2. Cliccate su Installato nel pannello a sinistra, poi nel pannello a destra trovate ed evidenziate il 

pacchetto che desiderate bloccare. 
3. Sulla barra dei menu, fare clic su Pacchetto> Blocca versione ... 
4. Synaptic metterà in evidenza il pacchetto in rosso e aggiungerà l'icona di un lucchetto sulla casellina 

all'inizio della riga del pacchetto. 
5. Per sbloccare, evidenziare ancora una volta il pacchetto e fare clic su Pacchetto> Blocca versione (che

presenterà un segno di spunta). 

6. Nota. Bloccare la versione del pacchetto tramite Synaptic non impedisce l'aggiornamento del 
pacchetto se si utilizza la riga di comando.

5.4  Risoluzione dei problemi 
Synaptic è molto affidabile, ma a volte si può ottenere un messaggio di errore. Una disquisizione completa su

questi messaggi può essere trovata nel Wiki MX/antiX, qui noi ne menzioniamo solo un paio dei più comuni.
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• Può capitare che si presenti un messaggio indicante che alcuni repository non sono riusciti a scaricare 

le informazioni proprie del repository. Questo di solito è un evento transitorio, e dovete 

semplicemente aspettare e poi riprovare cliccando sul pulsante, in alto, “Aggiorna” (corrisponde al 

comando apt update) o si può usare MX Repo Manger per cambiare il server di quel repository.

• Se con l'installazione di un pacchetto si viene avvisati che altro software (altri pacchetti) che si 

desidera conservare verrà rimosso, fare clic su Annulla per annullare l'operazione.

• Può accadere che con l'inserimento di un nuovo repository venga visualizzato un messaggio di errore 

dopo l'aggiornamento delle informazioni dei pacchetti (update) che riporterà qualcosa come: 

“Warning, Errore GPG: [URL del nuovo repository] Le seguenti firme non sono state verificate.” 

Questo messaggio viene visualizzato perché apt-get controlla l'autenticazione dei pacchetti al fine di 

migliorare la sicurezza, e la chiave non è presente nei pacchetti del nuovo repository. Per risolvere 

questo problema, fate clic su Menu-Start> Sistema> MX Fix GPG Keys (MX trova chiavi GPG) e 

seguite le istruzioni. Se non viene trovata alcuna chiave, chiedete nel Forum.

• Di tanto in tanto, potrebbe capitare di non riuscire a installare i pacchetti perché i loro script di 

installazione non superano uno o più controlli di sicurezza; per esempio, un pacchetto potrebbe 

tentare di sovrascrivere un file che fa parte di un altro pacchetto, o richiedere il downgrade di un altro 

pacchetto da cui dipende. Se l'installazione di un pacchetto o l'aggiornamento si è bloccato su uno di 

questi errori, si dice che quel pacchetto è “danneggiato”. Per risolvere questo problema, fate clic sulla 

voce “Filtri personalizzati” nel pannello di sinistra in basso e poi su “Danneggiato” in alto. Prima 

evidenziate il pacchetto e poi cercate di risolvere il problema facendo clic su Modifica> Ripara i 

pacchetti danneggiati. Se non riuscite ad ottenere la correzione, cliccate col destro sul pacchetto per 

deselezionarlo o disinstallarlo. 

• Durante l'installazione o la disinstallazione, a volte appaiono messaggi riguardanti il processo con 

richieste di scegliere il modo di procedere:

• Disinstallare? Di tanto in tanto, eventuali conflitti delle dipendenze dei pacchetti possono 

portare il sistema APT a richiedere la disinstallazione di un gran numero di pacchetti 

importanti per poter installare qualche altro pacchetto. Questo è raro, con la configurazione di 

default, ma diventa sempre più probabile quando si aggiungono repository non supportati. 

Stare molto attenti quando si installa un pacchetto che richiederebbe che altri vengano 

rimossi! Se un gran numero di pacchetti stanno per essere rimossi, si può decidere di cercare 

un altro metodo di installazione di quell'applicazione. 
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• Mantenere? Durante l'aggiornamento, a volte si viene informati che un nuovo file di 

configurazione è disponibile per un certo pacchetto, e vi verrà chiesto se si desidera installare 

la nuova versione o mantenere la versione corrente.

• Se il pacchetto in questione proviene da un repository MX, si raccomanda di scegliere 

"installa la versione del manutentore" 

• In caso contrario, rispondere "mantieni la versione attuale" (N), Che è anche la scelta di

default. 

5.5  Altri metodi 

5.5.1  Aptitude 

Aptitude è un gestore di pacchetti che può essere usato al posto di apt o Synaptic. E' disponibile nei 

repository, ed è particolarmente utile quando insorgono problemi con le dipendenze. Può essere eseguito da 

riga di comando (CLI) o attraverso una interfaccia grafica (GUI) minimale. 

Figura 5-5: Schermata iniziale di Aptitude (GUI), che mostra la risoluzione di un problema di 
dipendenza. 
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Per i dettagli su questa applicazione, vedere il Wiki di MX/antiX. 

5.5.2  pacchetti deb 

I pacchetti software installati tramite Synaptic (e APT che ne costituisce il “motore”) sono in un formato 

chiamato deb (abbreviazione di Debian, la distribuzione Linux che ha ideato APT). È possibile installare 

manualmente i pacchetti deb scaricati, utilizzando lo strumento grafico Gdebi o lo strumento da riga di 

comando dpkg . Si tratta di strumenti semplici per installare pacchetti deb locali. 

NOTA: se le dipendenze non possono essere soddisfatte, si riceverà un avviso e il programma si fermerà. 

Figura 5-6: Gdebi pronto per l'installazione. 

Installazione dei file deb con Gdebi 

1. Raggiungete il pacchetto deb che desiderate installare (di solito si trova nella cartella “Scaricati”) e 

fate clic su di esso. Gdebi si aprirà la finestra di installazione. 

2. Fate clic su Installa. 

3. Inserite la password di root quando richiesta. 

4. Gdebi tenterà di installare il pacchetto, e riferirà del risultato. 

Installazione di file *.deb con dpkg 

1. Raggiungete la cartella che contiene il pacchetto deb che desiderate installare. 
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2. Fate clic su uno spazio vuoto di quella cartella per aprire un terminale e diventate root. In alternativa, 
cliccate sulla freccia per salire di un livello poi cliccate col destro sulla cartella contenente il 
pacchetto deb e scegliete Apri il terminale qui poi diventate root.

3. Installate il pacchetto con il comando (sostituendo il nome del pacchetto vero, ovviamente): 
dpkg -i nomepacchetto.deb

4. Se si devono installare più pacchetti presenti nella stessa directory, allo stesso tempo, (per esempio 
installando manualmente Libreoffice) si può fare tutto in una volta usando: 
dpkg -i *.deb

NOTA: In un comando di shell, l'asterisco nell'argomento è una wild card (un jolly). In questo caso 
farà sì che il programma vada ad applicare il comando a qualsiasi file il cui nome termina con .deb. 

5. Se vi sono dipendenze richieste che non sono già installate sul vostro sistema, si otterrà un errore di 
dipendenze non soddisfatte, dato che dpkg non le scarica automaticamente.
Per correggere questi errori e completare l'installazione, eseguite questo comando per forzare 
l’installazione:
apt -f install

6. Apt tenterà di porre rimedio alla situazione installando le dipendenze necessarie (se sono disponibili 
nei repository), o rimuovendo il file .deb (se non è possibile installare le dipendenze). 
NOTA: il comando usato nel passaggio 5 riflette il cambiamento avvenuto con il passaggio dei 
comandi di installazione dal vecchio apt-get all’attuale apt

5.5.3  Pacchetti Autosufficienti 

Appimages, flatpaks e snap sono pacchetti autosufficienti (contengono già al loro interno le librerie e le altre 

dipendenze che gli servono) che non devono essere installati nella solita modalità.

• Appimages  : è sufficiente scaricare il pacchetto, spostarlo su /opt (consigliato) e rendere eseguibile 

cliccandoci sopra col destro, e sul menù a cascata andare in Proprietà > Permessi.

• Flatpaks  : Usate MX Installa Programmi, scheda flatpak, per ottenere app. da flathub.

• Snaps  : Meno affidabile su MX Linux perché di default non usa systemd. Soluzione e dettagli nel link 

al Wiki qui sotto.

Uno dei loro grandi vantaggi è che ogni software aggiuntivo di cui hanno bisogno è incluso, e quindi non 

avrà un impatto negativo sul software già installato. Ma va anche detto che sono molto più grandi dei 

tradizionali pacchetti installati. Installandone molti, il sistema si gonfia.

AIUTO: Wiki di   MX/antiX  

5.5.4  Metodi CLI 

È ugualmente possibile utilizzare la riga di comando per installare, rimuovere, aggiornare, cambiare i 

repository e in generale per gestire i pacchetti. Invece di lanciare Synaptic per svolgere le operazioni più 

comuni, per esempio, molti utenti preferiscono aprire un terminale, diventare root e utilizzare uno di questi 

comandi (sono richiesti i privilegi di amministratore). 
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Tabella 5: comandi comuni per la gestione dei pacchetti 

Comando Azione 

apt install nomepacchetto Installare un determinato pacchetto 

apt remove nomepacchetto Rimuovere un determinato pacchetto (senza rimozione della 
configurazione dei dati in /home)

apt purge nomepacchetto Rimuovere completamente un determinato pacchetto 

apt autoremove Ripulire i pacchetti rimanenti dopo la rimozione (dipendenze non più 
necessarie)

apt update Aggiornare la lista dei pacchetti presenti nei repository 

apt upgrade Installare tutti gli aggiornamenti disponibili 

apt-get dist-upgrade gestisce in modo intelligente le dipendenze che cambiano con le 
nuove versioni dei pacchetti 

5.5.5  Altri metodi di installazione 

Prima o poi qualche software che si desidera installare non sarà disponibile nei repository e potrebbe rendersi
necessario utilizzare altri metodi d'installazione. Questi metodi includono: 

• Blobs. A volte ciò che si desidera installare non è il classico pacchetto .deb opensource installabile 
con i metodi visti in precedenza ma una raccolta di dati già compilati forniti in forma di dati binari 
archiviati come entità singola "blob" o precompilata. Tali blob di norma sono closed-source ed in 
genere vanno ad allocarsi nella directory /opt. Esempi comuni includono componenti aggiuntivi 
(addons) di Firefox, Thunderbird e LibreOffice. 
Per esempio, per installare la versione più recente di LibreOffice:
◦ Cercate sul web "libreoffice download ultima versione". Cliccate su :
https://www.libreoffice.org/download/download/
◦ Selezionate la versione desiderata, sulla base del tipo di sistema operativo (es. Linux x64) e il tipo di
formato del pacchetto (deb).
◦ Cliccate sul pulsante di download; dato che lo uso sempre, faccio una piccola donazione. 
◦ Una volta completato il download, andate nella cartella Scaricati e cliccate con il destro sull'archivio
LibreOffice_6.2.3 > Estrai qui.
◦ Cliccate sulla cartella estratta, quindi cliccate con il destro sulla cartella DEBS > Apri terminale qui.
◦ Inserite questo comando
sudo dpkg -i *.deb
◦ Cosi facendo si installerà e sarà disponibile nella categoria Ufficio del menu-start.
◦ Probabilmente vorrete rimuovere la vecchia versione. La cosa si può fare usando Synaptic per 

selezionare e rimuovere libreoffice-core, questo pacchetto porterà via con sé anche gli altri pacchetti. 

Assicuratevi di non rimuovere quello nuovo!

◦ Create un launcher aprendo il menu Start e cliccando con il destro sulla voce LibreOffice > 

Aggiungi al Pannello (oppure: Aggiungi al Desktop).
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• Pacchetti RPM: Alcune distribuzioni di Linux utilizzano il sistema di packaging RPM. Pacchetti RPM

sono simili ai pacchetti deb in molti modi, e vi è un programma a riga di comando disponibile in MX 

Linux per convertire i pacchetti RPM in DEB chiamato alien . Non viene installato di default in MX 

Linux, ma è disponibile nei repository. Dopo averlo installato sul proprio sistema, è possibile 

utilizzarlo per installare un pacchetto rpm con questo comando (come root): alien 

nomepacchetto.rpm -i . In questo modo verrà inserito un file deb con lo stesso nome nella stessa 

posizione del file rpm, che si potrà quindi installare nei modi descritti sopra. Per informazioni più 

dettagliate su alien, guardatevi la versione di wikipedia della sua pagina man. Vedi link in fondo a 

questa pagina. 

• Codice sorgente (sorgenti): Qualsiasi programma open-source può essere compilato dal codice 

sorgente originale del programmatore, se non vi è nessun'altra opzione. In circostanze ideali, questa 

dovrebbe essere un'operazione piuttosto semplice, ma a volte si può incorrere in errori che richiedono 

diverse abilità per superarli. Il “sorgente” viene di solito distribuito come tarball (tar.gz o tar.bz2 file). 

La cosa più conveniente è quella di fare una richiesta sul forum per quel pacchetto oppure seguite il 

link per un tutorial sulla compilazione dei programmi. 

• Miscellanea: molti sviluppatori di software forniscono i pacchetti software, che di solito vengono 

distribuiti come file tarball o zip, secondo un loro modo personale. Essi possono contenere script di 

installazione, o essere file binari pronti per l'installazione, o contenere degli installer di binari simili ai

programmi di Windows setup.exe. In Linux, l’installer di questi programmi spesso finisce in .bin. 

Google Earth, per esempio, è spesso distribuito in questo modo. In caso di dubbio, consultate le 

istruzioni di installazione fornite con il software. 

5.5.6  Link 

• Wiky M  X/antiX: errori s  y  naptic  

• Wiki M  X/antiX: Installazione del software  

• Wiki M  X/antiX: Compilazione  

• Gdebi  

• St  rumenti di gestione dei pacchetti Debian  

• Guida Debian APT  

• Guida su   Alien  
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6  Utilizzo avanzato 

6.1  Programmi Windows sotto MX Linux
Ci sono un certo numero di applicazioni, sia open-source che commerciali, che permettono alle applicazioni 

di Windows di funzionare sotto MX Linux. Sono chiamati emulatori, nel senso che replicano le funzioni di 

Windows su una piattaforma Linux. Molte applicazioni di MS Office, giochi e altri programmi possono 

essere eseguiti utilizzando un emulatore con vari gradi di successo, variabile da una velocità e funzionalità 

paragonabili a quelle originali fino ad arrivare a funzionalità e prestazioni di livello base. 

6.1.1  Open-source 

Wine, per MX Linux, è il principale emulatore open-source di Windows. Esso fornisce una base di 

compatibilità per l'esecuzione dei programmi Windows, ma non richiede Microsoft Windows per eseguire le 

applicazioni. Più facilmente installabile attraverso MX Installa Programmi (MX Package Installer) cercando 

nella sezione Misc; se si preferisce installarlo con Synaptic, selezionare "winehq-staging" per ottenere tutti i 

pacchetti che compongono ed arricchiscono wine. Le versioni aggiornate di wine vengono rapidamente 

confezionate dai compilatori dei repository “community” e messi a disposizione degli utenti, utilizzando la 

versione più recente proveniente dai Test repo. 

NOTA: se si vuole usare Wine mentre si sta eseguendo il sistema operativo con una Live, è necessario 

disporre della persistenza della home (Sezione 6.6.3).

• homepage W  in  e   
• Wiki M  X/antiX:   W  i  ne  

DOSBox crea un ambiente simile a DOS usato per l'esecuzione di programmi MS-DOS, in particolare giochi
per computer. 

• homepage DOSBox   
• DOSBox Wiki   

DOSEMU è un software disponibile presso i repository che permette di avviare DOS in una macchina 
virtuale, rendendo possibile l'esecuzione di Windows 3.1, Word Perfect per DOS, DOOM, etc. 

• homepage D  OSEMU   
• Wiki M  X/antiX: DOSEMU  
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Figura 6-1: Photoshop 5.5 in esecuzione sotto Wine 

6.1.2  Commerciale 

CrossOver Office consente di installare su Linux molte applicazioni di produttività, plugin e giochi di 
Windows popolari, senza bisogno di una licenza del sistema operativo Microsoft. Supporta particolarmente 
bene Microsoft Word, Excel e PowerPoint (fino al 2003). 

• CrossOver Linux Home   
• Wikipedia: Crossover  
• compatibilità delle applicazioni   

Links

• Wikipedia: Emulatore  
• emulatori D  OS  

6.2  Le macchine virtuali 
Le applicazioni di macchine virtuali sono una classe di programmi che simulano un computer virtuale, 
consentendo di eseguire un qualsiasi sistema operativo sulla macchina virtuale. E' utile per i test, e per 
l'esecuzione di applicazioni non native, fornendo agli utenti la sensazione di avere una partizione 
appositamente dedicata a quel sistema operativo. Molti utenti di MX Linux fanno uso di questi software di 
virtualizzazione della macchina per l'esecuzione, “in una finestra”, di Microsoft Windows in maniera da poter
disporre del software scritto per di Windows sul proprio desktop senza dover interrompere l'attività della 
nostra sessione Linux. Inoltre è usato per fare dei test evitando l'installazione su una partizione appositamente
dedicata. 
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6.2.1  Impostazioni

 Virtual Box: impostare una cartella condivisa (14,4)
Esistono un certo numero di applicazioni software di macchina virtuale per Linux, sia open source che 

proprietarie. MX rende particolarmente facile da usare VirtualBox (VB), quindi ci concentreremo su questo 

programma. Per i dettagli e gli sviluppi più recenti, vedere la sezione dei link qui sotto. Ecco una panoramica

dei passi fondamentali per impostare ed eseguire VirtualBox: 

• Installazione . La via migliore per l’installazione è quella di usare MX Installa Programmi dove VB 

appare nella sezione Misc. Ciò determinerà l'abilitazione dei VirtualBox repository, e scaricherà e 

installerà l'ultima versione di VirtualBox. Il repository sarà lasciato abilitato, consentendo 

aggiornamenti automatici tramite MX Aggiornamenti. 

• 64bit. VB richiede il supporto dell'hardware alla virtualizzazione per eseguire un sistema operativo 

ospite a 64 bit, le cui impostazioni (se esistono) si trovano nel BIOS, quindi in alcuni casi sarà più 

semplice anche su una macchina a 64 bit virtualizzare un sistema a 32 bit. 

Dettagli nel Manuale   di   VB.  

• Riavvio. È consigliabile riavvire VB dopo l’installazione per consentire che  si imposti 

completamente.

• Post-installazione . Verificare che l'utente appartenga al gruppo vboxusers. Aprire MX Manager 

Utenti> scheda Gruppi. Selezionare il nome utente e fare in modo che 'vboxusers' sia selezionato nella

lista Gruppi. Confermare e uscire. 

• Extension Pack .Se si installa VB da MX Installa Programmi, l'Extension Pack verrà incluso 

automaticamente. In caso contrario, sarà necessario scaricarlo e installarlo dal sito Web di Oracle 

(vedi Links). In ogni caso, sia che si sia scaricato dal sito o che sia già presente nel sistema perchè 

proveniente dai repo dovrete spostarvi con Thunar su di esso e cliccare sull'icona del file. Se ricavato 

dai repository si troverà in /usr/share/virtualbox-ext-pack/.

L' Extension Pack aprirà VirtualBox e si installerà automaticamente.

• Posizione . I file della macchina virtuale vengono memorizzati di default nella cartella /home. 

Possono essere abbastanza grandi e se si dispone di una partizione dati separata si può considerare di 

mettere la cartella predefinita lì. Andare su File> Preferenze> scheda Generale e modificare il 

percorso della cartella. 
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Figura 6-2: Windows 2000 in esecuzione in VirtualBox 

6.2.2  Uso 

• Creare una macchina virtuale . Per creare una macchina virtuale avviare VirtualBox, quindi fare 

clic sul pulsante Nuova sulla barra degli strumenti. Avrete bisogno di un di CD di Windows o una ISO

Linux (conviene a 32 bit, a 64 bit potrebbe non funzionare). Seguite la procedura guidata, accettando 

tutte le impostazioni suggerite a meno che non si sappia scegliere di meglio,  comunque si può sempre

cambiare in un secondo momento. Se la vostra ISO ha PAE, clic su Sistema> scheda Opzioni e 

abilitatelo. Potrebbe essere necessario aumentare la memoria RAM per i sistemi allocati su Virtualbox

maggiore del valore minimo di default, lasciando ancora memoria sufficiente per il sistema operativo 

ospitante (Mx Linux). Quando nella procedura guidata compare la finestra pop-up “Disco fisso” se 

intendete avere un sistema installato che memorizzi tutti gli ulteriori programmi che decidete di 

installarvi all'interno, le vostre attività e file, allora selezionate “Crea subito un nuovo disco fisso 

virtuale”. Per Windows, che ha bisogno di parecchio spazio, prendere in considerazione la creazione 

di un HD virtuale più grande di quello predefinito (10 GB) perché anche se è possibile aumentare le 

dimensioni più tardi, non è un processo semplice.
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Se vi interessa soltanto testare un sistema operativo, ad esempio il CD/DVD o la ISO di una 

distribuzione Linux, allora nella finestra “Disco fisso” potete scegliere “non aggiungere un disco fisso

virtuale”

• Selezionare un punto di montaggio . Se si era scelto di creare un nuovo disco fisso virtuale sarà 
sufficiente seguire la procedura guidata accettando le scelte predefinite e ciò che viene consigliato, 
attenzione a dare sufficiente Ram e considerate che se il disco è “allocato dinamicamente” sarà 
leggermente meno performante rispetto a “dimensione specificata”. Se nella finestra pop-up si era 
scelto di “non aggiungere un disco fisso virtuale” allora una volta che la macchina è configurata, è 
possibile selezionare il punto di montaggio. Questo punto di montaggio potrà essere il lettore ottico 
con il CD/DVD contenente l'ISO del sistema operativo, o anche un file ISO presente in qualche 
cartella nel filesystem del sistema operativo ospitante (Mx Linux). Fare clic su Impostazioni> 
Archiviazione , comparirà una finestra di dialogo dove si vedrà nel campo “albero di archiviazione” 
un controller IDE e sotto un controller SATA. Cliccando sull'icona del CD/DVD, sempre nel campo 
“albero di archiviazione”, si vedrà comparire l'icona di un CD/DVD anche nella sezione “Attributi” 
nella parte destra della finestra. Fate clic sull'icona del CD/DVD nella sezione Attributi per aprire un 
menu a tendina dove è possibile designare il lettore del CD/DVD contenente il disco con l'ISO del 
sistema operativo da visionare, ma è anche possibile muoversi nel filesystem per raggiungere il file 
ISO da visionare. In quest'ultimo caso selezionate “Scegli un file di disco ottico virtuale” e poi si 
indicherà la cartella dove avete archiviato l'ISO. Avviate la macchina. Il dispositivo selezionato (ISO 
o CD/DVD) sarà montato quando si avvia la macchina virtuale e il sistema operativo può essere 
caricato, visionato e installato. 

• GuestAdditions. Le GuestAddictions vanno installate a livello di sistema e poi anche per ciascun 
sistema operativo “ospite”, quindi prima si cliccherà sul file delle GuestAddictions per permetterne 
l’installazione e poi ogni qualvolta installate un sistema operativo “ospite” (l'ospitante è MX Linux), 
assicuratevi di installare VirtualBox GuestAdditions direttamente dal sistema operativo ospite avviato,
quindi cliccando su Dispositivi> “Inserisci l'immagine del cd delle GuestAdditions” dopo di che, se 
precedentemente avevate scaricato il file delle Guest Addiction, questo sarà automaticamente 
individuato. Questo vi permetterà di abilitare la condivisione di file tra ospite e ospitante e di regolare 
la visualizzazione nel modo che meglio si adatta al vostro ambiente. Se il sistema non riesce ad 
individuare il file delle GuestAddictions potrebbe essere necessario reinstallare il pacchetto: 
virtualbox-guest-additions o installarlo se non era stato installato in precedenza. Notare che se 
VirtualBox viene installato usando MX Installa Programmi allora vengono automaticamente installate
anche le GuestAdditions.

• Clonazione. Il modo più sicuro per spostare o modificare le impostazioni di una macchina virtuale 

esistente è quello di clonarlo: tasto destro del mouse sul nome di una macchina esistente> Clone  e 

inserite le informazioni. Per utilizzare il nuovo clone, creare una nuova macchina virtuale e nella 

procedura guidata quando si seleziona il disco rigido, scegliete "Usa disco rigido esistente" e 

selezionate il file *VDI del nuovo clone. 
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• Documentazione . Un eccellente documentazione per VirtualBox è disponibile attraverso la voce 
“Aiuto” nella barra dei menu o in formato PDF dal sito web. 

 
Figura 6-3: Individuazione dell'ISO per un nuovo SO ospite "Some OS" in VirtualBox

Links

• Wikipedia: Virtual Machine  
• Wikipedia: Confronto d  e  i software d  i   macchina virtuale   
• home page VirtualBox   
• Extension Pack VirtualBox   

6.3  Window Manager alternativi 

Un Gestore di Finestre, o se si preferisce Window Manager (originariamente WIMP: Finestra, Icona, Menu, e

dispositivo di puntamento), in Linux è essenzialmente la componente che controlla l'aspetto delle interfacce 

grafiche utente e fornisce i mezzi con cui l'utente può interagire con loro. MX Linux è strettamente legato a 

Xfce, come parte del suo approccio globale, ma esistono altre possibilità per gli utenti. MX Linux rende 

facile installare le alternative più popolari attraverso MX Installa Programmi, come descritto di seguito. 
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Figura 6-4: MX Linux 15 con Mate come ambiente desktop, e con il Browser aperto 

• Budgie Desktop, un desktop semplice ed elegante che utilizza GTK +
• Budgie Desktop  

• Compiz, un WM OpenGL con proprietà compositi  ng  .
• Compix   Window     Manager  

• Gnome Base, un display manager e desktop basato su GTK + che fornisce un ambiente desktop ultra-
leggero. 

• Gnome Ultra (GOULD), un ambiente desktop ultra-leggero   
• KDE5 Standard, un ambiente molto sviluppato e potente adattato all'ambiente MX Linux. vedere il 

Wiki di MX/antiX .
• KDE   home  pa  ge   

• LXDE è un ambiente veloce e leggero del desktop le cui componenti possono essere installati 
separatamente.

• LXD  E homepage   
• Wiki L  XDE   

• MATE è la continuazione di GNOME 2. Fornisce un ambiente desktop intuitivo e attraente.
• MAT  E homepage   

Una volta installato, è possibile scegliere il Window Manager che si desidera attraverso il pulsante di 

sessione presente nella Schermata di Login di default, nell’angolo a destra della barra in alto, dopo di che si 

farà il login come si farebbe normalmente. Se si sostituisce il Gestore del Login con un altro presente nei 

repository, assicurarsi di averne sempre almeno uno disponibile al riavvio. 

Wikipedia: X Window Manager 
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6.4  Riga di comando 
Anche se MX offre un set completo di strumenti grafici per l'installazione, la configurazione e l'utilizzo del 

sistema, la linea di comando (chiamato anche console, terminale, BASH, o shell) è ancora un utile e, a volte, 

uno strumento indispensabile. Qui ci sono alcuni usi comuni: 

• Avviare un'applicazione GUI per vederne l'output degli errori. 

• Velocizzare le operazioni di amministrazione del sistema. 

• Configurare o installare applicazioni software avanzate. 

• Eseguire più operazioni in modo rapido e semplice. 

• Risolvere problemi relativi ai dispositivi hardware. 

Il programma predefinito in MX per eseguire un terminale in una finestra del desktop è XFCE Terminal, che

può essere trovato in Start Menu> Sistema> Xfce Terminal (Terminal Emulator). Alcuni comandi sono 

considerati validi solo per l'amministratore (root), mentre altri possono variare l'output a seconda dell'utente. 

Per ottenere i permessi di root temporanei usare uno dei metodi descritti nella Sezione 4.7.1. 

Potrai riconoscere quando Xfce Terminal è in esecuzione con privilegi di root, guardando la linea del prompt 

a destra, prima dello spazio in cui si digita. Invece di una $, Si vedrà un #; inoltre, il nome utente cambia in 

root scritto in rosso. 

Nota. Se si tenta di eseguire come utente normale un comando che richiede i privilegi di root, come 

iwconfig, verrà visualizzato un messaggio di errore che non è stato trovato il comando, e apparirà una 

finestra pop-up che il programma deve essere eseguito come root, oppure semplicemente ci si troverà 

nuovamente al prompt senza nessun messaggio. 

 
Figura 6-5: L'utente ora ha i privilegi di amministratore (root) 
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6.4.1  Primi passi 

• Per ulteriori informazioni sull'esecuzione di Xfce Terminal per risolvere i problemi del sistema, si 
prega di consultare l'argomento Risoluzione dei problemi alla fine di questa sezione. Inoltre, si 
consiglia di fare il backup dei file su cui si sta lavorando come utente root con il comando cp e mv 
(vedi sotto). 

• Anche se i comandi del terminale possono essere abbastanza complessi, la comprensione della riga di 
comando in realtà è una cosa più semplice di quel che si potrebbe pensare. Per vedere come può 
essere facile, aprire Xfce Terminal e provare un paio di comandi di base. Sarà tutto più comprensibile 
se ci si esercita praticamente piuttosto che studiandolo in linea teorica. Cominciamo con un semplice 
comando: ls, Che elenca il contenuto di una directory. Il comando base elenca il contenuto di una 
qualsiasi directory sulla quale ci si è spostati con il terminale: 
ls 

• Questo è un comando utile, ma mostra solo un paio di brevi colonne di nomi stampati sullo schermo. 
Supponiamo di voler ulteriori informazioni sui file in questa directory. Siamo in grado di aggiungere 
un'opzione al comando per fargli mostrare (si dice stampare a video) ulteriori informazioni. 
Un'opzione è un elemento che aggiungiamo ad un comando per ampliare o modificare il suo 
comportamento. In questo caso, l'opzione che vogliamo è:
ls -l 

• Come si può vedere sul proprio schermo, quest'opzione fornisce informazioni più dettagliate 
(specialmente riguardo i permessi) sui file presenti in una directory qualsiasi. 

• Naturalmente, si potrebbe desiderare di vedere il contenuto di un'altra directory (senza prima spostare 
li il terminale). Per fare questo, aggiungete un argomento al comando, specificando quale file volete 
guardare. Un argomento è un valore o un riferimento che noi aggiungiamo al comando per 
indirizzare il suo funzionamento. Dando come argomento /usr/bin/, siamo in grado di elencare il 
contenuto di tale directory, piuttosto che quello della directory in cui ci troviamo con il terminale (il 
terminale di default è posizionato nella /home/utente). 
ls -l /usr/bin

• Ci sono un sacco di file in /usr/bin/ ! Sarebbe bello se si potesse filtrare questa uscita in modo che 
solo le voci che contengono, per esempio, la parola " fire" venissero elencate. Possiamo utilizzando 
delle pipe all'uscita del comando ls per indirizzare il risultato verso un altro comando: il comando 
grep. La pipe, o carattere │, serve per utilizzare l'output di un comando come input di un altro. Il 
comando grep effettua delle ricerche sulla base di un modello di ricerca che gli viene dato in maniera 
che sappia cosa e come cercare. Grep restituirà tutti i risultati che possono essere associati al modello,
quindi nel nostro esempio tutto ciò che viene restituito dal comando ls, attraverso il carattere pipe | 
viene indirizzato a grep che filtrerà la parola fire, che in questo caso rappresenta il modello di ricerca.
ls -l /usr/bin | grep fire

• Infine, supponiamo di voler salvare questi risultati in un file di testo da utilizzare in un secondo 
momento. Quando impartite dei comandi, l'output si dirige fondamentalmente verso lo schermo; ma 
siete in grado di reindirizzare questo output da qualche altra parte, come ad esempio in un file, 
utilizzando il simbolo > di redirezione (redirect) per istruire il computer a fare un elenco dettagliato di
tutti i file che contengono la parola " fire" in una determinata directory (per impostazione predefinita 
la directory /home dell'utente), e per creare un file di testo contenente tale elenco, con il nome, in 
questo caso, di" FilesOfFire"
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ls -l /usr/bin | grep fire > FilesOfFire.txt

• Come si può vedere, la linea di comando può essere utilizzata per eseguire facilmente compiti 
complessi combinando semplici comandi in modi diversi. 

6.4.2  Comandi comuni 

Ecco un elenco di comandi da terminale rudimentali. Per un riferimento completo, vedere la sezione Links, 
qui di seguito. 
Navigare nel filesystem 
Tabella 6: comandi di navigazione nel Filesystem 

Comando Commento 

cd /usr/share Cambia la directory corrente nella cartella presente nel percorso dato: "/usr/share".
Se a cd non viene aggiunto nessun argomento, vi porterà alla directory home. 

pwd Mostra il percorso della corrente directory di lavoro 

ls Elenca il contenuto della directory corrente. Utilizzate l'opzione -a per 
visualizzare i file nascosti, e -l per vedere i dettagli su tutti i file. Spesso si 
presenta in combinazione con altri termini: lsusb elenca tutte le periferiche USB, 
lsmod tutti i moduli, etc. 

Gestione dei file 
Tabella 7: comandi di gestione dei file 

Comando Commento 

cp filesorgente posizionefile Copiare un file in un file con un altro nome o posizione. Utilizzare
-R ("ricorsivo") per copiare intere directory. 

mv filesorgente posizionefile Spostare un file o una directory da una posizione ad un'altra. 
Utilizzato anche per rinominare file o directory ed eseguire un 
backup: per esempio prima di modificare un file critico come 
xorg.conf si potrebbe utilizzare questo comando per spostarlo a 
qualcosa come xorg.conf_bak. 

rm nomefile Cancellare un file. Utilizzare -R per cancellare una directory, e -f (
"forza"), se non si desidera che venga chiesto di confermare per 
ogni eliminazione. 

cat file.txt Stampa a video (mostra sullo schermo) il contenuto di un file. 
Utilizzare solo su file di testo con estensione .txt 

grep Trova una determinata stringa di caratteri in un determinato pezzo 
di testo e mostra l'intera linea che contiene la stringa cercata . 
Solitamente utilizzato con una pipe, ad esempio:
cat uncertofile.txt | grep unacertastringa  visualizzerà la linea di
uncertofile.txt che contiene unacertastringa. Per trovare una 
scheda USB di rete, per esempio, è possibile digitare: 
lsusb | grep -i Network. Il comando grep è case sensitive di 
default, si utilizza -i per renderlo case insensitive. 

dd Copia qualsiasi cosa, quindi può essere usato per le copiare intere 
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directory, partizioni e unità di massa. La sintassi di base è 
dd if=filesorgente of=filediversonome
if=file    Specifica il percorso di ingresso. E' lo Standard input 
of=file   Specifica il percorso di uscita. E' lo Standard output

Esempio 1
#dd if=/dev/sda of=/dev/sdb
Questo comando farà la esatta copia di /dev/sda in /dev/sdb
Esempio 2
#dd if=/dev/dvd of=dvd.iso
Questo comando farà una copia del DVD nel file dvd.iso

Simboli 
Tabella 8: Simboli 

Comando Commento 

| Il simbolo pipe viene utilizzato per coinvogliare l'output di un comando all'input di un
altro. Alcune tastiere mostrano due brevi barre verticali invece di una, ma poi nel 
terminale compare un unica barra che svolge correttamente la sua funzione.

> Il simbolo di reindirizzamento, utilizzato per inviare l'output di un comando in un file.
Se esiste un file con lo stesso nome, questo sarà eliminato. Raddoppiare il simbolo di 
reindirizzamento farà in modo che l'output di un comando si aggiunga ad un file 
esistente invece di sostituirlo. 

& Aggiungere la e commerciale alla fine di un comando (con uno spazio prima di esso) 
induce a farlo funzionare in background in modo che non ci sia bisogno di aspettare 
che sia completato per eseguire il comando successivo. La doppia e commerciale 
indica che il secondo comando deve essere eseguito solo se il primo ha avuto 
successo. 

Risoluzione dei problemi 
Per la maggior parte dei nuovi utenti Linux, la linea di comando è utilizzata principalmente come strumento 

di risoluzione dei problemi. I comandi del terminale danno rapidamente informazioni dettagliate che possono

essere facilmente incollate in un post sul forum, casella di ricerca, o e-mail quando si cerca aiuto sul web. Si 

raccomanda vivamente di mantenere queste informazioni a portata di mano quando si chiede aiuto. Essere in 

grado di fare riferimento alla specifica configurazione hardware non solo accelera il processo per ricevere 

aiuto, ma anche farà si che gli utenti che si offrono di aiutare possano fornire soluzioni più accurate. Ecco 

alcuni comandi comuni per la risoluzione dei problemi (vedi anche sezione 3.4.4). Alcuni di questi sono in 

grado di fornire informazioni, o di fornirne in quantità maggiore, solo se vengono digitati con i privilegi di 

root. 
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Tabella 9: Comandi per la risoluzione dei problemi

Comando Commento 

lspci Mostra un veloce riassunto dei dispositivi hardware interni rilevati. Se un dispositivo 
viene mostrato come /sconosciuto/, di solito sussiste un problema di driver. l'opzione 
-v permette la visualizzazione di informazioni con maggiori dettagli. 

lsusb Elenca i dispositivi USB inseriti nel computer. 

dmesg Mostra il registro di sistema per la sessione corrente (cioè dall'ultimo avvio). L'output
è piuttosto lungo, e di solito questo viene convogliato attraverso grep, less (simile a 
more) o tail (per vedere le attività più di recenti). Ad esempio, per trovare eventuali 
errori relativi al vostro hardware di rete, provare dmesg | grep -i net 

top Fornisce un elenco in tempo reale dei processi in esecuzione e varie statistiche su di 
essi. Disponibile anche in versione grafica col nome di Htop e in una versione più 
gradevole: Gestore dei processi (taskmanager). Le trovate in StartMenu> Sistema

Accesso alla documentazione per i comandi 

• Molti comandi mostrano un semplice messaggio di "informazioni sull'uso del comando" se gli si 
aggiunge l'opzione "-h" o "--help". Ciò può essere utile per richiamare rapidamente la sintassi di un 
comando. Per esempio: cp --help

• Per informazioni più dettagliate su come utilizzare un comando, consultare la pagina man (manpage) 
del comando.

• Le pagine di manuale sono comodamente accessibili tramite il menu Start, ponendo un cancelletto e il
nome del comando nella casella di ricerca in alto. Ad esempio, è possibile visualizzare la pagina man 
per il comando “cp” (copia) scrivendo questa voce nella casella di ricerca: #cp

• La pagina man può anche essere letta alla console con il comando man nomecomando. Per 
impostazione predefinita, le pagine man vengono visualizzate nel terminale con la modalità di 
impaginazione di less, che significa che viene visualizzata solo una schermata del file alla volta. 
Tenete in mente questi trucchi per navigare nella schermata risultante:

• La barra spaziatrice (o il tasto PageDown) avanza di una schermata. 
• La lettera b (o il tasto PageUp) retrocede di una schermata. 
• La lettera q esce dal documento di aiuto. 

Alias 
È possibile creare un alias (personalizzare il nome di un comando per renderlo più pratico da utilizzare) per 
qualsiasi comando si desideri, breve o lungo che sia. E’ molto facile crearli usando lo strumento Bash Config.
Dettagli nel Wiki M  X/antiX  . 

6.4.3  Link 

• BASH Guida per principianti    (in italiano)
• Nozioni di base della riga di comando   
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6.5  script 
Uno script è un semplice file di testo che può essere scritto direttamente da una tastiera, e consiste in una 
serie di comandi del sistema operativo espressi secondo una sequenza logica. I comandi sono trattati uno alla 
volta da un interprete di comandi che a sua volta richiede servizi dal sistema operativo. L'interprete dei 
comandi predefinito in MX Linux è Bash. I comandi devono essere comprensibili alla Bash, e sono stati 
definiti per essere utilizzabili nella programmazione. Uno script di shell è la controparte nel mondo Linux dei
programmi batch in ambito Windows. 
Gli script vengono utilizzati in tutto il sistema operativo Linux e molte applicazioni si appoggiano ad essi 
perché costituiscono un modo semplice ed economico per creare, modificare ed eseguire diversi comandi. 
Durante l'avvio, per esempio, molti script sono invocati per avviare processi specifici quali la stampa, 
networking, ecc. Gli script vengono utilizzati anche per i processi automatizzati, per l'amministrazione di 
sistema, le estensioni delle applicazioni, controlli utente, ecc Infine, qualsiasi tipo di utente può utilizzare gli 
script per i propri scopi personali. 

6.5.1  Un semplice script 

Facciamo uno script molto semplice (e famoso) per avere un'idea base del funzionamento. 

1. Aprite l'editor di testo FeatherPad ( Menu Start> Accessori), E digitate:

#! /bin/bash
clear
echo Buon giorno, Mondo!

2. Salvate il file nella vostra directory home con il nome SempliceScript.sh 
3. Fate clic destro sul nome del file, selezionate Proprietà e, nella scheda Permessi, selezionate "Permetti

di eseguire il file come un programma". 
4. Aprite un terminale e digitate:
sh /home/<NomeUtente>/SempliceScript.sh

5. La linea "Buon giorno, Mondo!" Apparirà sullo schermo. Questo semplice script non fa molto, ma 
stabilisce il principio che un semplice file di testo può essere utilizzato per inviare comandi e per 
controllare il comportamento del sistema. 

NOTA:  Tutti gli script si aprono con una shebang (o shabang) all'inizio della prima riga: è una 
combinazione del segno cancelletto (#) o hash, e un punto esclamativo, seguiti dal percorso dell'interprete dei
comandi. Qui l'interprete è Bash, il suo eseguibile è localizzato nel percorso standard per le applicazioni di 
tutti gli utenti: la directory /bin. Una volta invocata, attraverso il comando sh, essa cercherà il nome dello 
script che gli viene dato nella directory dove è posizionato il terminale, che di default è la cartella 
/home/VostroNome, quindi il comando precedente poteva anche essere dato così:

sh SempliceScript.sh
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Se lo script si trovasse nella cartella Documenti, o si sposterà il terminale nella cartella Documenti con il 
comando cp o si darà il comando sh /home/VostroNome/Documenti/SempliceScript.sh che può 
essere trasmesso in modo più semplicemente così: sh ~/Documenti/SempliceScript.sh

6.5.2  Uno script utile 

Diamo un'occhiata ad uno script utile per l'utente ordinario che riduce tutte le azioni coinvolte nel backup di 
diversi set di file ad un unico tasto. Lo script di seguito si basa su uno script di sistema chiamato rdiff-
backup che deve essere installato dai repository, se si vuole che funzioni. Permette di copiare una directory 
in un'altra, mantenendo un registro delle differenze in una sottodirectory speciale così da poter recuperare 
degli eventuali file persi qualche tempo prima. (Per inciso, rdiff-backup si basa a sua volta su uno script 
chiamato diff.) 
In questo esempio, un utente denominato "newbie" vuole creare uno script per eseguire il backup di 
documenti, musica, posta elettronica e immagini dalla directory /home su un disco esterno. 

Ora diamo un'occhiata alle componenti di questo script: 

1 #!/bin/bash
2 # 
3 # Questo script rdiff-Backup esegue il backup su un secondo disco rigido
4 # Deve essere eseguito come root per permettere il montaggio del secondo disco rigido
5 
6 # Per ripristinare i file, eseguire il comando: cp -a /mnt/sda1/username /home 
7 # Se preferite ripristinare, senza sovrascrivere, date: 
8 # cp -a -i reply=no /mnt/sda1/username /home 
9 
10 # Montaggio dei dispositivi esterni 
11 
12 mount /dev/sdb1 
13 mount /dev/sdb2 
14 mount /dev/sdb3 
15 
16 # Esecuzione del backup 
17 
18 rdiff-backup /home/newbie/Documents /mnt/sdb2/Documents 
19 rdiff-backup /home/newbie/Music /mnt/sdb1/Music 
20 rdiff-backup /home/newbie/Mail /mnt/sdb2/Mail 
21 rdiff-backup /home/newbie/Pictures /mnt/sdb3/Pictures 
22 
23 # Smontaggio dei dispositivi esterni 
24 
25 umount /dev/sdb1 
26 umount /dev/sdb2 
27 umount /dev/sdb3 
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• Linee 2-8: un segno di cancelletto è stato posto di fronte a queste linee (dette "commentate") per 
indicare alla bash che non fanno parte della sequenza di comandi da eseguire. Qui il loro scopo è 
quello di fornire, a chiunque guardi questo script, informazioni riguardanti lo script d'origine, il 
creatore, e la licenza (metadati). 

• Linea 10: un buon script separa i comandi in sezioni procedurali etichettate in modo chiaro, anche 
nelle linee 16 e 23. 

• Linee 12-14: i tre dispositivi da utilizzare per il backup devono essere prima montati in modo da 
essere disponibili al sistema. 

• Linee 18-21: qui alla Bash viene detto di usare lo script di sistema rdiff-backup per confrontare le 
directory originali (fonti) con le directory di backup (destinazione), copiando le differenze che trova, e
conservando una copia delle modifiche. 

• Linee 25-27: una volta che il lavoro di backup è fatto, le unità esterne vengono smontate dal sistema. 

Chiunque volesse usare lo script dovrebbe svolgere pochi passi di esecuzione: 

1. Copiate l'intero script. 
2. Fate clic destro sul desktop e selezionate Crea documento> File vuoto... 
3. Date un nome (senza spazi) che abbia un senso al file, e aggiungete l'estensione "sh" in modo da farlo 

riconoscere al sistema come uno script. In questo esempio, si potrebbe chiamarlo 
Backup_DocsMusicMailPictures.sh 

4. Aprite il nuovo file testo e incollateci all'interno il testo copiato dello script. 
5. Modificate tutti i nomi, percorsi , ecc. per quelli che sono sul vostro particolare sistema. Nell'esempio 

di cui sopra, si possono certamente avere nomi diversi e/o percorsi differenti per le directory da 
salvare, così come dispositivi differenti dove si vuole salvare il backup.
Quando avete corretto lo script eliminate anche i numeri all'inizio di ogni riga.

6. Salvate lo script in un luogo che potete trovare facilmente quando ne avrete bisogno, diciamo che 
conviene creare una nuova directory /home/scripts appositamente destinata. 

7. Fate clic sullo script, selezionate Proprietà, fate clic sulla scheda Permessi e vidimate la casellina 
Permetti di eseguire come un programma. 

8. Quando si è pronti per il backup, aprite un terminale e digitare: 
sh /home/scripts/Backup_DocsMusicMailPictures.sh

SUGGERIMENTO: Usare il tasto tab per completare automaticamente il nome del file dopo aver 
digitato le prime lettere. 

Links 

• Tutorial L  inux Shell Scripting  
• Elenco dei comandi di Linux   

• Tutorial sugli script in italiano  
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6.5.3  Tipi di script speciali

Alcuni script per poter essere eseguiti richiedono un software speciale (linguaggio di scripting), non è 

sufficiente il semplice avvio in Bash. I più comuni, per i normali utenti, sono gli script Python, che hanno il 

formato *.py.

Per eseguirli, devi indicarne il percorso corretto al file. Se ad esempio avete uno script python sul vostro 

desktop, chiamato "tryme.py" potete fare tre cose:

• Basta cliccare su di esso. MX Linux ha un piccolo programma chiamato Py-Loader che lo lancerà 

usando python.

• Aprire un terminale e digitare: 

python ~/Desktop/tryme.py

• In alternativa, potete aprire un terminale all'interno della cartella contenente il file, ed in questo caso 

si digiterà: 

python ./tryme.py

I linguaggi di scripting sono molto avanzati e non rientrano nell'ambito di questo manuale.

6.5.4  Script utente pre-installati
I seguenti script aiutano gli utenti a mantenere la loro installazione di MX Linux sempre aggiornata  in 
modalità Rolling Release. 

smxi
Quando viene eseguito, smxi permette agli utenti di installare un nuovo kernel, installare driver grafici ATI e 
NVIDIA, eseguire apt-get upgrade o apt-get dist-upgrade in modo sicuro, e molto altro ancora! Scritto da un 
programmatore di nome " H2 ", lo script è praticamente auto esplicativo, ma per le opzioni di utilizzo, 
eseguire smxi -h
smxi deve essere eseguito al di fuori del sistema X Window (cioè, non in una sessione grafica del desktop) 
per la maggior parte delle funzioni. 

• Dal desktop: 
• Premere Ctrl-Alt-F1 per uscire dalla modalità grafica ed aprire un terminale. 
• Effettuare il login come root (digitare root e fornire la relativa password) 
• Digitare: smxi

• Al boot: 
• Quando si presenta il menu di GRUB, digitate e per essere in grado di modificarlo.
• Nel menu di GRUB di MX Linux, nel campo di inserimento, alla fine della riga che specifica 

il kernel, aggiungete "3" subito dopo la parola "quiet"
• Il sistema si avvierà con l'apertura di un terminale. 
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• Accedere come "root" (senza virgolette) e fornire la password appropriata 
• Digitare: smxi 

smxi, la prima volta che viene eseguito, farà una serie di domande tra cui le opzioni di sistema che si desidera
eseguire. Le seguenti opzioni consigliate sono : 

• continue-no-changes
• apt (piuttosto che aptitude)
• apt dist-upgrade 

Dopo che smxi ha completato le sue attività vi verrà chiesto se desiderate riavviare il desktop in modalità 
grafica. Per farlo digitate, con i privilegi di amministratore:
smxi -G

NOTA: Eseguire smxi -G in un terminale root, all'interno di una sessione grafica con il server X in 
esecuzione, permetterà di avviare alcune funzioni di smxi, che altrimenti saranno negate, come la rimozione 
di kernel indesiderati, ecc. 
homepage smxi 
documentazione smxi 

sgfxi
Questo script creato da h-2, viene eseguito all'interno di smxi o separatamente, e si occupa dell'installazione 

dei driver grafici. Sgfxi attualmente supporta driver proprietari come fglrx di ATI, e driver proprietari di 

Nvidia. Permette anche di effettuare la sostituzione in Xorg da driver proprietari a driver liberi per ATI, Intel, 

o Nvidia. Seguire la procedura sopra descritta per utilizzare lo script, sostituendo smxi con sgfxi. 

Sgfxi necessita di una connessione internet funzionante! Alcune connessioni Internet wireless possono venire

scollegate quando si opera al di fuori di X. Se questo accade con la vostra connessione converrà passare 

temporaneamente ad una connessione internet via cavo prima di procedere.

Lo script sgfxi scarica automaticamente e installa gli header del kernel e tutto ciò di cui si ha bisogno. Poi 

scarica gli installer dei binari dei driver grafici da Nvidia oppure da ATI, prepara il sistema, installa, quindi 

imposta conseguentemente xorg.conf , il tutto in modo abbastanza pulito, e  intuitivo. Inoltre si auto-

aggiorna cosi che sarà in grado di installare tutti i nuovi driver rilasciati. Infine, sgfxi consente, in modo 

semplice, di scambiare vicendevolmente tra driver proprietari come fglrx di ATI o i driver proprietari 

NVIDIA e i driver liberi di Xorg. 

NOTA: avviando sgfxi su un sistema con chipset nvidia verrà rimosso ddm-mx, il pacchetto software usato 

da MX Tools per installare le schede grafiche AMD/ATI e Nvidia, di conseguenza dovrai reinstallarlo se 

vorrai poterlo usare dopo l'avvio di sgfxi.

manuale sgfx
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inxi
Un terzo script proveniente dal programmatore h-2, presente in MX Linux, è inxi, uno script che riporta 

informazioni di sistema in una pratica modalità a riga di comando. Inserite inxi -h in un terminale per 

vedere tutte le opzioni disponibili, che comprendono una gamma molto vasta e completa di dati del sistema 

fino ad arrivare (se collegati ad internet e inserendo gli opportuni parametri) alle previsioni del tempo.

Questo è il comando in esecuzione dietro a MX Veloce Info di Sistema.

Maggiori info: Wiki di MX/antiX

Maggiori info:Una guida in italiano su Smxi, Sgfx eInxi, la si trovare nelle Faq di antiX (gli strumenti sono 
gli stessi) al capitolo 12
FAQ   in   formato   ODT  
FAQ   in   formato   PDF  

6.5.5  Suggerimenti e trucchi

Facendo doppio clic su uno script di shell, questo si aprirà nell'editor Featherpad per impostazione predefinita

invece che venire eseguito direttamente. Questa modalità è stata pensata come misura di sicurezza per 

prevenire l'esecuzione accidentale dello script quando non ci fosse l’intenzione di farlo. Per modificare tale 

comportamento, fate clic su Impostazioni > Editor di tipi mime. 

Individuare x-application/x-shellscript e cambiare l'applicazione predefinita di avvio in bash.

6.6  MX Strumenti – Livello avanzato
Oltre alle MX Apps di base, le cui configurazioni sono state discusse nella sezione 3.2, MX Linux include 

alcuni programmi per l'utente avanzato disponibili in MX Tools. 

6.6.1 Aggiorna Kernel su Live-usb (CLI) 

   Cambia il kernel su un  a   USB-  Live di MX/antiX  

ATTENZIONE: da usare solo in una sessione Live!

Questa applicazione, a riga di comando, può aggiornare il kernel su una USB-Live di MX con un qualsiasi 

altro kernel tra quelli installati. Questa applicazione verrà mostrata negli Strumenti di MX (MX Tools) 

solamente quando si è all'interno di una sessione Live. 
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Figura 6-6: Lo strumento live-usb kernel updater pronto a sostituire un nuovo kernel 

Aiuto: qui 

6.6.2  MX Crea Live USB (Live-Usb Maker)

Usare per creare una Live-USB a partire da un file ISO, o a partire da un CD/DVD Live o una USB-Live già 

esistenti. La creazione della Live-USB potrà essere realizzata usando questa utility su un sistema operativo 

installato, sia esso un Hard Disk o una chiavetta, dove un ulteriore chiavetta andrà a costituire la USB-Live, 

ma si può realizzare anche su un sistema non installato usando questa utility su una chiavetta USB-Live che 

realizzerà una seconda USB-Live.

Sebbene sia presente anche UNetbootin in MX Linux tra le applicazioni di default (vedi Sezione 2.2.3). 
antix2usb ha una serie di vantaggi: 

• E' più veloce.

• Salva i files di stato ad ogni riavvio.

• LiveUSB con spazio di stoccaggio dati per salvare files direttamente sulla live-usb

• Persistenza

• Rimasterizzazione

• Ora viene offerta l’opzione dd

• Aggiornamento del Kernel Live

NOTA: la forma a riga di comando (CLI): live-usb-maker, avviata da root offre molte opzioni avanzate.
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Figura 6-7: Lo strumento live-usb maker pronto a creare una live usb
AIUTO: qui

6.6.3  Persistenza/Live Remaster (MX RemasterCC) 

 make-snapshot-installed-system

 make-live-usb-persistence

 live-usb-installing-apps

NOTA: Questa applicazione verrà mostrata negli Strumenti di MX (MX Tools) solamente
quando si è all'interno di una sessione Live.

--Remaster-- 
ATTENZIONE: da usare solo in una sessione Live!

Lo scopo principale di Live Remaster è di rendere agli utenti molto facile, conveniente e sicuro, ottenere la 
propria versione personalizzata di MX Linux che possa anche essere distribuita ad altri computer. 
L'idea è di utilizzare una unità USB Live (o un Live HD con una “installazione frugale”, vedi il wiki 
MX/antiX) su una partizione del disco come ambiente di sviluppo e test.
Aggiungere o sottrarre pacchetti, dopo di chè, quando si è pronti a rimasterizzare, usare il programma 
remaster sottoforma di un semplice script o attraverso un interfaccia grafica (quella di MX RemasterCC) per 
fare una rimasterizzazione del sistema e quindi riavviare. Se qualcosa va terribilmente male, si può 
semplicemente riavviare nuovamente con l'opzione di ripristino (rollback) e si potrà avviare nell'ambiente 
precedente. 

 mx-16-remaster-your-live-usb

 mx-spins-workbench
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 mx-spins-stevos-kde

--Persistenza-- 
ATTENZIONE : Da usare solo in una sessione Live!
ATTENZIONE : Potrebbe non funzionare con grandi aggiornamenti che potrebbero superare la capacità 
della RAM. In questo caso sono disponibili procedure alternative: 

• Effettuare l'aggiornamento a tappe, con una dimensione ridotta (ad esempio, 200 MB) per ciascuna 
tappa

• Attendere l'ISO snapshot che viene fornita da MX Linux aggiornata all'ultimo mese o aspettare quella
successiva, e reinstallare. Prima di avviare la procedura, assicurarsi di copiare tutte le cartelle non di 
sistema su una chiave o unità di massa.

 Live USB con persistenza (modalità legacy) 

 Live USB con persistenza (modalità UEFI)

La persistenza è un ibrido tra un sistema installato su un dispositivo Live (CD/DVD o chiave USB con la ISO
Live del sistema) e un'installazione completa; essa consente di mantenere tutti i file che installate o 
aggiungete durante una sessione live. I programmi installati o eliminati e le personalizzazioni ai file 
dell'utente "demo", effettuate durante la persistenza Live, saranno salvati e riportati sul sistema installato. 

Figura 6-8: Lo strumento Remaster e Persistenza 
AIUTO: qui. 
AIUTO:Una guida approfondita in italiano su Snapshot, Creazione USB-Live, Installazione Frugale, 
Rimasterizzazione, la si trovare nelle Faq di antiX (gli strumenti sono gli stessi) nei capitoli da 13 a 16
FAQ   in   formato   ODT  
FAQ   in   formato   PDF  
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6.6.4  Snapshot (Salva tuo Sistema su ISO)

Questo strumento permette di ottenere una copia del sistema in esecuzione e di creare una ISO da esso. 
L'ISO può essere messa su un dispositivo Live nel modo consueto (vedi Sezione 2.2). Volendo poi effettuare 
l'installazione dal dispositivo Live che avete creato, aprite un terminale di root e digitate il comando: 
minstall

Figura 6-9: Schermata di apertura di MX Snapshot (MX Salva tuo sistema su ISO)
AIUTO: qui.

6.7  SSH 
SSH (Secure Shell  )   è un protocollo utilizzato per accedere in modo sicuro a sistemi remoti. E 'il modo più 
comune per accedere a computer remoti Linux e Unix-like. MX Linux viene fornito con i pacchetti principali
necessari per eseguire SSH in modalità attiva, il principale dei quali è OpenSSH, un'implementazione libera 
della Secure Shell che è costituita da una suite completa di applicazioni. 

• Avviate o riavviate il demone SSH come utente root con il comando:
/etc/init.d/ssh start 

• Per avviare il demone SSH automaticamente all'avvio del computer, fate clic su Tutte le 
impostazioni> Sessione e avvio> Avvio Automatico. Fate clic sul pulsante “Aggiungi”, quindi nella 
finestra di dialogo inserite un nome tipo StartSSH, poi, se lo desiderate, una breve descrizione, infine 
nel campo più sotto, il comando:
/etc/init.d/ssh start 
Premete OK e siete a posto. La volta successiva che si fa il re-boot, il demone SSH sarà attivo. 
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• Gli utenti di KDE su Linux MX possono fare lo stesso andando in  Impostazioni> Impostazioni di 
sistema KDE>Avvio e spegnimento> Avvio automatico . 

6.7.1  Risoluzione dei problemi 

Di tanto in tanto SSH potrebbe non funzionare in modalità passiva, in questo caso si riceverebbe un  
messaggio di mancato collegamento. Allora si può provare in questo modo: 

• Modificate come root il file '/etc/ssh/sshd-config'. Circa a livello della linea 16 troverete il parametro 
'UsePrivilegeSeparation yes'. Cambiatelo in:
UsePrivilegeSeparation no 

• Aggiungere se stessi (o gli utenti che vi interessa aggiungere) nel gruppo 'ssh' utilizzando Mx 
Manager Utenti (MX User Manager) oppure modificate come root il file /etc/group. 

• A volte i certificati possono essere mancanti o obsoleti; un modo semplice per riaverli è quello di 
eseguire (come root) il comando
ssh-keygen -A 

• Controllate che sshd sia in esecuzione digitando
/etc/init.d/ssh status
Il sistema dovrebbe rispondere '[OK] sshd is running' (OK sshd è in esecuzione).

• Se si utilizza un firewall, verificare che la porta 22 non sia bloccata. Inoltre deve consentire il traffico 
IN e OUT. 

Maggiori info: manuale Openssh 

6.8  Sincronizzazione
La sincronizzazione dei file (o syncing) consente a file identici ma localizzati in posizioni diverse di 

continuare a rimanere identici anche dopo un’eventuale modifica di uno dei membri identici.

Può essere impostata in uno di questi due modi:

• a senso unico ("mirroring"), in cui un computer “sorgente” viene copiato su altri, ma un eventuale 

cambiamento su uno degli altri non viene copiato ne sul sorgente ne su nessun’altro.

• a due vie, in cui più computer vengono mantenuti identici

Ad esempio, alcuni utenti di MX trovano utile usare software di sincronizzazione quando gestiscono più 

installazioni per se stessi, o per i membri della famiglia o per altri gruppi, eliminando così la necessità di 

aggiornare più di una volta. 

È disponibile una grande quantita di software di sincronizzazione, ma i seguenti due sono stati testati e 

dimostrati utili per gli utenti di MX Linux:

• unison-gtk (nei repo)

• FreeFileSync  
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7  Sotto il cofano 

7.1  Introduzione 
MX Linux in ultima analisi, eredita la sua struttura di base da Unix, Un sistema operativo che è stato in giro 
in varie forme dal 1970, da molto prima di MS Windows. Fin dal primo momento che Linux ha iniziato a 
essere sviluppato, ha iniziato ad esistere anche la distribuzione Debian. Il sistema operativo di base è 
l'argomento di questa sezione. Gli utenti provenienti da Microsoft Windows in genere trovano un sacco di 
concetti poco famigliari, e si sentono frustrati cercando di fare le cose nel modo in cui sono abituati. 
In questa sezione verrà data una panoramica concettuale di alcuni aspetti base di MX Linux, e come questo si
differenzia da altri sistemi così da facilitare la transizione. 
Link 

• Wikipedia: Unix  
• Linux Home   
• Wikipedia Debian  

7.2  La struttura del filesystem 
Ci sono due usi di base del termine "filesystem". Il primo è il filesystem del sistema operativo. Questo si 

riferisce ai file e a come il sistema operativo li organizza per tenere traccia di tutte le risorse hardware e 

software che ha a disposizione. 

L'altro uso del termine filesystem si riferisce al Disk filesystem, progettato per l'archiviazione e il recupero 

dei file su un dispositivo di archiviazione dati, di solito un disco fisso. Il Disk filesystem è impostato quando 

la partizione del disco viene formattata, prima di scrivere i dati sulla partizione. 

Filesystem del sistema operativo 

Uno dei primi problemi con cui si scontrano molti nuovi utenti Linux è come funziona il filesystem. Per 

esempio, se avete cercato nel sistema di MX Linux di trovare C: \driver o D: \driver, state cercando invano:

MX Linux gestisce i dischi rigidi e altri supporti di memorizzazione in modo diverso da Windows. Piuttosto 

che avere un albero di filesystem separato su tutti i dispositivi, MX Linux ha un singolo albero di filesystem 

(chiamato filesystem “root”) che è rappresentato dal simbolo "/" che contiene ogni dispositivo collegato. 

Quando un dispositivo di memoria viene aggiunto al sistema, il filesystem del dispositivo viene collegato a 

una directory o sottodirectory del filesystem root; questo si chiama montaggio di un dispositivo o unità di 

memoria dati. Se aprite Thunar e fate clic su Filesystem nel riquadro in alto a sinistra, noterete un numero di 

directory con i nomi basati sulla Unix Filesystem Hierarchy Standard. 
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Figura 7-1: Il filesystem di MX visibile in Thunar 
Ecco una semplice descrizione delle principali directory di MX Linux insieme a degli esempi di quando gli 
utenti comunemente lavorano con i file in queste directory: 

• /bin
• Questa directory contiene i file di programma binari che vengono utilizzati dal sistema durante

l'avvio, ma che possono anche essere richiesti dalle azioni degli utenti una volta che il sistema 
è completamente attivo e funzionante. 

• Esempio: Molti programmi di base della riga di comando, come ad esempio la shell Bash, e le 
utility come “dd”, “grep”, “ls”, e “mount” si trovano qui, in aggiunta ai programmi utilizzati 
solo dal sistema operativo. 

• /boot 
• Come si può immaginare, i file che Linux ha bisogno per fare il boot si trovano qui. Il kernel 

di Linux, il cuore del sistema operativo Linux, è conservato qui, come lo sono i bootloader 
come GRUB. 

• Esempio: Nessun file qui è comunemente accessibile dai normali utenti. 
• /dev 

• In questa directory ci sono gli speciali file che collegano i vari dispositivi di input/output 
presenti sul sistema. 

• Esempio: Nessun file qui è comunemente accessibile direttamente dagli utenti, fatta eccezione 
per i comandi di montaggio a riga di comando (CLI). 

• /etc 
• Questa directory contiene file di configurazione del sistema così come file di configurazione 

delle applicazioni.
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• Esempio: Il file /etc/fstab specifica i punti di montaggio per i filesystem aggiuntivi sui 
dispositivi, partizioni, ecc. che possono essere configurati per il vostro utilizzo ottimale. 

• Esempio: i problemi di visualizzazione dello schermo a volte si risolvono con la modifica del 
file /etc/X11/xorg.conf. 

• /home 
• Qui risiedono directory personali (con i dati e le impostazioni) dell'utente. Se vi è più di un 

utente viene impostata una sottodirectory separata per ciascuno. Nessun utente (ad eccezione 
di root) è in grado di leggere la home directory di un altro utente. La directory dell'utente 
contiene sia file nascosti (dove il nome del file è preceduto da un punto) che file visibili; i file 
nascosti possono essere visti in Thunar facendo clic su Visualizzazione> Mostra file nascosti
(oppure premendo Ctrl-H). 

• Esempio: gli utenti in genere organizzano i propri file, all'inizio, utilizzando le directory di 
default come Documenti, Musica, ecc.

• Esempio: il vostro profilo di Firefox si trova nella directory nascosta .mozilla/firefox / 
• /lib 

• Questa directory contiene librerie condivise (analoghe alle DLL Windows) che sono 
necessarie al momento del boot. In particolare, i moduli del kernel si trovano qui, sotto 
/lib/modules. 

• Esempio: Nessun file qui è comunemente accessibile dagli utenti. 
• /media 

• I file per supporti rimovibili come CD-ROM, unità floppy e chiavette USB vengono installati 
qui quando i media (o periferiche) vengono montati automaticamente. 

• Esempio: Dopo il montaggio è possibile accedere, in questa cartella, al contenuto di una 
periferica come una flash-card, una USB-pen ecc. 

• /mnt 
• Dispositivi di storage fisico (di memorizzazione di dati) devono prima essere montati qui, per 

poter essere accessibili. Poi i dischi o le partizioni vengono definite nel file /etc/fstab, e alla 
fine il loro filesystem viene montato qui. 

• Esempio: in questa directory gli utenti possono accedere alle unità e partizioni montate. 
• /opt

• Questa è la posizione prevista per i sottosistemi delle principali applicazioni di terze parti 
installate dall'utente. 

• Esempio: se si installa Google Earth, è in questa directory che verrà installata. Alcune 
distribuzioni mettono i programmi installati dall'utente anche nelle sottodirectory /opt. 

• /proc
• Posizione per le informazioni sui processi e sul sistema informativo.
• Esempio: Nessun file qui è comunemente accessibile dagli utenti 

• /root 
• Questa è la home directory per l'utente root (amministratore). Si noti che questa directory non 

è la stessa di " / " cioè la radice del filesystem chiamata root, dove la parola root significa 
radice. Invece nel caso di /root, qui root sta per amministratore.
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• Esempio: Nessun file qui è comunemente accessibile dagli utenti, ma i file salvati mentre siete
loggati come utente root possono essere salvati qui. 

• /sbin 
• I programmi vengono installati qui, se sono richiamati dagli script di avvio del sistema, ma 

non saranno normalmente avviabili dagli utenti, a meno che non si sia root, in altre parole qui 
troviamo le utility di amministrazione del sistema. 

• Esempio: Nessun file qui è comunemente accessibile dagli utenti, ma è qui che si trovano i file
come modprobe e ifconfig. 

• /tmp 
• Questa è la posizione dei file temporanei prodotti dai programmi, come ad es. i compilatori, 

quando essi sono in esecuzione. In generale, qui troviamo i file temporanei a breve termine, 
creati da un programma esclusivamente mentre sono in esecuzione. Chiuso il programma di 
norma questi file vengono eliminati.

• Esempio: All'inizio di una sessione aprite la cartella /tmp e prendete nota dei file e cartelle 
presenti, poi aprite Libreoffice Writer e create un documento inserendoci all'interno delle 
immagini. Vedrete comparire una cartella in /tmp con all'interno delle miniature delle 
immagini caricate nel documento, poi, chiudendo il documento anche la cartella con le 
miniature scomparirà. 

• /usr 
• Questa directory contiene molte cartelle e file riguardanti le applicazioni dell'utente, ed è in 

qualche modo analoga alla directory di Windows "Programmi". 
• Esempio: molti eseguibili si trovano in ( /usr/bin) 
• Esempio: file di documentazione ( /usr/docs) e di configurazione, grafica e icone sono in ( 

/usr/share). 
• Esempio: molti file specifici per MX Linux si trovano in /usr/local/ 

• /var 
• Questa directory contiene i file che sono in costante riscrittura/modifica, mentre Linux è in 

funzione, ad esempio i registri, processi in coda e posta di sistema. 
• Esempio: si può guardare in /var/log/ quando si cerca di determinare ciò che è accaduto nel 

corso di un processo 

Il Filesystem Disk 
Il Filesystem Disk, o filesystem del disco, è qualcosa di cui l'utente medio non ha bisogno di interessarsi 

particolarmente. Il Disk filesystem predefinito usato da MX Linux si chiama ext4, una versione del file 

system ext2 che supporta il journal, cioè scrive le modifiche in un file log prima di eseguirle, rendendolo più 

robusto. Il filesystem ext4 viene impostato durante l'installazione del sistema operativo quando il disco rigido

viene formattato. 

In generale, ext4 garantisce maggiore stabilità e velocità di tutti i suoi rivali, per questo non è consigliabile 

l'installazione di MX Linux su un filesystem del disco diverso se non si è ben coscienti delle differenze. 

Tuttavia, MX Linux può leggere e scrivere molti altri filesystem di formattazione del disco, e può anche 
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effettuare l'installazione del sistema utilizzando uno di questi filesystem disk diversi, se per qualche motivo si

preferisce uno di questi piuttosto che ext4. 

Link 

• Wikipedia Filesystem  
• Wikipedia. Confronto di file system  
• Wikipedia Ext4  
• I file di registro nella directory /var/log/  

• I file di registro   in italiano

7.3  Permessi
MX Linux è un sistema operativo basato su account. Questo significa che nessun programma può essere 
eseguito senza un account utente, e qualsiasi programma in esecuzione è in tal modo limitato dalle 
autorizzazioni concesse all'utente che lo ha avviato. 
NOTA: Gran parte della sicurezza e della stabilità, di cui Linux è celebre, è una diretta conseguenza del 
corretto uso delle limitazioni degli account utente e della protezione fornita dalle autorizzazioni predefinite di
file e directory. Per questo motivo, si dovrebbe operare come root solo quando una procedura lo richieda. 
Mai accedere a MX Linux come root per usare il computer per le normali attività; l'esecuzione di un browser 
web come utente root, per esempio, è uno dei pochi modi con cui si potrebbe infettare con un virus un 
sistema Linux! 
Informazioni di base 
La struttura predefinita dei permessi dei file in Linux è abbastanza semplice ma più che sufficiente per gestire
la maggior parte delle situazioni. Per ogni file o cartella, ci sono tre autorizzazioni che possono essere 
concesse, e tre entità (proprietario/creatore, gruppo, altri/mondo) a cui sono concessi. I permessi sono: 

• Lettura avere il permesso di lettura significa che i dati possono essere letti dal file; significa anche il 
file può essere copiato. Se non avete il permesso di lettura di una directory non potete nemmeno 
vedere i nomi dei file elencati in essa. 

• Scrittura avere il permesso di scrittura significa che il file o la cartella possono essere modificati, 
copiati o eliminati. Per le directory, si specifica se un utente può scrivere i file all'interno della 
directory. Applicare il permesso di scrittura ad una directory consente la cancellazione dei file 
contenuti in essa anche da parte di utenti che non possiedono i permessi di scrittura su tali file.

• Esecuzione il permesso di esecuzione determina se il file può essere eseguito dall'utente, ovviamente 
questo permesso ha un valore se il file è uno script o un programma. Per le directory, consente di 
accedere alla directory (per esempio con il comando cd) anche nel caso non se ne possa visualizzarne 
il contenuto. Si determina se l'utente può accedere a quella directory e renderla la directory di lavoro 
corrente. 

Ad ogni file e cartella, quando vengono creati, viene designato un singolo utente come proprietario. (Si noti 
che se si sposta un file da un altra partizione in cui si ha un proprietario diverso, manterrà il proprietario 
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originale, ma se si copia e incolla, sarà assegnato al proprietario della partizione su cui è stato copiato) Ogni 
file o cartella ha anche un unico gruppo designato come il suo gruppo, per impostazione predefinita il gruppo
a cui appartiene il proprietario. Quando si estendono i permessi ad altri (others) investiranno tutti coloro che 
non sono il proprietario o appartenenti al gruppo del proprietario. 
NOTA: Per gli utenti avanzati, ci sono attributi speciali aggiuntivi oltre la lettura/scrittura/esecuzione che 
possono essere impostati: sticky bit, SUID e SGID. Per ulteriori informazioni, vedere i link nella sezione 
sottostante. 

La visualizzazione, l'impostazione e la modifica delle autorizzazioni 
Ci sono molti strumenti disponibili in MX Linux per visualizzare e gestire le autorizzazioni. 

• GUI
• Thunar Per visualizzare o modificare i permessi di un file, fare clic destro sul file e 

selezionare Proprietà. Fare clic sulla scheda Permessi. Qui, usando i menu a discesa  è 
possibile impostare le autorizzazioni concesse al proprietario, gruppo, e altri. Per alcuni file 
(come gli script, per esempio), è necessario vistare l'apposita casellina per renderli eseguibili. 
NOTA: È necessario essere loggati come root per modificare l'autorizzazione di un file o una 
directory il cui proprietario è root. Per le cartelle più grandi è necessario aggiornare Thunar 
altrimenti i permessi non saranno mostrati in modo corretto, anche se le autorizzazioni sono 
effettivamente cambiate. Basta premere F5 per aggiornare Thunar, altrimenti vedrete i 
permessi precedenti. 

• MX User Manager (MX Manager Utenti) è un modo semplice per modificare le 
autorizzazioni associando un utente con gruppi specifici. 

• CLI
• Partizioni interne . Per impostazione predefinita, è necessaria la password di root/superutente

per montare le partizioni interne. Per modificare questo comportamento, andate su MX 
Rifiniture scheda Altro. 

• Nuove partizioni esterne . Per formattare una nuova partizione con ext4 sono richiesti i 
permessi di root, questo però potrebbe portare a un risultato inatteso o indesiderato per il 
normale utente perché non sarà poi in grado di scrivere i file nella partizione. Per modificare 
questo comportamento, consultare il wiki MX/antiX. 

• Operazioni manuali. Anche se MX Manager Utenti copre situazioni più frequenti della 
quotidianità, a volte può essere preferibile utilizzare la linea di comando. I permessi di base 
sono rappresentati da r (lettura), w (scrittura) e x (esecuzione), un trattino - indica nessun 
permesso. Per visualizzare le autorizzazioni di un file sulla riga di comando, digitare: 
ls -l NomeFile

Potrebbe essere necessario utilizzare l’indirizzo completo del file (es. /usr/bin/gimp). 
L'opzione -l farà sì che il file sia elencato in formato lungo, mostrando i suoi permessi insieme
ad altre informazioni. 
-rw-r--r-- nomeutente nomegruppo 277 Jan 7 14:42 .asoundrc
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Figura 7-2: Osservare i permessi del file

I caratteri "rw-r--r--" a destra dopo il trattino di apertura (trattino che indica che è un file normale) ci 
informa sui permessi di lettura/scrittura/esecuzione, in sequenza per proprietario, il gruppo e gli altri: 
9 caratteri totali. Qui si vede che il proprietario ha permessi per leggere e scrivere, ma non di 
esecuzione (rw-), mentre il gruppo e gli altri possono solo leggere ( r-). Il proprietario, in questo caso 
viene precisato chiamarsi "newbie", appartenente al gruppo "users". 
Se per qualche motivo si voglia modificare il proprietario di questo file, da newbie a root usando la 
riga di comando, si può usare il comando chown come in questo esempio:
 chown root /home/newbie/.asoundrc chown root
Per informazioni dettagliate sull'uso chown, nonché sul più articolato comando chmod, Vedi la 
sezione Links. 

Links 

• Wiki M  X/antiX: Autorizzazioni  
• Autorizzazioni file   

7.4  I file di configurazione 
Con poche eccezioni, le impostazioni di sistema e dei programmi in MX Linux sono memorizzati in diversi 
file di configurazione che sono dei normali file di testo; non c'è un "Registro di sistema", la cui modifica 
richieda utensili speciali. La maggior parte dei file di configurazione sono solo semplici elenchi di parametri 
e valori che i programmi avviano e leggono, per determinare il loro comportamento. 

7.4.1  File di configurazione utente 

I file che contengono le impostazioni individuali di ciascun utente (come i vostri punteggi nei giochi, o il 
layout del desktop) sono memorizzati all'interno della directory home dell'utente, in genere come un file 
nascosto o una directory, e possono essere modificati solo da quell'utente o da root. In realtà volendo 
modificare queste impostazioni, raramente lo si fa modificando direttamente questi file di sistema perché la 
maggior parte della configurazione utente viene fatta graficamente attraverso le applicazioni stesse. Per 
esempio, quando si apre un'applicazione e si va a cliccare su Modifica> Preferenze, le scelte vengono scritte
in un (di solito nascosto) file di configurazione nella directory utente. Allo stesso modo in Firefox, quando si 
digita about: config nella barra degli indirizzi, si va a modificare i file di configurazione nascosti. 
I file di configurazione di Xfce sono presenti in ~/.config/.
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7.4.2  File di configurazione del sistema 

I file che contengono impostazioni o configurazioni predefinite a livello di sistema (come ad esempio il file 
che determina quali servizi avviare automaticamente durante il boot) sono in gran parte conservati nella 
directory /etc/ e sono modificabili solo da root. Si tratta di file che nella maggioranza dei casi non vengono 
mai toccati direttamente dagli utenti regolari. Vediamone alcuni:

• /etc/rc.d/rc5.d - Contiene i file per gestire il runlevel 5, nel boot di MX Linux dopo il login. 
• /etc/sysconfig/keyboard - Consente di configurare la tastiera. 
• /etc/network/interfaces - Definisce le interfacce Internet dal sistema. 

Alcuni file di configurazione possono contenere solo poche righe, o anche essere vuoti, mentre altri possono 
essere piuttosto lunghi. Il punto importante è che se siete alla ricerca di un file di configurazione per 
un'applicazione o un processo, mettete il naso nella directory /etc e guardatevi attorno. Attenzione: perché 
questi file interessano l'intero sistema, 1) eseguire il backup di tutti i file che si intende modificare (più facile 
graficamente: copiate ed incollate in Thunar, aggiungendo BAK alla fine del nome del file), e 2) state attenti!

7.4.3  Esempio 

Eventuali problemi audio possono essere risolti con una serie di strumenti grafici o a riga di comando, ma 
può capitare di tanto in tanto che un utente debba modificare direttamente il file di configurazione di sistema.
Per molti sistemi, questo sarà /etc/modprobe.d/snd-hda-intel.conf. Si tratta di un semplice file la cui 
sezione superiore è simile a questa: 

# some chips require that the model be set manually
# for example asus g71 series may need model=g71v
options snd-hda-intel model=auto

Per cercare di ottenere l'audio (se ad esempio dopo l'installazione non si riesce a sentire nulla e non dipende 
da un semplice settaggio del mixer), si potrebbe decidere di sostituire al posto della parola "auto" le giuste 
informazioni sul modello della vostra scheda audio. Per scoprire il vostro modello di scheda, potete aprire un 
terminale e digitare: lspci | grep Audio
L'output dipende dal sistema presente, ma avrà la seguente forma: 
00:05.0 Audio device: nVidia Corporation MCP61 High Definition Audio (rev a2)

Ora è possibile inserire le informazioni nel file di configurazione: 
# some chips require that the model be set manually
# for example asus g71 series may need model=g71v
options snd-hda-intel model=nvidia

Dovreste salvare il file, riavviare la macchina, e, auspicabilmente, il suono dovrebbe funzionare. Se ancora 
non funzionasse potreste provare a precisare meglio il modello così:  model=nvidia mcp61 
Links

• La comprensione dei file di configurazione Linux  
• I permessi dei file  
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7.5  Runlevel 
MX Linux, di default, si avvia eseguendo il programma sysVinit che fa partire il boot. (E’ presente come 
opzione anche la possibilità di utilizzare il programma systemd come metodo alternativo di init; non usa i 
runlevel nello stesso modo.)
Dopo aver completato il processo di boot, sysvinit esegue tutti gli script di avvio in una directory specificata 
dal runlevel di default (questo runlevel è precisato nella riga che inizia con la voce id nel file /etc/inittab). 
Come la maggior parte delle altre versioni di Linux, MX Linux ha 7 runlevel: 

Tabella 10: Runlevel in MX Linux 

Runlevel Commento 

0 Arresto del sistema 

1 Modalità singolo utente: offerta di una console di root senza richiesta del login. Utile se 
si perde la password di root 

2 Multiutente senza rete 

3 Accesso alla console, senza server X (cioè senza interfaccia grafica o GUI) 

4 Non utilizzato/personalizzabile

5 Viene presentata la finestra di Login di default (Login con interfaccia grafica)

6 Riavvio del sistema 

MX Linux è impostato di default sul runlevel 5, quindi al boot verranno avviati gli specifici script di init ai 
quali si fa riferimento nel file di configurazione del livello 5.

Uso
La comprensione del Runlevel non è particolarmente complessa. Per esempio quando gli utenti hanno un 
problema con il Window Manager X, non possono correggerlo rimanendo sul runlevel di default 5, perché X 
è in esecuzione su quel livello. Ma si può avviare il runlevel 3 e lavorare sul problema in uno dei due 
seguenti modi. 

• Dal desktop: premete Ctrl-Alt-F1 per uscire da X. Per portarsi al runlevel 3, diventate root e digitate 
telinit 3; questo fermerà tutti gli eventuali servizi ancora operanti sul runlevel 5. 

• Dal menu di GRUB: quando vi compare la schermata di GRUB premete il tasto e (per editare). Nella 
schermata successiva, andate alla riga che rappresenta il comando di boot attuale, si tratta di una delle 
righe più in basso tra quelle che compaiono ed è facilmente identificabile perchè inizia con "linux" e 
finisce, nell’impostazione predefinita, con la parola “quiet”. Alla fine della riga, cioè dopo la parola 
quiet, aggiungete uno spazio e il numero 3

• Premete il tasto F10  per avviare il boot. 

Una volta che il cursore si trova nel prompt, effettuate il login con il vostro username e password dell'utente 
normale. Se necessario, è possibile anche effettuare il login come "root" e fornire la password di 
amministrazione. 
Comandi utili quando ci si trova al runlevel 3, davanti al prompt del terminale, sono: 
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Tabella 11: Runlevel Comune 3 comandi 

Comando Commento 

runlevel Restituisce il numero del runlevel in cui ci si trova. 

halt Eseguito come root. Spegne la macchina. Se questo non funziona nel sistema, 
provare poweroff . 

reboot Eseguito come root. Riavvia la macchina. 

<Application> Esegue l'applicazione, purché non sia grafica. Per esempio, è possibile utilizzare il
comando nano per modificare i file di testo, ma non Leafpad. 

Ctrl-Alt-F7 Se è stato utilizzato Ctrl-Alt-F1 per uscire da un desktop in esecuzione, ma non 
avete continuato fino al runlevel 3, questo comando vi riporterà al desktop. 

telinit 5 Da eseguire come root. Se siete sul runlevel 3, digitate questo comando per aprire 
lightdm il gestore del login. 

NOTA: questi comandi possono cambiare in futuro, se MX Linux passa ad un nuovo gestore del sistema. 

Links 

• Wikipedia: runlevel  
• Il Progetto Informazioni Linux: runlevel Definizione   

7.6  Il kernel 

7.6.1  Introduzione 

Come supporto alla trattazione dell'argomento, questo è uno schema semplificato con la descrizione della 
posizione del kernel in un sistema operativo Linux, preso da Anatomia del kernel Linux .

 
Figura 7-3: Schema del kernel Linux 
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In cima c'è l'area utente, o area delle applicazioni, dove vengono eseguite le applicazioni utente. Sotto l'area 
utente c'è l'area del kernel. L'area dove è presente il kernel di Linux. Nell'area utente è presente anche la 
GNU C Library (glibc), che fornisce l'interfaccia di chiamata di sistema che si connette al kernel e fornisce 
un mezzo per il passaggio delle informazioni tra le applicazioni dell' area-utente (user space) e il kernel. 
Questo è importante perché il kernel e le applicazioni utente occupano diversi indirizzi di aree protette. E 
mentre ogni processo nell'area-utente occupa un proprio indirizzamento di area virtuale, il kernel occupa un 
unico indirizzo di area. 

7.6.2  Aggiornamento/Downgrade

Impostazioni Base
A differenza di altri software presenti sul proprio sistema, il kernel non viene aggiornato automaticamente se 

non al di sotto del livello di revisione minore (indicato dal terzo numero nel nome del kernel). 

Prima di modificare il kernel corrente, si farebbe bene a porsi alcune domande: 

• Perché voglio aggiornare il kernel ? Ho, ad esempio, un nuovo hardware e ho bisogno di un driver 

che nella vecchia versione del kernel non è presente? 

• Devo declassare (downgrade) il kernel? Per esempio, i processori Core2 Duo tendono ad avere strani 

problemi con il kernel predefinito di MX-18 che vengono risolti passando al kernel predefinito di 

Debian 4.9 (usando MX Installa Pacchetti).

• Sono consapevole del fatto che cambiamenti superflui potrebbero portare a vari tipi di problemi? 

MX Linux fornisce un metodo semplice di aggiornamento/downgrade del kernel: aprite MX Installa Meta-

pacchetti e fate clic sulla categoria "kernel". Vedrete un certo numero di kernel disponibili per l'utente. 

Selezionate quello che volete usare (chiedete sul Forum informazioni se non siete sicuri) e installatelo.

Vi si potrà vedere una voce in grigio che riguarda il kernel installato di default, più altre due voci: 

• Un kernel "Fallback" (retrocesso), che rappresenta una scelta ragionevole per tornare indietro di un 
livello 

• L'ultimo kernel disponibile, della stessa serie del kernel di default 

 

Figura 7-4: Kernel disponibili in “MX Installa Meta-pacchetti” per l'architettura a 64 bit 

Dopo aver selezionato e installato il nuovo kernel, fate il re-boot e, alla schermata del boot (o meglio di 

Grub), assicuratevi che il nuovo kernel sia evidenziato; in caso contrario, utilizzando il tasto “Freccia Giù” 
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scendete sulla linea “Opzioni avanzate di MX Gnu/Linux” e date invio, vi verrà mostrato un elenco con i 

kernel presenti nel sistema. Selezionate quello che desiderate. 

Impostazioni Avanzate
Ecco un approccio di base per l'aggiornamento manuale del kernel di Linux sul vostro sistema. 

• In primo luogo, scoprite cosa avete installato al momento. Aprite un terminale e digitate 
inxi -S 
Per esempio, un utente di MX versione 15 a 64 bit dovrebbe vedere qualcosa di simile a questo:
$ inxi -S 

Sistem: Host: UTRA Kernel: 4.2-3.dmz.3-liquorix-amd64 x86_64 (64 bit)
Desktop: Xfce 4.12.2
Distro: MX-15_x64-mx Fusion

Assicuratevi di annotare il nome del kernel (in grassetto sopra) dall'output di quel comando. 

• In secondo luogo, selezionate e installate un nuovo kernel. Aprite Synaptic, cercate linux-image e 

cercate un numero del kernel più alto assicurandosi che l'architettura sia la stessa (ad esempio, 686) 

così come lo stesso processore (ad esempio, PAE) a meno che non si abbia un buon motivo per 

cambiare. Installate quello che desiderate, o avete bisogno, nel modo consueto. 

• In terzo luogo, installate il pacchetto linux-headers corrispondente al nuovo kernel selezionato. Ci 

sono due metodi per farlo.

• Guardate attentamente in Synaptic le voci che iniziano con linux-headers e che si abbinano al 

kernel scelto.

• In alternativa, è possibile installare più facilmente gli headers dopo il riavvio con il nuovo 

kernel digitando il seguente codice in un terminale root: 

apt install linux-headers-$(uname -r)

Gli headers potranno essere installati anche utilizzando un comando come:

m-a preparare

• Quando si farà il reboot, verrà avviato automaticamente, tra i kernel presenti, quello più aggiornato. 

Se non funziona, si ha la possibilità di tornare a ciò che si stava utilizzando: riavviate, e quando 

arrivate alla schermata di GRUB scendete in 

*Opzioni avanzate per MX Gnu/Linux

scendete ancora, tra le righe delle varie opzioni presenti nella partizione dalla quale si vuole avviare, 

evidenziate la riga che mostra il kernel precedentemente installato, e premete invio. 

7.6.3  Aggiornamento del Kernel e dei drivers

Dynamic Kernel Module Support (DKMS) ricompila automaticamente tutti i moduli di drivers DKMS 

quando si installa una nuova versione del kernel. Questo consente a quei drivers, non presenti all'interno del 
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kernel ma che si interfacciano con questo sottoforma di moduli, di continuare a lavorare dopo un 

aggiornamento del kernel Linux. 

L'eccezione riguarda i driver grafici proprietari (sezione 3.3.2). 

• Drivers NVidia

• Se sono stati installati utilizzando sgfxi, dovrebbero essere ricompilati con sgfxi, vedi Sezione 

6.5.3

• Se installati utilizzando MX Nvidia Installa Driver o mediante synaptic/apt, potrebbe essere 

necessario ricompilare i moduli del kernel. In questo caso aprite MX Tools e ri-avviate MX 

Nvidia Installa Driver, dopodichè il programma si offrirà di ricompilare e reinstallare il modulo 

grafico della vostra scheda. Se il reboot si blocca presentando un prompt del terminale, diventate 

root  e provate a dare: sudo ddm-mx -i nvidia

per ricompilare e reinstallare il modulo del driver.

• Drivers Intel

Potrebbe essere necessario aggiornare il driver, a seconda del kernel che andate ad aggiornare

7.6.4  Più opzioni

Esistono altre considerazioni e scelte rispetto al kernel: 

• Esistono altri kernel “pre-confezionati” (pre-rolled) come il kernel Liquorix, che è una versione del 

kernel Zen ed è destinato a fornire una migliore esperienza di utilizzo del desktop in termini di 

reattività, anche con carichi pesanti come ad esempio durante il gioco, oltre a una bassa latenza 

(importante per lavorare con audio). MX Linux aggiorna i kernel Liquorix frequentemente, che 

possono essere installati più facilmente attraverso MX Installa Programmi, nella sezione Kernel. 

• Le varie distro (ad es. AntiX, la distro “sorella” di MX) in genere se ne preparano uno proprio 

personalizzato.

• Utenti ben preparati possono compilarsi un kernel specifico per un particolare hardware. 

7.6.5  Links

• Wikipedi  a: Kernel Linux  
• Anatomia del kernel di Linux   
• archivi del kernel Linux   
• Mappa interattiva di kernel Linux   
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7.6.6  Kernel panic e recupero 

Un kernel panic è un'azione relativamente rara effettuata dal sistema quando rileva un errore interno fatale 

che non può risolvere in modo sicuro. Esso può essere causato da un certo numero di fattori che vanno da 

problemi hardware ad un errore nel sistema stesso. Quando ottenete un kernel panic, provate a riavviare con 

l'unità Live di MX Linux, che permette di superare temporaneamente eventuali problemi software e si spera 

permetterà di vedere ed eventualmente copiare i dati. Se ciò non funziona, allora scollegate tutto l'hardware 

non necessario e riprovate. 

La vostra prima preoccupazione è quella di accedere ai dati per metterli al sicuro. Si spera che abbiate un 

backup da qualche parte. In caso contrario, è possibile utilizzare uno dei programmi di recupero dati come 

ddrescue che viene fornito con MX Linux. La vostra ultima risorsa è quella di portare il disco rigido in un 

laboratorio professionale per il recupero. 

Ci sono un certo numero di passaggi che potrebbero essere necessari per ripristinare un sistema MX Linux in 

maniera nuovamente funzionale, una volta che havete messo i dati al sicuro, anche se in ultima analisi, 

potrebbe essere necessario reinstallare utilizzando l'unità Live. A seconda del tipo di guasto, si potrebbero 

effettuare le seguenti operazioni: 

1. Rimuovere i pacchetti che hanno danneggiato il sistema. 

2. Reinstallare il driver grafico. 

3. Reinstallare GRUB usando MX Ripara Boot (Mx Boot Repair). 

4. Resettare la password di root. 

5. Reinstallare MX Linux, selezionando, a livello della seconda schermata del processo di installazione, 

la casellina per mantenere la /home in modo che le configurazioni personali non vengano perse. 

Non abbiate timore a chiedere aiuto sul forum con eventuali domande su queste procedure. 

Links 

• Home page G  NU C Library   
• ddrescue  
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8  Glossario 
Introduzione 
I termini di Linux possono essere, in un primo momento, fastidiosi e fonte di confusione, quindi questo 
glossario fornisce un elenco di quelli utilizzati in questo manuale, per aiutarvi ad iniziare. 

• applet: Un programma progettato per essere eseguito dall'interno di un'altra applicazione. 
Diversamente da un'applicazione, le applet non possono essere eseguite direttamente dal sistema 
operativo. 

• backend (o anche back-end): Il back-end comprende i vari componenti di un programma che 
elaborano l'input, fornito dall'utente, immesso attraverso il frontend. Vedi anche frontend. 

• backport: I pacchetti su cui è stato fatto il Backports, sono pacchetti delle versioni più aggiornate di 
un software, quindi in fase test, che sono stati ricompilati per poter essere eseguiti su una 
distribuzione non test ma stabile come MX Linux al fine di mantenere un sistema generale stabile ma 
dotato di applicazioni aggiornate. La ricompilazione permette che quel software molto nuovo si 
appoggi su librerie in fase stable invece che in fase test.

• BASH: BASH è l'acronimo di Bourne-again shell, ed è la shell di default (interprete a riga di 
comando) sulla maggior parte dei sistemi Linux, nonché su Mac OS X. 

• BitTorrent (anche Bit Torrent o torrent): Si tratta di un sistema inventato da Bram Cohen per 
distribuire file di grandi dimensioni senza la necessità che un singolo individuo fornisca l'hardware, 
hosting e le risorse di banda necessarie. 

• boot block: Lo spazio in un disco fuori dal MBR che contiene informazioni per iniziare a caricare il 
sistema operativo, cosa necessaria per avviare un computer. 

• bootloader: Programma che sceglie un sistema operativo da avviare subito dopo che il BIOS ha 
terminato l'inizializzazione dell'hardware. Avente una dimensione estremamente piccola, l'unico 
compito del bootloader è di passare il controllo del computer al kernel del sistema operativo. 
Bootloader avanzati offrono un menu per scegliere tra diversi sistemi operativi installati. 

• chainloading o chain loading (caricamento a cascata): Invece di caricare direttamente il sistema 
operativo, boot manager come GRUB possono utilizzare il caricamento a catena per passare il 
controllo da se stessi a un settore di boot posto su una partizione del disco rigido. Il settore di boot 
prescelto, dalla sua partizione, viene caricato all'interno (rimpiazzando il settore di boot dal quale il 
boot manager stesso è stato caricato nella fase iniziale) ed avviato il programma di boot. Il vantaggio 
del chain loading, oltre a quando è indispensabile come per l'avvio di Windows da GRUB, è che ogni 
sistema operativo sul disco rigido - e potrebbero essercene dozzine - è responsabile che i dati 
contenuti nel proprio settore di avvio siano corretti. Così GRUB, che risiede nell' MBR non deve 
essere riscritto ogni volta che ci sono cambiamenti. GRUB può semplicemente caricare (a cascata) le 
informazioni rilevanti dal settore di avvio di una partizione indipendentemente che queste siano 
rimaste le stesse o cambiate dall'ultima volta che è stato eseguito il boot. 

• cheat code: Codici che possono essere inseriti quando si avvia una unità Live per modificare il 
comportamento del boot. Sono utilizzati per passare le opzioni al sistema operativo MX Linux per 
impostare i parametri per ambienti particolari. 
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• command line interface (CLI) (interfaccia a riga di comando): Conosciuto anche come console, 
terminale, prompt dei comandi, shell o bash. Si tratta di un'interfaccia di testo in stile UNIX, al quale 
si è ispirato anche MS-DOS che gli assomiglia. Una console di root è quella in cui sono stati acquisiti 
privilegi amministrativi dopo aver inserito la password di root. 

• desktop enviroment (ambiente desktop): Si tratta del programma che fornisce un desktop grafico 
(finestre, icone, desktop, barra delle applicazioni, ecc) per un utente del sistema operativo. 

• Disk Image (immagine del disco): E' un file contenente la struttura e l'intero contenuto di un supporto
di memorizzazione dati o di un dispositivo, ad esempio un disco rigido o DVD. Vedi anche ISO. 

• Distribuzione: Una distribuzione Linux, o distro, è un particolare assemblaggio del kernel Linux con
vari pacchetti di software GNU (cioè software unix-compatibile con licenza GNU-GPL) , e diversi 
desktop o window manager. Dal momento che, a differenza del codice proprietario utilizzato nei 
sistemi operativi Microsoft e Apple OS, in GNU/Linux il software è libero ed open-source, chiunque 
nel mondo, avendone le capacità, può sviluppare liberamente su quanto è stato fatto in precedenza e 
innovare una nuova visione di sistema operativo GNU/Linux. MX Linux è una distribuzione basata 
sulla famiglia Debian Linux. 

• filesystem (anche file system): Con questo termine ci si riferisce al modo in cui i file e le cartelle sono
organizzati logicamente su dispositivi di archiviazione di un computer in modo che possano essere 
trovati dal sistema operativo. Si può anche fare riferimento al tipo di formattazione su un dispositivo 
di memorizzazione, come ad esempio i classici formati di Windows NTFS e FAT32 o i formati Linux:
ext3, ext4 o ReiserFS, e in questo senso si riferisce al metodo effettivamente utilizzato per codificare i
dati binari sulle unità Hard Disk, floppy, unità flash, unità USB ecc.

• firmware . I piccoli programmi e la struttura dei dati che controllano internamente i componenti 
elettronici 

• free: La parola inglese "free" (libero) ha due possibili significati: 1) gratis, e 2) libero o senza 
restrizioni. Nella comunità del software open-source, un'analogia usata per spiegare la differenza è 1) 
"libero" nel senso di free beer (birra gratis) oppure 2) free nel senso di free-as-in-speech (discorso 
libero o libertà di parola). Va detto che a questo doppio significato della parola free in Inglese non 
corrisponde un simile doppio significato della parola libero in Italiano, quindi noi non rischiamo di 
confondere i concetti. La parola “Freeware” è usata per riferirsi a un software che è semplicemente 
senza costi, mentre il “free-software” (software libero) si riferisce a un software open-source 
(software a codice aperto), rilasciato sulla base di una licenza open source. La denominazione open 
source, al posto di free-software, permette di evitare la confusione con gratis, tuttavia le due 
denominazioni, pur essendo sinonimi dal punto di vista pratico, nel tempo hanno finito per 
rappresentare due concetti leggermente diversi perché nella comunità Gnu/Linux si sono sviluppate 
due scuole di pensiero legate alle licenze del software, dove free-software presenterebbe una 
componente etica come cardine centrale non presente tra i sostenitori dell'open-source. Si tratta 
comunque di diatribe che coinvolgono sviluppatori e utenti avanzati di cui il normale utente viene 
investito marginalmente e può anche non interessarsene.

• frontend o front-end: Rappresenta la parte di un programma software che interagisce direttamente 
con l'utente. Vedi anche backend.
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• GPL: GNU General Public License. Si tratta di una licenza con la quale vengono rilasciate molte 
applicazioni open-source. Essa prevede che, entro certi limiti, sia possibile visualizzare, modificare e 
ridistribuire il codice sorgente delle applicazioni rilasciate sotto di essa, ed inoltre che non sia 
possibile distribuire il codice eseguibile a meno che non venga anche fornito il codice sorgente a 
chiunque ne faccia richiesta. 

• Graphical User Interface (o Interfaccia grafica utente o GUI): Si intende l'interfaccia di un 
programma, o sistema operativo, che utilizza le immagini (icone, finestre, ecc) per interagire con 
l'utente. Sono in contrapposizione con le interfacce testuali (a riga di comando). 

• home directory: Una delle 17 cartelle, o directory, di livello superiore che, in MX Linux, si diramano
dalla directory principale. La directory /home, contiene una sottodirectory per ogni utente registrato 
nel sistema. All'interno della propria /home/nomeutente ciascun utente ha pieni privilegi di lettura e 
scrittura. Inoltre, la maggior parte dei file di configurazione specifici dell'utente per i vari programmi 
installati sono memorizzati in sottodirectory nascoste all'interno della /home/nomeutente. Ad esempio 
le mail verranno scaricate su una cartella all'interno della propria /home/nomeutente. Altri file che 
dovessero venire scaricati di solito vanno a finire di default in home/nomeutente/Documenti, in 
/home/nomeutente/Scrivania, o in /home/nomeutente/Scaricati. 

• IMAP: Internet Message Access Protocol è un protocollo che permette ad un client di posta 
elettronica di accedere a un server remoto di posta. Supporta modalità di funzionamento sia on-line 
che off-line. 

• interfaccia: Un canale di comunicazione tra i componenti del computer, spesso ci si riferisce al 
collegamento tra un computer e una rete. Esempi di nomi di interfacce in MX Linux includono 
WLAN (interfaccia wireless) e eth0 (normale interfaccia cablata). 

• IRC: Internet Relay Chat, un vecchio protocollo che permette un facile scambio di messaggi di testo. 
• ISO: Si tratta di un'immagine di una unità di memorizzazione che, utilizzando uno standard 

internazionale, contiene la struttura del filesystem e i file di dati contenuti all'interno tra cui gli script 
del boot, strutture e attributi. Questo è il classico modo con cui vengono rese disponibili in Internet le 
versioni di Linux, come MX Linux. Vedi anche disk image. 

• kernel: Il nucleo di un sistema operativo ovvero il software avente il compito di fornire ai processi in 
esecuzione sul computer un accesso sicuro e controllato all'hardware. Costituisce la parte di software 
in un sistema operativo che interagisce direttamente con l'hardware. 

• LiveCD/DVD (o CD/DVD Live): Un CD/DVD da cui si può fare il boot per avviare un sistema 
operativo, di solito con un ambiente desktop completo e applicazioni e funzionalità hardware 
essenziali. Una unità Live si differenzia da una semplice unità bootable in quanto quest'ultima 
consente solo di installare direttamente il sistema sul disco, mentre una unità Live permette di avviare 
il sistema, provarlo e solo dopo averlo provato, se lo si desidera, lo si può installare.

• LiveMedium (o Unità Live): Un termine generico che comprende CD/DVD Live e USB Live. 
• LiveUSB (USB Live): Un'unità flash USB in cui un sistema operativo viene eseguito in modo tale 

che possa essere avviato ed utilizzato. Vedi LiveDVD. 
• MAC address : un indirizzo hardware che identifica in modo univoco ogni nodo (punto di 

collegamento) di una rete. Esso, di solito, è formato da una serie di sei gruppi di due cifre o caratteri, 
separati da due punti. 
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• pagine man : dove man è l'abbreviazione di manuale. Le pagine man di solito contengono 
informazioni dettagliate sulle opzioni, gli argomenti, e talvolta, il funzionamento interno di un 
comando. Anche i programmi GUI spesso hanno pagine man, specificando le opzioni disponibili a 
riga di comando. Disponibile nel menu Start digitando, nella casella di ricerca, un # prima del nome 
della pagina man che vi interessa, ad esempio: #pulseaudio. 

• MBR: Master Boot Record: il primo settore di 512 byte di un disco rigido, da cui viene eseguito il 
boot. Dati speciali scritti nell'MBR consentono al BIOS di avviare un sistema operativo installato su 
una partizione del computer. 

• md5sum: Programma che calcola e verifica l'integrità dei dati di un file. L'MD5 hash (o checksum) 
funziona come se fosse l'impronta digitale compatta di un file. E' estremamente improbabile che due 
file non identici abbiano lo stesso hash MD5. Questo perché quasi tutte le modifiche a un file 
determineranno anche cambiamento del suo hash MD5. Per questo motivo l'hash MD5 è 
comunemente utilizzato per verificare l'integrità dei file quando si può disporre di un hash originale 
con cui fare il confronto.

• mirror o mirror site: Una copia esatta di un altro sito Internet, comunemente utilizzato per fornire 
fonti multiple delle stesse informazioni per la fornitura di un accesso affidabile ai download di grandi 
dimensioni. 

• modulo: I moduli sono pezzi di codice che possono essere caricati e scaricati nel kernel su richiesta. 
Attraverso i moduli si possono estendere le funzionalità del kernel senza la necessità di riavviare il 
sistema. 

• mountpoint (punto di montaggio): La posizione nel filesystem di root in cui è collegato (montato) 
un dispositivo fisso o rimovibile. Si tratta del percorso della directory alla quale viene collegato un 
dispositivo, attraverso un link, in maniera che sia accessibile all'utente. Tutto l'hardware di un 
computer ha bisogno di avere un punto di montaggio nel filesystem per essere utilizzabile. La 
maggior parte dei dispositivi standard, quali tastiera, monitor e la partizione primaria del disco fisso 
sono montati automaticamente all'avvio. 

• MTP : MTP sta per Media Transfer Protocol, il quale opera a livello dei file in modo che il 
dispositivo non esponga tutti gli archivi della sua memoria di massa. I dispositivi Android più vecchi 
usano l'archiviazione di massa USB per trasferire file con un computer. 

• NTFS®: New Technology File System di Microsoft. Ha debuttato nel 1993, per il sistema operativo 
Windows NT, orientato alle reti aziendali. In seguito a revisioni successive è entrato nella serie 
principale dei computer desktop utente di Windows nelle versioni successive a Windows 2000. E' 
stato introdotto alla fine del 2001, costituendo il filesystem standard a partire da Windows XP. Viene 
preso in giro negli ambienti Unix/Linux affermando che la sigla sta per "Nice Try File System" 
(Grazioso Tentativo di File System)! 

• open-source: Software il cui codice sorgente è stato reso disponibile pubblicamente sotto una licenza 
che consente alle persone di modificare e ridistribuire il codice sorgente. In alcuni casi, le licenze 
open source limitano la distribuzione del codice binario eseguibile. 

• pacchetto: Un pacchetto è un insieme di dati non eseguibili contenente le istruzioni per l'installazione
rivolte al vostro gestore di pacchetti. Un pacchetto non sempre contiene un singolo programma; 
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potrebbe contenere solo una parte di una grande applicazione, diversi piccoli programmi di utilità, 
dati sui font, la grafica, o file di aiuto. 

• gestore di pacchetti: Un gestore di pacchetti (come Synaptic o Gdebi) è un insieme di strumenti per 
automatizzare il processo dell'installazione, dell'aggiornamento, configurazione e rimozione di 
pacchetti software. 

• pannello: Il pannello, altamente configurabile in Xfce4, visualizzato per impostazione predefinita sul 
lato sinistro dello schermo, contiene le icone di navigazione, i programmi aperti e le notifiche di 
sistema. 

• Partition Table - Tavola delle partizioni: Una tavola (o tabella) delle partizioni è un'architettura del 
disco rigido che espande il vecchio schema di partizionamento del  Master Boot Record (MBR) 
utilizzando gli identificatori univoci globali (GUID) per consentire l'esistenza di più di quattro 
partizioni iniziali. 

• persistenza: la capacita di conservare le modifiche apportate in una sessione live durante l'uso di una 
USB-Live.

• porta: Consente una comunicazione o connessione virtuale di dati. Può essere utilizzata dai 
programmi per scambiare dati direttamente, piuttosto che passare attraverso un file o un altro 
dispositivo di memorizzazione temporanea. Le porte hanno numeri assegnati per protocolli e 
applicazioni specifiche, come ad esempio 80 per HTTP, 5190 per AIM, etc. 

• purge: un comando che rimuove non solo il pacchetto che viene identificato, ma anche tutti i file di 
configurazione e i dati ad esso associati (sebbene non quelli presenti nella directory home  
dell’utente).

• repo: Forma abbreviata di repository. 
• repository: Un repository è un archivio di software situato su un server web dal quale i pacchetti 

software possono essere recuperati e installati tramite un gestore di pacchetti.
• root: Root ha due significati in un sistema Unix/Linux che sono intimamente connessi, ma comunque 

distinti e la cui differenza è importante da capire.
• Il file system di root è la struttura logica di base che organizza tutti i file così da permettere al 

sistema operativo di accederci, così come ai programmi, ai processi, pipe o dati. Esso 
dovrebbe rispettare l'Unix Filesystem Hierarchy Standard, che specifica la modalità gerarchica
ad albero secondo la quale devono essere posizionati  i vari tipi di file. 

• L' utente root (o amministratore) è il proprietario del file system root e quindi ha tutte le 
autorizzazioni necessarie per fare qualsiasi cosa con qualsiasi file. A volte si rende necessario, 
per l'utente normale, assumere temporaneamente i privilegi (o diritti) dell' utente root per 
installare o configurare i programmi, invece è pericoloso e viola la base della sicurezza di 
Unix/Linux fare il Login e poi operare come root se non è assolutamente necessario. 
Nota: in un'interfaccia a riga di comando, un utente normale può temporaneamente diventare 
root con il comando su ed immettendo successivamente la password di root. 

• runlevel: Un runlevel è uno stato operativo preimpostato su un sistema operativo Unix-like. Un 
sistema può essere avviato in uno qualsiasi dei differenti runlevel, ognuno dei quali è rappresentato da
un singolo numero intero. Ogni runlevel designa una configurazione di sistema diverso e consente 
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l'accesso ad una diversa combinazione di processi (ad esempio, istanze dell'esecuzione dei 
programmi). Vedere la Sezione 7.5. 

• script: Un file di testo eseguibile, che contiene comandi in un linguaggio interpretato. Di solito ci si 
riferisce a script bash che vengono utilizzati ampiamente "sotto il cofano" del sistema operativo 
Linux, ma possono essere usati anche altri linguaggi. 

• sessione: Una sessione di login è il periodo di attività tra una registrazione utente e il Logout (l'uscita)
di un sistema. In MX Linux, questo di solito indica la durata di un particolare "processo" dell'utente 
(il codice del programma e la sua attività in corso), che Xfce invoca. 

• SSD: Un'unità SSD (Solid State Drive) è una periferica di archiviazione non volatile che memorizza i 
dati permanenti sulla memoria flash allo stato solido.

• codice sorgente: Il codice umanamente leggibile (per gli sviluppatori) in cui il software viene scritto 
prima di essere assemblato o compilato nel codice di linguaggio macchina. 

• switch (interuttore o opzione): Un interruttore, anche detto flag (bandiera), opzione o parametro, è 
un elemento di modificazione aggiunto a un comando per modificare il suo comportamento. Un 
esempio comune è -R (Ricorsiva), che dice al computer di eseguire il comando in tutte le 
sottodirectory. 

• symlink o link simbolico o collegamento simbolico: anche detto soft link. Particolare tipo di file che
punta ad un altro file o directory e non a dati. Esso consente allo stesso file di avere nomi e/o percorsi 
(posizioni nel filesystem) diversi. 

• tarball: Un formato di archiviazione, come zip, popolare sulla piattaforma Linux. A differenza dei file
zip, però, i tarball possono utilizzare uno qualsiasi di tutta una serie di diversi formati di 
compressione, come gzip o bzip2. Questi file compressi di solito finiscono con estensioni come .tgz, 
.tar.gz o .tar.bz2. Molti formati di archivio sono supportati in MX con un'applicazione grafica 
chiamata Gestore di Archivi (Archive Manager). Di solito un archivio in Thunar può essere estratto 
semplicemente cliccando col tasto destro su di esso. 

• Unix: Anche UNIX. Questo sistema operativo sviluppato alla fine degli anni 1960 presso i Bell Labs 
e utilizzato principalmente per i server e mainframe è la base sul quale è stato modellato 
successivamente il sistema operativo Linux. Come Linux, Unix ha molte varianti. 

• UUID (identificatore univoco universale) . Un identificatore univoco universale (UUID) è un 
numero a 128 bit che identifica univocamente gli oggetti o i dati Internet. 

• window manager o gestore finestre: Un componente di un ambiente desktop che fornisce funzioni 
di base come minimizzare, chiudere, movimento, ingrandimento delle finestre per un ambiente ad 
interfaccia grafica. A volte può essere usato come alternativa ad un ambiente desktop completo. In 
MX Linux, il window manager di default è Xfce4. 

• X: anche chiamato X11, o xorg. Il sistema X Window è un protocollo di rete e di display che fornisce 
finestre sui display di tipo bitmap. Fornisce una serie di strumenti e i protocolli per costruire 
interfacce grafiche utente (GUI) su sistemi operativi Unix-like e OpenVMS, ed è supportato da quasi 
tutti gli altri sistemi operativi moderni. 
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Le traduzioni delle versioni precedenti sono state eseguite dagli utenti di MX Linux: Spartak77 e 
Retrocomputing

L’ aggiornamento all’attuale versione è stata eseguita da: Spartak77

Il testo originale in inglese di questo manuale è reperibile qui: https://mxlinux.org/manuals

Traduzioni aggiornate: https://mxlinux.org/wiki/help-files-other/users-manual-translations

Per consigli, suggerimenti, segnalazioni, collaborazione, questa è la mail:

Spartak77 pierluigimariomail AT gmail DOT com

Tutto il contenuto di MX Linux 2019 © è rilasciato sotto GPLv3. Nel riutilizzarlo dovrebbe essere riportata 
la citazione:
Progetto di Documentazione della Comunità di MX Linux . Manuale degli utenti di 
MX Linux 2019
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